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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each 
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under 
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any 
instrument or defective parts when returned prepaid to us and which our examination discloses to have been 
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized 
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The 
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive 
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed 
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of 
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and 
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications 
are made by persons other than its own authorized service personnel unless such work is authorized in writing by 
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their 
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. 
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our 
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check 
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and 
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. 
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be 
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against 
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of 
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or 
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
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1.  GENERAL INFORMATION

This manual describes how to operate the Elzone 5390 analyzer. To help you operate the 
Elzone more efficiently:

• read Chapter 2, User Interface, before operating the analyzer and its software

• use the step-by-step instructions located in Chapter 3 when performing common 
operations (dialogs used in these procedures are explained in Chapters 4, 5, 6, and 7) 

Organization of the Manual

The Elzone operator’s manual is organized as follows:

Chapter 1  GENERAL INFORMATION

Provides a general description of the Elzone 5390 system, its features, 
and specifications.

Chapter 2 USER INTERFACE

Provides basic software and instrument interface.

Chapter 3 OPERATIONAL PROCEDURES

Provides brief step-by-step procedures for the operations you can per-
form with the analysis program.

Chapter 4 FILE MENU

Provides a description of the commands available on the File menu.

Chapter 5 UNIT MENU

Provides a description of the commands available on the Unit menu.

Chapter 6 REPORTS MENU

Provides a description of the commands available on the Reports menu.

Chapter 7 OPTIONS MENU

Provides a description of the commands available on the Options menu
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Chapter 8 TROUBLESHOOTING AND MAINTENANCE

Provides information for troubleshooting and for performing routine 
maintenance procedures.

Chapter 9 ORDERING INFORMATION

Provides ordering information and part numbers for system components.

Appendix A ERROR MESSAGES

Provides a listing of error messages that may be displayed by the analysis 
program, as well as causes and actions for each.

Appendix B DATA REDUCTION

Contains the calculations used by the software to produce reports.

Appendix C FORMAT OF EXPORTED DATA

Provides the format for exported data.

Appendix D ELECTROLYTES

Provides information on electrolytes and their preparation for analysis.

Appendix E THEORY OF OPERATION

Provides a discussion on the operation theory of the Elzone analyzer.

Appendix F CONCENTRATION ANALYSES

Provides information on performing concentration analyses.

Appendix G CAMERA OPTION

Provides installation and basic operating instructions for the camera.

Appendix H OPTIMUM PERFORMANCE FOR STRAY PARTICLE COUNT 
AND NOISE

Provides a discussion on methods for obtaining optimum performance 
for noise-sensitive applications.

Index INDEX

Provides quick access to a subject matter.
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Conventions

This manual uses the symbols shown below to identify notes of importance, warnings, 
and cautions:

Notes contain important information pertinent to the subject matter.

Warnings contain information that help you prevent actions that may cause 
personal injury.

Cautions contain information that help you prevent actions that may damage the 
analyzer.
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Internet Access

Visit www.micromeritics.com to learn more about Micromeritics, our products, and 
applications. Our site is user-friendly, easy to navigate, and informative. Its content is 
summarized below.

Be sure to browse our site to see the many ways in which we can assist you.

About Micromeritics A brief history of Micromeritics, office locations, awards/cer-
tifications, career opportunities, and a virtual tour of its 
headquarters

Products Product information and printable brochures

Applications Application Notes, Product Bulletins, Tech Tips, Technical 
Articles/papers, and important application links

Online Catalog  Catalog of instruments and accessories, allowing you to place 
your order online

News and Press Press releases, Events calendar, microReports, and latest 
Micromeritics news updates

Lab Service Provides laboratory tips and access to the Micromeritics Ana-
lytical Services web site

Customer Support Customer support contacts, product registration, instrument 
training information, Material Safety Data Sheets, and account 
registration

Grant Program Details of the Grant Program established for non-profit orga-
nizations and universities

Contact Us Contact information, office locations, maps and driving direc-
tions to the Micromeritics facility, and registration for the 
microReport newsletter
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System Description

The Elzone 5390 Particle Size analyzer uses the electrical sensing method for measuring 
particles. It is capable of measuring particles (organic and inorganic) ranging from 0.4 to 
240 m in diameter. The Elzone’s ability to measure low-concentration samples allows it 
to produce accurate data where other techniques are limited.

Operation

The Elzone’s operation is based on a simple, yet efficient process. The sample, dispersed 
at a low concentration in an electrolyte solution, is placed in a sample beaker and onto the 
sample stand of the analyzer. When the sample stand is raised, a tube containing a pre-
cision-drilled orifice becomes submerged in the sample beaker. An electrode in the tube 
provides a current which passes through the orifice by way of the electrolyte to a second 
electrode in the sample beaker. The dispersed sample is pulled through the orifice. As 
each particle passes through, it displaces a volume of electrolyte equal to its own volume. 
This disturbs the electrical field between the two electrodes, producing an electrical pulse 
for each particle. The Elzone counts and sizes these pulses and reports the data.
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Orifice Tubes 

A wide range of orifice tubes is available to accommodate many sample sizes. The orifice 
is drilled in a synthetic jewel which is permanently sealed into the wall of the tube. Each 
tube is carefully tested, using standard samples of monodispersed polymer spheres, to 
verify it produces distortion-free measurements. The effective range of particle sizes a 
typical orifice can measure is from 2% to 60% of its orifice diameter. You can blend 
(merge) data obtained from multiple orifice tubes to report a continuous distribution for 
overlapping segments of a broad range of particle sizes.

Analysis Program

The Elzone analysis program is operated in a Windows environment, and includes wiz-
ards and intuitive screens enabling you to perform system operations quickly and 
efficiently. 

Also included is a report system which allows you to manipulate and customize reports. 
You can zoom in on portions of the graphs or shift the axes to examine fine details. Scal-
able graphs can be copied to the clipboard and pasted into other applications. Reports can 
be customized with your choice of fonts and a company logo added to the report header 
for an impressive presentation. Refer to Onscreen Reports, page 6-22 for available 
options.

Camera

An optional camera is offered for capturing and displaying pictures of the orifice jewel on 
the computer screen. This camera enables you to:

• view particle activity in the orifice
• detect blockages in the orifice
• check the orifice jewel for cracking
• check the orifice for particle build-up

Refer to Ordering Information on page 9-1 for ordering information. Installation and 
operating instructions for the camera are located in Appendix H.
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ElectroPrep 

The ElectroPrep is designed to recirculate electrolyte through a filter cartridge that retains 
particles greater than 0.1 to 0.2 micrometers in diameter. The electrolyte is contained in a 
reservoir, providing a supply of clean electrolyte at all times. 

For electrolytes in which sample particles readily disperse (e.g., alumina in saline water) 
without having to add a dispersing agent, the waste liquid can simply be poured back into 
the reservoir and used again and again. In typical usage under this circumstance, one prep-
aration of electrolyte will last several months before the filter cartridge has to be replaced. 
This is also true with saturated electrolytes.

Waste liquid cannot be recycled when the sample material requires a special dispersing 
agent because placing it back into the electrolyte would change the electrolyte composi-
tion. The ElectroPrep is still useful in these situations by affording a ready source of clean 
electrolyte to fill instrument sample beakers and supply containers. The ElectroPrep can 
be employed with either aqueous or organic electrolytes by selecting the appropriate car-
tridge. Refer to Ordering Information, page 9-1 for information on ordering the 
ElectroPrep, or contact your local sales representative.

Volumetric Pump

Also available is a volumetric pump which enables you to measure the concentration of 
particles.

Refer to Ordering Information on page 9-1 for information on placing your order. 
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Specifications

The Elzone 5390 analyzer has been designed and tested to meet the specifications listed 
below.

       

Characteristic Specification

Analysis

 Electrolyte: Aqueous- or organic-based liquids

 Concentration: From 1 to 1000 ppm (0.1%) by volume

 Sensing rate: From 1 to over 5,000 particles per second

 Size range: 0.4 to 240 m (20-30: 1 range per orifice)

 Analysis time: Typically 10 to 100 seconds

Performance

 Repeatability: ± 1% (10 measurements from same sample)

 Reproducibility: ± 1.5% (instrument to instrument)

Electrical

 Voltage: 100/120/230/240 VAC

 Fuse type: 2.0 A, 3 AG, Slow-Blow  (100/120 VAC)
1.0 A, 5 x 20 mm Slow-Blow (230/240 VAC)

 Power: 150 VA

 Frequency: 50/60

Environment

 Temperature: 10 to 45 ºC operating; -10 to 55 ºC storing or shipping

 Humidity: 20 to 80% relative, noncondensing

Physical 

 Width: 38 cm (15 in.)

 Height: 54.5 cm (21.5 in.)

 Depth: 40.5 cm (16 in.)

 Weight: 28 kg (61 lbs)
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Characteristic Specification

Computer

Minimum requirements: • P1 GHz or faster 32 bit (x86) or 64 bit (x64) 
processor

• 2 GB RAM
• 40 GB minimum hard drive (formatted in NTFS) 

(one partition)
• Video Adapter capable of 1024 × 768 minimum 

resolution
• One 10 BaseT Ethernet port (can be 10/100)
• CD-ROM drive
•   Windows 7 Professional is recommended for the

  best user experience.
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2.  USER INTERFACE

The Elzone 5390 Confirm software is accessed by three different levels of users:

• Administrator: installs and maintains software and updates, establishes user 
accounts and rights (the Administrator responsibilities are covered in a separate 
manual).

• Developer: has access to all functions of the software. A Developer’s primary 
function is to create templates for an Analyst.

• Analyst: creates sample files from predefined templates; some fields, such as the 
Mass field, are enabled and can be edited. An Analyst is also allowed to perform 
other tasks as designated throughout this manual. Tasks not allowed are disabled.

This manual is written for the Developer and Analyst levels of the Elzone 5390 Confirm 
software. Functions for the Administrator are covered in the Administrator Utility User’s 
Guide.

This chapter contains information to familiarize you with the hardware and software of the 
Elzone system. It is recommended that you read this chapter before attempting to operate 
the Elzone 5390 analyzer.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on 
the front, side, and rear panels of the analyzer.
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Front Panel

Power Indicator  
(upper left side of 
front panel)

Camera assembly

Orifice light connector

Sample Stand

Stirrer assembly 
(shows rotary stirrer installed)

Electrode (external) 
connector

 

Sample port

Exit tube

This door contains a reflector (used to 
diffuse the orifice light when the 
camera is installed).

Compartment doors The sample compartment contains two sliding doors. 
These doors should always be closed during an analysis. 
The door on the right side contains a reflector which 
serves to diffuse the orifice light (when the camera option 
is installed). 

Power Indicator Illuminates when the analyzer is turned on. 

Electrode connector For connecting the external electrode.

Camera assembly (optional) Enables you to capture pictures of the orifice 
jewel and display them on the computer screen.

Orifice light connector For connecting the orifice light (included with the camera 
option). The orifice light provides a backlight for the 
orifice when capturing pictures. Also illuminates the 
sample beaker, providing a clear view of particle 
suspension.
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Sample port For installing the orifice tube.

Exit tube This tube is used to remove liquid from the sample 
beaker to the waste container.

Stirrer assembly Enables you to maintain dispersion of the sample. Two 
types of stirrers are available:

• Propeller; maintains dispersion by means of a glass 
propeller. The propeller stirrer is included with the 
Elzone analyzer.

• Hydropulser (optional); maintains dispersion using a 
pulsing motion. The hydropulser may be desirable for 
more fragile samples and when using small volumes 
of analysis liquids.  

Sample stand For raising the sample beaker up and around the orifice 
tube for analysis.

To raise the stand: Pull out the knob and slowly raise 
the stand to the desired position, then release the knob to 
lock it into place. Slots are evenly spaced along the sam-
ple stand track for this purpose.

To lower the stand: Pull out the knob and slowly lower 
the stand to its lowest position, then release the knob to 
lock it into place.

Slots are evenly spaced 
along the track to lock 
the sample stand into 
position.
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Side Panel

Supply inlet 
port

Waste vacuum port

Waste liquid outlet port Waste container sensor

Waste liquid outlet port For connecting the waste tubing to the waste container

Waste vacuum port For connecting the vacuum tubing to the waste container

Waste sensor connector For connecting the overflow sensor cable to the waste 
container. This sensor senses when the bottle becomes 
full and automatically cancels any operation in progress; 
an error message is also displayed. You must empty the 
waste container before you can proceed.

If the waste sensor cable is not securely plugged in and, 
therefore, does not detect the full container, a second 
sensor activates. If the second sensor activates, the 
internal tubing is filled with liquid and may have spilled 
into the internal component area. Call your Micromeritics 
service representative if this occurs. Refer to Sensors, 
page 5-41 for additional information.

Supply inlet port For connecting the supply tubing from the supply 
container (analysis liquid)
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Rear Panel

Power connector

On/Off switch

Voltage selector 
card

Ethernet connector

Camera USB 
connector

RS232 ports 
(unused)

Air Filter

Test Points
(for service 
personnel only)

Test points For use by Micromeritics service personnel only

Camera USB port For connecting the camera 

Air Filter Helps to minimize buildup of dust within the analyzer

On/Off switch For turning the analyzer on and off

Ethernet connector For connecting the ethernet cable, allowing 
communication between the analyzer and the computer

Power connector For connecting the power cord

Voltage selector card Enables you to specify the proper operating voltage

Spare 1 and 2 RS-232
 ports

Unused
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Using the Software

The Elzone 5390 Program operates in a Windows environment and requires familiarity 
with standard Windows operations such as using the mouse, menus, and dialog boxes. 
While this manual provides brief instructions for such standard operations, you may have 
to refer to your Windows documentation or to its online help system to clarify functions 
which are specific to Windows.

Logging In

Each user — Administrator, Developer, or Analyst — is required to enter a user name and 
password when opening the application. Initially, the Administrator establishes passwords 
for the Developer and Analyst(s) when the software is installed. These passwords are 
temporary and are used for initial log-in; at that time, each user is prompted to specify a 
password of personal preference.

Your password must consist of at least six characters and expires after a specified time 
(designated by the Administrator). You will be locked out of the application if you fail to 
enter the correct password after three (default) tries. This number can be changed by your 
Administrator. The Administrator is also required to unlock the application in the event it 
becomes locked after failure to enter the correct password.

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are 
available for certain components on the instrument schematic when in manual mode, and 
for onscreen graphs and tabular reports. These menus are accessed by selecting the item 
for which you wish to display its menu and clicking the right mouse button. For example, 
right-click in the graph area of an onscreen report and the following menu is displayed.
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Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combi-
nations (if assigned) are listed to the right of the menu item. Instead of opening the menu 
and choosing the command, simply press the key combination. For example, to open a 
sample information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an under-
lined letter by pressing Alt plus the underlined letter in the command. For example, to 
access the File menu, press Alt, then F.

Table 2-1 provides a list of the shortcut keys available in the Elzone 5390 analysis pro-
gram.

Table 2-1. Shortcut Keys

Key(s) Function

F1 Access online operator’s manual

F2 Open a sample information file

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file

Insert the current date (Select Dates dialog)

F4 Open a material properties file

Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile open windows

F7 Cascade open windows

F8 Start report

F9 Close all open reports

Alt + F4 Exit the Elzone program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List material properties files

Shift + F5 List report options files

Shift + F9 Displays the shortcut menu for onscreen reports and for selected 
components on the instrument schematic
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Dialog Boxes and Subdialog Boxes

Dialog boxes are displayed when a item followed by an ellipsis (...) is selected. Subdialog 
boxes are displayed when certain push buttons are selected. Both types of boxes may 

contain one or more of the items listed below.

If an item is shown in gray instead of black, the item is currently unavailable.

Data Entry fields These fields are used to enter text; either numeric 
(numbers only) or alphanumeric (numbers, letters, or 
printable characters). 

If an invalid entry is made, an error message is dis-
played; for example, if you attempt to enter an alpha 
character in a numeric field, or a number outside of the 
specified range.

Information bar Some dialog boxes contain information pertinent to the 
selected field in an information bar across the bottom of 
the dialog. For example, a range is shown for fields in 
which numeric entries are required.

Radio button Radio buttons are provided in groups of two or more 
and are used to make a choice; only one radio button 
can be selected.

Radio button

Drop-down list

Information bar; displays 
range for selected field

Push button; 
this type 
displays a 
subdialog

Data entry 
fields

Check box

Push button; this type  
invokes an action
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Check box Check boxes allow you to choose multiple options from 
a group of options.

Push button Typically, a push button is used to display subdialog 
boxes in which to edit, enter, or specify additional 
information about the subject matter. Some push 
buttons, however, are used to invoke an action; for 
example, Save saves entries in the current dialog. 

Close Closes the active dialog. If the dialog box contains 
unsaved changes, you will be prompted to save them 
before the dialog box closes.

Any information entered in subdialog boxes (refer to 
the next section of this chapter), is discarded also.

Save Saves the information entered in the current session; the 
dialog box remains open.

Replace Allows you to replace the contents of the current file 
with those from an existing file. For example, if you are 
creating an analysis conditions file, you can save time 
by clicking and choosing a file containing the values 
you wish to use. The values are copied into the current 
file automatically and, therefore, can be edited as 
desired. The file from which they were copied remains 
intact and ready for the next use.

Cancel Discards everything you entered in the open dialog and 
any subdialogs, then closes the dialog. A warning 
message is displayed before closing.

Drop-down list A drop-down list contains a list of options and is 
indicated by a down arrow to the right of the field. If 
there are more items than can fit in the box, a scroll bar 
is provided for navigating through the list.
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Selecting Files

Sample information is stored in files and saved under file descriptions. Certain dialog 
boxes contain a Files list box which displays a list of files available for that particular 
operation. For example, the Open Sample Information File dialog.

The files displayed in the window are those contained in the chosen directory (Category 
and Subcategory fields) and having the status shown in the Status field. To select a file, 
simply double-click on the desired file in the Files window.

You can use the following options to limit the list of files displayed in the window:

• Enter a range of dates. Click Date Range; the Select Dates dialog is displayed.

Select Show Date Range to enable the From and To fields, then enter a beginning 
and ending date. Or you can double-click in each field to display a calendar to select 
a date. Only the files falling within the range you specify will display. The range of 
dates remains the default until you change the dates or select Show All Dates. The 
current range or date option displays just below the Date Range push button.
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For convenience, the following shortcut keys are available when the Select Dates 
dialog is displayed:

• Select a file status from the Status drop-down list (displays only for sample files). 

The table shown below describes each file status.

Table 2-2. File Status and Description

• Use the Category and Subcategory drop-down lists to navigate to a different file 
location. 

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which you may select a date

Status Description

All All sample information files in the specified directory and within the 
specified range of dates

Analyzing Sample information files that are currently being used with an analysis

Background Sample information files that contain background data

Complete Sample information files that have been used with an analysis

Entered Sample information files that contain manually entered data

No Analysis Sample information files that have not been used in an analysis

Selects the year

Selects the month

Click the desired date
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Selecting Reports

Reports are selected from the Report Options dialog. Simply select (highlight) the report 
and then double-click, or press the spacebar. A report is selected when it is preceded 
with a check mark. Reports are deselected in the same manner. 

You can also edit some reports by selecting the report and click Edit (refer to page 4-31 
for details on editing reports).

Indicates a report 
is selected.
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Menu Structure

All functions for the Elzone analyzer are located on menus which are accessed from the 
Menu bar. Each menu contains commands, and in some cases a submenu. A submenu is 
indicated when the command is followed by an arrow. 

Brief descriptions of each menu are provided below; refer to the chapter given in 
parentheses for a detailed description of the commands contained on that menu.

File Enables you to maintain system files. (Chapter 4, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument operations. 
If you have two analyzers connected to your computer, a unit 
menu is shown for both. (Chapter 5, UNIT MENU)

Reports Enables you to generate, open, and close reports. Also provides 
examples of reports. (Chapter 6, REPORTS MENU)

Options Enables you to add archive locations, edit labels for sample files, 
and select data presentation formats. (Chapter 7, OPTIONS 
MENU)

Menu Name

Command

Menu Bar

Submenu
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Windows Menu

Windows Enables you to arrange the windows and icons on your screen. It 
also displays the names of all open files. (this chapter, page 2-14)

Help Displays information about the Elzone program. Also provides 
access to the online operator’s manual. (this chapter, page 2-15)

Tile Resizes all open windows and arranges them side by side so that 
the contents of all open windows are visible.

Cascade Resizes all open windows and arranges them in a stacked fashion. 
The active window is positioned on top of the stack. Each 
window’s title remains visible, making it easy to select other 
windows. 

Arrange Icons Arranges the symbols for all minimized windows in an orderly 
manner.

Open Files Displays all open files; the active window is preceded with a 
check mark 
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Help Menu

Operator’s 
Manual

Provides a copy of the operator’s manual in Adobe Acrobat 
PDF format. Refer to Specifications, page 1-8 for tips on using 
the online manual.

About Elzone II Displays information about the Elzone 5390 analysis program.
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3.  OPERATIONAL PROCEDURES

This chapter contains brief step-by-step instructions on how to:

• create sample and parameter file templates, beginning on this page 
• create a parameter file, page 3-3
• create a sample file, page 3-10
• perform a background, page 3-14
• calibrate orifice tubes, page 3-18
• prepare for an analysis, page 3-26
• optimize instrument settings, page 3-31
• perform an analysis, page 3-36
• print contents of a parameter or sample file, page 3-38
• list file statistics, page 3-39
• import sample and parameter files, page 3-40
• export a sample file, page 3-41
• convert a file used with a previous version of the Elzone to be compatible with 

Elzone II, page 3-42
• generate overlays, page 3-45

This chapter does not provide detailed descriptions of the fields in the dialogs used to per-
form these procedures. Refer to Chapters 4 through 7 for field descriptions. Use the table 
of contents or index to assist you in locating the appropriate dialog.

Some procedures cannot be performed by the Analyst; these procedures are marked 
accordingly.

Creating File Templates

When you create a sample or parameter file, a dialog containing templates is displayed so 
that you can choose one on which to base your file. Several predefined templates have 
been included with the Confirm program. A new template can be created using the values 
from existing sample files. For example, you may wish to create a template from a sam-
ple file that you used with a sample material that you analyze on a routine basis.

A template cannot be edited; however, the values in the sample file you create using a 
template can be edited. 

 An Analyst is not authorized to create sample and parameter file templates.
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Perform the following steps to create a template using a sample file.

1. Select File > Open >Sample information; the Open Sample Information dialog is 
displayed.

2. Choose the desired file, then click Open; the Sample Information dialog is displayed.

3. Edit the fields of all parameters (click the tabs to access each parameter) as desired.

4. Select File > Save As Template, then choose:

• Sample information to save all parameters as a sample file template; the Save As 
Sample Template dialog is displayed. You can also click Save As Template on the 
Sample Information dialog if you are saving all parameters as a template. You 
cannot save parameter file templates using this push button.

• a parameter file to save the values of one of the parameters as a parameter file 
template. For example, select Analysis conditions to save the values in the 
Analysis conditions dialog box as a template for Analysis conditions files; the Save 
as Analysis Conditions Template dialog is displayed.

5. Enter an appropriate description in the ID field of the dialog for the type of template 
you are creating; you can use up to 42 characters. Be sure to use an intuitive 
description.

You can also create parameter file templates using existing parameter files.
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6. Click Save to save the template. If Save does not become enabled, a file containing 
the same description currently exists. Edit the description to enable Save. The 
Confirm program does not allow duplicate file descriptions.

7. Click Close on the sample file; the following error message is displayed:

(file name) has been changed. Save changes before closing?

8. Click No (unless you wish to save the changes made) to close the dialog.

Creating Parameter Files

The following file types can exist as part of the sample information file, as well as indi-
vidual parameter files:

• Analysis conditions
• Material properties
• Report options

Having these files exist independently allows you to use them over and over again. 

Several predefined parameter files are included with the Confirm program. Although 
these files may come close to the needs of your laboratory, you may wish to define addi-
tional ones. Or you can use a predefined file as a starting point. You can do this by 
creating a new file and then selecting Replace. A dialog is displayed so that you can 
select the existing parameter file. The values are copied into the file. You can edit the file 
in any way desired without affecting the file from which the values were copied.

 An Analyst is not authorized to create parameter files.
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Analysis Conditions

Analysis conditions specify the data used to guide an analysis.

Perform the following steps to create an analysis conditions file:

1. Select File >New > Analysis conditions; the Create an Analysis Conditions File 
dialog containing the available templates is displayed.

2. Choose a template then click Create; the Analysis Conditions dialog is displayed:

3. Enter a description in the Analysis Conditions field. Be sure to use an intuitive 
description so that you can recognize it easily. You can use up to 40 characters in this 
field.

4. Choose an appropriate orifice tube from the Orifice Tube drop-down list. If the tube 
you select is preceded with an asterisk, the tube has not been calibrated for the current 
instrument. 

If the tube you plan to use is not included in the list, use the Add push button to add 
it.

Refer to Analysis Conditions, page 4-12 if you need clarification of the fields on the 
dialogs used in this procedure.

Use Replace to copy values of an existing file into the current one. You can edit the 
values after they have been copied into the file if desired. This is useful when you 
have an existing file that contains many of the values that you wish to use in the 
current file.
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5. Select Specify Diameter range and specify a range for the size of particles to be 
read.

6. Specify rinse options. You can choose to rinse before or after the analysis by draining 
and filling the system or simply by flushing the system.

7. Select Purge Volumetric Pump to have the volumetric pump (if installed) purged 
during the rinsing operation.

8. In the Number of Tests field, enter the number of analyses you plan to perform (this 
number can be edited in the sample file). 

9. Enter the stirrer speed and the direction in which to have the particles circulate.

10. Click Flow Control and choose flow and blockage detection options.

11. Click Data Setup and specify details on producing the raw data.

12. Specify when you wish to have the analysis end.

13. Click Save; the Save As Analysis Conditions File dialog is displayed. 

14. Ensure that the description is as desired, then click Save to save the file and return to 
the Analysis Conditions file dialog. If Save is disabled, the description is a duplicate 
one and must be edited. The Confirm program does not allow duplicate descriptions.

15. Click Close to close the dialog.
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Material Properties

Material properties specify data for the sample material and its electrolyte.

1. Select File > New > Material Properties; the Create a Material Properties dialog 
containing the available templates is displayed.

2. Choose a template then click Create; the Material Properties dialog is displayed:

3. Edit or enter a description in the Material Properties field.

4. Select your sample from the Sample Material list. If it does not appear in the list, 
enter its name in the Description field, its related properties in the appropriate fields, 
and click Add.

5. Select the electrolyte from the Electrolyte Solution list. If it does not appear in the 
list, enter its name in the Description field, its related properties in the appropriate 
fields, and click Add.

6. Use the Dispersion window if needed to add any pertinent information. The 
information you enter in this window displays on the Option report.

Refer to Material Properties, page 4-22 if you need clarification of the fields on the 
dialog used in this procedure.

Use an intuitive name that will help you identify the type of sample you plan to 
analyzer using this file. You may want to use a name containing the type of sample 
material and electrolyte.
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7. Click Save; the Save As Material Properties File dialog is displayed. 

8. Ensure that the description is as desired, then click Save to save the file and return to 
the Material Properties file dialog. If Save is disabled, the description is a duplicate 
one and must be edited. The Confirm program does not allow duplicate descriptions.

9. Click Close to close the dialog. 

Report Options

Report options files specify the type of reports which can be generated from an analysis 
or from manually entered data. They also contain report details such as axis scale, axis 
range, and column headings. These report options files may be used to generate reports 
automatically at any time during or after the analysis. Of course, reports generated during 
analysis can only report on data collected up to the time of the report.

Report options files may contain tabular reports only, plots only, or both tabular reports 
and plots. They may also contain user-defined report tables.

Report options files also may be defined to include overlay options. The Elzone program 
enables you to overlay: 

• one plot type onto a different plot type from the same analysis

• one plot from all tests in the same sample file

• up to eight plots of different samples onto the current plot of the same type, and 
they don’t all have to contain data collected with the Elzone. You can overlay data 
collected with Micromeritics’ Saturn DigiSizer 5200, SediGraph 5100, and 
SediGraph 5120.

Refer to Generating Graph Overlays, page 3-45 for step-by-step instructions on over-
laying graphs.

Perform the following steps to define a report options file:

1. Select File > New > Report Options; the Create a Report Options File dialog 
containing the available templates is displayed.

Refer to Report Options, page 4-25 if you need clarification of the fields on the 
dialogs used in this procedure.
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2. Choose a template, then click Create; the Report Options dialog is displayed:

3. Enter a description (up to 42 characters) in the Report options field. Enter an 
identifier that gives a more intuitive description of the file’s contents. For example, 
Particle Diameter, Inc. Volume Options.

4. Select Show report title and enter the title you wish to appear at the top of the report. 
Or deselect this option if you prefer not to have a report title.

5. Click on the down arrow to the right of the Test field and choose which test you wish 
to have reported. If you choose Average, an average for all tests performed using this 
file will be generated.

6. If you wish to compare analysis results for the current sample to those obtained for a 
reference sample, click Reference and choose the desired file. Results are reflected 
in the Difference from Reference report.

7. If you wish to determine if the results for the current sample are within coarse and 
fine specifications, click Specification and choose a sample file for each boundary. 
Results are reflected in the Out of Specification report.

8. If you wish to compare the same type of graph from multiple files, click Overlays 
and choose the files. Then be sure you edit the graph from the Reports to Generate 
window and choose Samples from the Overlay drop-down list. (Refer to Multiple 
Samples Overlay, page 3-45 for detailed instructions.)

9. Click Peaks if you wish to edit Peak detection settings.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can 
have it display in the report header by selecting Show graphic. Click Browse to 
select the file; use the Height and Width fields to specify the size.
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10. From the Reports to Generate list, select the reports you wish to have generated. 
Refer to Selecting Reports, page 2-12 for details on selecting reports.

11. Click Save; the Save As Report Options File dialog is displayed. 

12. Ensure that the description is as desired, then click Save to save the file and return to 
the Report Options file dialog. If is disabled, the description is a duplicate one and 
must be edited.

13. Click Close to close the dialog.
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Creating a Sample Information File

A sample information file must be created for each analysis. The sample information file 
consists of information groups which, collectively, identify the sample, guide the analy-
sis, and specify report options.

A sample file can be created by a Developer or an Analyst.

Analyst

An Analyst creates a sample information file by choosing predefined parameters. Param-
eter details can be viewed by switching to the Advanced format, but editing is not 
allowed. Perform the following steps to create a sample information file:

1. Select File > New > Sample Information; the Create a Sample Information File 
dialog containing the available templates is displayed.

2. Choose the desired template, then click Create; the Basic Sample Information dialog 
is displayed.

3. Edit the description in the Sample field; or enter a new one.

Refer to Sample Information, Analyst, page 4-4 if you need clarification of the fields 
on the dialogs used in this procedure.
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4. Click on the down arrow to the right of each of the following fields to choose 
appropriate parameter files, or you can accept the defaults displayed in the template:

• Analysis Conditions
• Material Properties
• Report Options

Remember, you can click Advanced to view details of parameter files, but you 
cannot edit them.

5. The remainder of the fields on the dialog display the values entered or chosen in the 
selected Analysis Conditions file. You may edit any value in an enabled field. This 
will change only the current file; it does not affect the values in the parameter file 
chosen from the drop-down list. 

6. The Reports to Generate window displays the reports to be generated (preceded 
with a check mark). You may edit the selections, but you cannot edit details of the 
reports.

7. After you have selected all parameters, click Save; the Save As Sample Information 
dialog is displayed. 

a. Choose the directory into which the file is to be saved.

b. Ensure that the description is as desired; the Confirm program does not allow 
duplicate descriptions.

c. Enter a comment in the Comment window; for example, you may wish to enter 
the date and time the file is created. You must enter a comment; otherwise Save 
will not become enabled.

d. Click Save to return to the Sample Information file dialog.

8. Click Close to close the dialog.
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Developer

A Developer’s view of the sample information dialog is more flexible than that of an Ana-
lyst. A Developer is allowed to view and edit (if desired) all parameters of the file.

Perform the following steps to create a sample information file:

1. Select File > New > Sample Information; the Create a Sample Information File 
dialog containing the available templates is displayed.

2. Choose a template, then click Create; the Sample Information dialog is displayed.

3. Edit (or enter) the description in the Sample field; you can use up to 50 characters.

4. In the Operator field, enter the name of the Analyst who will be performing the 
analysis.

5. In the Submitter field, enter the name of the department, company, etc. submitting 
the sample for analysis. 

6. Enter the bar code (if used). If you are not using bar codes, this line can be omitted 
from the sample editor or it can be used for some other type of information. Refer to 
Edit Labels, page 7-4 for information on removing or editing this field.

Refer to Sample Information, Developer, page 4-8 if you need clarification of the 
fields on the dialogs used in this procedure.
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7. Select the type of data for this file; you can have data collected automatically, enter 
the data manually, or have the data collected and saved for a background.

8. If you have User Parameter fields defined, enter the appropriate values; refer to Edit 
Labels, page 7-4 for additional information on these parameters.

9. Use the Comments window or the Add Log Entry push button to enter additional 
information about the sample or analysis conditions. Information entered in the 
Comments window appears in the header of some reports. Information you enter 
using the Add Log Entry push button displays in the Sample Log report.

10. Edit the values for the Dilution Factor and the Mass Concentration if needed.

11. Use the Comments window or the Add Log Entry push button to enter additional 
information about the sample or analysis conditions.Information entered in the 
Comments window appears in the header of some reports. Information you enter 
using the Add Log Entry push button displays in the Sample Log report.

12. After you complete the Sample Information dialog, click on the parameter tabs to 
open associated dialogs and edit as desired. Instructions for completing these dialogs 
are explained in Creating Parameter Files, page 3-3.

13. After you have completed all parameters, click Save: the Save As Sample 
Information dialog is displayed. 

a. Choose the directory into which the file is to be saved.

b. Edit the description; the Confirm program does not allow duplicate descriptions.

c. Enter a comment in the Comment window; for example, you may wish to enter 
the date and time the file is created. You must enter a comment in the window; 
otherwise, Save will not become enabled.

d. Click Save to complete the save operation and return to the Sample Information 
file dialog.

14. Click Close to close the dialog.
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Performing a Background Analysis

Occasionally, the ratio between contaminates in the electrolyte and particles in a sample 
can be low and, therefore, difficult to tell the difference between the two. When 
performing an analysis, the desired ratio between sample particles and contamination 
(sometimes called signal-to-noise ratio) in the electrolyte is approximately 99:1 in 1 mL 
of electrolyte. In other words, for every 99 sample particles, there should be no more than 
1 particle of contamination in the electrolyte.

When the signal-to-noise ratio drops below an unacceptable level, a procedure can be 
performed to remove the presence of contaminates in the electrolyte from the analysis 
data. 

Creating the Sample File

1. Select File > New > Sample Information; the Create a Sample File dialog is 
displayed.

2. Choose a template, then click Create.

3. On the Sample Information dialog:

a. Enter an appropriate description in the Sample field.

b. Select Background as the type of data.

c. Enter a dilution factor of 1.00.

d. Enter information in any other fields as desired (Operator, Submitter, etc.).

4. Click the Analysis Conditions tab, then:

a. Click the down arrow to the right of the Orifice Tube field and choose the orifice 
tube you plan to use.

b. Select Specify Diameter range; using the Minimum and Maximum fields, 
enter the range you plan to use in your analysis. 

c. Click Data Setup; select or enter the following:

Full resolution as the Data Format
Logarithmic in Diameter for Size Classes; class range typically is the same 
range as specified for diameter range

Click OK to return to the Analysis Conditions dialog.

 An Analyst is not authorized to perform background analyses.
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d. Enter appropriate values for other fields (stirrer speed, etc.) on the Analysis 
Conditions dialog.

5. Click the Material Properties tab; select the electrolyte being used. The sample 
material selected is irrelevant since only the electrolyte is being used for a 
background analysis. However, many Elzone users make an entry in the Sample 
Material list pertinent to the background. For example, you may wish to use 
“Background particles.” This is more relevant on the Background report.

6. Click the Report Options tab; select (precede with a check mark):

Inc. Number/mL% vs. Diameter Graph
Summary; click Edit and ensure that Total Number and Volume-Specific Number 
are selected.

7. Click Save; the Save as Sample Information File dialog is displayed.

8. Enter an appropriate identification in the ID field and a comment in the Comment 
window.

9. Click Save to save the file and return to the Sample Information file, then click 
Close.

Performing the Analysis

1. Remove the external electrode and the stirrer propeller (remove the hydropulser tube 
if the hydropulser is installed) from the analyzer.
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2. Using a mild detergent, wash the propeller, the electrode, an appropriate sample 
beaker (refer to the reference material booklet for the size of sample beaker to use), 
and the orifice tube. Use the straight brush provided in the accessories kit to scrub the 
inside and outside of the orifice tube, and the orifice.

3. Rinse all items with filtered water or electrolyte.

4. Reattach the electrode and the propeller (or hydropulser tube) to their proper 
connections.

5. Install the orifice tube onto the sample port (refer to Choosing and installing an 
Orifice tube, page 3-26).

6. Ensure that the appropriate electrolyte is connected to the Supply port.

7. Clean the installed glassware (orifice tube, electrode, and stirrer) externally.

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Place (or hold) a beaker under the glassware. Use the squeeze bottle to 
thoroughly rinse each piece of glassware, then remove the beaker.

8. Fill the analysis beaker with electrolyte (no sample) and place it on the sample stand; 
position the electrode next to the orifice tube so that it will be submerged in the 
beaker. 

It is very important that all components be clean before performing a background 
analysis.

Squeeze bottle
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9. Raise the sample stand.

10. Select Unit [n] > Fill System to fill the orifice tube.

11. Adjust and focus the camera if needed (if using the camera).

12. Select Unit [n] > Sample Analysis to display the analysis screen. Click Browse and 
choose the sample file you created.

After the analysis is finished, save the background data.

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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Calibrating an Orifice Tube

An orifice tube must be calibrated for the instrument on which it is to be used. An orifice 
tube (in the drop-down list) that has not been calibrated will be indicated with an asterisk. 
If you use an orifice tube that has not been calibrated, inaccurate data will be produced. 
An orifice tube is calibrated using reference material(s).  

Follow the instructions below to calibrate an orifice tube. Be sure to have your reference 
materials and the accompanying booklet handy before starting this procedure.

1. Remove the external electrode and the stirrer propeller (remove the hydropulser tube 
if the hydropulser is installed) from the analyzer

2. Using a mild detergent, wash the propeller, the electrode, an appropriate sample 
beaker (refer to the reference material booklet for the size of sample beaker to use), 
and the orifice tube. Use the straight brush provided in the accessories kit to scrub the 
inside and outside of the orifice tube, and the orifice.

3. Rinse all items with filtered water or electrolyte.

4. Reattach the electrode and the propeller (or hydropulser tube) to their proper 
connections.

A Developer must create Analysis Conditions templates using the default Analysis 
Conditions files if an Analyst will be calibrating orifice tubes.

It is very important that all components be clean before calibrating an orifice 
tube.
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5. Install the orifice tube onto the sample port (the instructions on page 3-26 explain 
how to install an orifice tube).

6. Place a beaker (not the sample beaker you washed for the calibration) on the sample 
stand and raise the stand. Refer to User Interface, page 2-3, if you need assistance on 
raising and lowering the sample stand.

7. Clean the installed glassware (orifice tube, electrode, and stirrer) externally:

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Using the squeeze bottle, thoroughly rinse each piece of glassware.

c. Lower the sample stand and remove the beaker.

8. Rinse the clean sample beaker with filtered electrolyte or water.

9. Fill the sample beaker with the amount specified for the beaker you are using (refer to 
the reference material booklet); allow enough room at the top to prevent overflow 
when glassware is submerged.

10. Place the beaker on the sample stand; position the electrode next to the orifice tube so 
that it will be submerged in the beaker. 

11. Raise the sample stand using the knob on the front.

If you have a camera installed on the analyzer, adjust the lens to display the orifice.

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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12. Close the sample compartment door on the right side; adjust the light and camera if 
needed.

13. Select Unit > Fill System; the Fill System dialog is displayed.

This step fills the internal glassware.

14. Click Start; a dialog indicating the operation is in progress is displayed. The dialog 
closes automatically when the glassware is filled.

15. Add the number of drops specified for each reference material (refer to the booklet) 
to the sample beaker.

16. Close the sample compartment door on the front side.
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17. Click Unit > Orifice Tube Calibration; the Orifice Tube Calibration dialog is 
displayed.

18. Click Replace; the Open Analysis Conditions File dialog is displayed.   

For an Analyst, the Open Analysis Conditions Template dialog containing templates 
is displayed. Templates must be created by a Developer; have someone with 
Developer’s rights create templates for the orifice tubes you will be using.

Developer’s view of 
the Open Analysis 
Conditions File 
dialog.
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19. Select the appropriate calibration file for the selected orifice tube. Click OK to return 
to the Orifice Calibration dialog; appropriate values for the calibration will be copied 
into the fields.

20. Click the down arrow to the right of the Orifice Tube field and choose the tube you 
plan to calibrate. If the tube is not in the list, perform the following steps to add it:

 a. Click Add Orifice; the Add Orifice Tube dialog is displayed.

b. Enter an identification in the Orifice Tube ID field. Typically users enter the 
serial number shown on the orifice tube and the size, making it easy to locate in 
the Files list. However, you may wish to establish your own identification 
system.

c. Enter the orifice size in the Diameter field.

d. Click OK to return to the Orifice Calibration dialog.

Size

Serial Number
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21. Click Next; the second view of the Orifice Tube Calibration dialog is displayed.

22. The appropriate reference materials should display in the window; if not, add them as 
follows:

a. Click Add; the Reference Material dialog is displayed.

b. Enter the Identification, Lot Number, Size, and Tolerance in the appropriate 
fields. (This information is found on the reference material bottle or in its 
accompanying booklet.) 

c. Select the Size statistic (also found on the bottle or its booklet).

d. Click OK to return to the Orifice Tube Calibration dialog.

e. Repeat steps a through d for each material to be used in the calibration.
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23. Be sure that only the reference materials to be used in this calibration are selected 
(preceded with a check mark). Double-click on a reference material to place (or 
remove) a check mark.

24. Verify that the appropriate Electrolyte Solution is listed and selected. If it is not 
listed, enter the appropriate information in the Description, Density, and Viscosity 
fields and click Add.

25. Click Next to display the Calibrate Orifice Screen, then click Start; this screen 
displays data as collected.

 

26. When the progress bar reaches 100%, click Save. (The example shown in the 
previous step shows the Save push button disabled; it becomes enabled when the 
calibration is complete.)

If this is a new tube or if the previous orifice tube was different, error message 
6116 will display; click No to close the message.

Becomes enabled 
when calibration is 
complete.

Progress Bar
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27. Click Finish; the Finish dialog is displayed.

Ensure that 0 (zero) is in the Number of Testers Remaining field and the data are 
saved.

28. Click OK; the final Orifice Tube Calibration screen is displayed. 

This screen shows the final parameters of the calibration. It also allows you to define 
the peaks (information on defining peaks can be found on page 5-29). 

29. Ensure that the values for each reference material are within tolerance; click the 
down arrow to the right of the drop-down list to access the reference materials.

30. Click Accept to save the calibration and close the dialog.

Ensure that the 
data are saved.

Be sure no tests 
are remaining.

Click the down 
arrow to display 
each reference 
material and its 
related values.
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Preparing for an Analysis

Choosing and installing an Orifice tube

1. Choose an orifice tube with an orifice that is approximately two times the diameter of 
the largest particles in the sample. If available, a microscope can be used to 
determine particle sizes.

2. Ensure that the orifice tube is calibrated.

a. Click Reports > Orifice Tube Calibration.

b. Click the down arrow to the right of the Orifice Tube field to see if the tube is 
included in the list.

If it is not in the list, you must calibrate the tube (refer to page Calibrating an 
Orifice Tube, page 3-18).

3. Install the orifice tube onto the sample port:

a. Lower the sample stand (if not in the lowered position). 

b. Turn the sample port connector nut counterclockwise to loosen, then remove the 
connector nut, ferrule, and O-ring.

Orifice tubes must be clean to ensure accurate analysis results. Refer to Cleaning 
Orifice Tubes, page 8-9.

To prevent contamination, it is recommended that you wear rubber gloves when 
handling orifice tubes. Be especially careful not to touch the orifice.

Turn connector nut 
counterclockwise (to the left)
loosen and remove.

Electrode
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c. Holding the orifice tube with one hand, slide the connector nut over the top of the 
tube. (Your hand will keep the connector nut in place.) Then slide the ferrule over 
the top of the tube; it will nest down into the connector nut. Now slide the O-ring 
over the top of the tube (approximately 1/4 in. from the top of the tube).

d. Place the connector nut over the sample port and slide the orifice tube into the 
port; turn the connector nut clockwise to tighten. 

Connector Nut

Ferrule

O-ring

  

If a camera is installed, be sure the orifice in the tube is aligned with the camera 
lens. Refer to Appendix G, page G-1 for information and operating instructions for 
the camera.
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Filling the Supply Container

Your supply container should always contain the same electrolyte as the one used to 
prepare and disperse your sample. Be sure your supply container is filled with filtered 
electrolyte before you begin the analysis. Many Elzone users use the ElectroPrep, a unit 
designed to provide a continuous supply of filtered electrolyte. Refer to Appendix D, 
page D-1 for information on electrolytes, how to filter them, and on the ElectroPrep. 

These instructions are for refilling the supply container with the same type of electrolyte 
as previously used. Refer to Changing the Liquid in the Supply Container, page 3-29 
if you plan to use a different type of electrolyte.

1. Unscrew the cap on the supply bottle. 

2. Remove the cap (and tubing); place the tube in a beaker so that the it will not touch 
the work surface and pick up dirt particles.

3. Fill the supply bottle with filtered electrolyte (refer to Preparation of Electrolyte 
Solutions, page D-4 for information on filtering electrolyte).

Reinsert the supply tubing in the container and reattach the cap.

Unscrew the cap of 
the supply bottle.
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Changing the Liquid in the Supply Container

Your supply container should always contain the same electrolyte as the one used to 
prepare and disperse your sample. 

These instructions are written for changing to a liquid of the same type base; for example, 
a water-based electrolyte to a different water-based electrolyte. Use the instructions in 
Changing Liquids of Different Bases if you are changing to a different type base; for 
example, a water-based electrolyte to an alcohol-based electrolyte.   

1. Select Unit > Change Orifice Tube or Liquid; the Change Orifice Tube or Liquid 
dialog is displayed.

2. Read the text in the dialog, then click Start. 

3. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Rinse the container with water (when using water-based electrolytes) or alcohol 
(when using alcohol-based electrolytes).

c. Fill the container with the new electrolyte.

d. Replace the cap and the tube.

4. Click Continue to complete the operation.

5. When the confirmation dialog is displayed, click Done to close the dialog.
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Changing Liquids of Different Bases

These instructions use an example of changing from a water-based electrolyte to an 
alcohol-based electrolyte.

1. Select Unit > Change Orifice Tube or Liquid; the Change Orifice Tube or Liquid 
dialog is displayed.

2. Read the text in the dialog, then click Start. 

3. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Empty the container of the water-based electrolyte, then refill it with water.

c. Replace the cap and the tube.

4. Click Continue.

5. When the confirmation dialog is displayed, click Next Liquid.

6. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Empty the container of the water, then refill it with alcohol (the base for the new 
electrolyte).

c. Replace the cap and the tube.

7. Click Continue.

8. When the confirmation dialog is displayed, click Next Liquid.
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9. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Empty the container of the alcohol, then refill it with the alcohol-based 
electrolyte.

c. Replace the cap and the tube.

10. Click Continue.

11. When the confirmation dialog is displayed, click Done to close the dialog.

Optimizing Instrument Settings

Instrument settings should be optimized:

• at the beginning of each operating shift regardless of whether you have a change in 
electrolyte

• for the electrolyte you are using in your analysis

• when you mix a new batch of electrolyte (even when it is the same type you have 
been using)

• when you change types of electrolyte

Since it is best to use a beaker containing electrolyte only (no sample), you can optimize 
your instrument settings while preparing your sample in a separate beaker. Or you can 
wait until optimization is complete and add the sample to the beaker used in the 
optimizing procedure.

1. Place a beaker of electrolyte onto the sample stand, then raise the stand.

2. Select Unit > Sample Analysis; the Sample Analysis dialog is displayed.

3. Click Browse and choose the file you plan to use for your analysis. 

4. Click Next; the User Log in dialog is displayed.

 An Analyst is not authorized to optimize instrument settings.
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5. Enter your password and click OK; the second view of the Analysis dialog is 
displayed.

6. Click Instrument Setup and ensure that Specify Diameter Range is selected and a 
valid range specified; click OK to close the dialog.

7. Click Optimize Settings. After the analyzer becomes idle, you may:

• Add sample to the electrolyte and continue with your analysis.

• Remove the beaker containing the electrolyte and place the beaker containing 
sample on the sample stand; then continue with your analysis.

• Click Close and restart your analysis when ready.

If you wish to save these settings for future use, click Save Settings to display the 
Save as Analysis Conditions dialog. Enter an appropriate name and click OK. You 
can then use the Replace button on the Analysis conditions portion of the sample 
file to load the settings into your sample file.
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Preparing and Loading Your Sample

Sample Dispersion

You must disperse a sample properly before you can analyze it. Use an effective 
electrolyte and sample dispersion method, obtained from references or by comparative 
testing, for stable counts. The suggested electrolyte strength is:

Approximate conductivity, m-mho/cm = 3000/D 
Approximate equivalent in weight % NaCl = 150/D 

where D = m orifice diameter.

Particle Concentration Guidelines

Coincidence (when two or more particles pass through the orifice at the same time) 
causes an absent portion of the true distribution and a distorted distribution of oversize, 
spurious particles. By using the correct concentration of particles or cells, you can keep 
the coincidence level at a maximum of 1.0%. Any level at or below these concentrations 
is acceptable. Refer to Table 3-1 to determine the concentration of particles in the sample 
solution. 

Table 3-1. Particle Concentration Guidelines

Where headings are described as:

Orifice Diameter 
(m)

N/mL for 1% 
Coincidence

mL/min @ 166 
mmHg

19 1,100,000 0.064

30 280,000 0.18

48 70,000 0.50

76 17,000 1.3

95 8,800 2.1

150 2,200 5.5

190 1,100 8.6

300 280 22.0

380 140 35.0

Orifice Diameter = The diameter (in micrometers) of the orifice being used.

N/mL for 1% 
Coincidence

= The total number of particles or cells in 1 mL of suspension in the 
sample beaker required for a coincidence level of 1.0%

mL/min @ 
166 mmHg

= The flow rate of a 1.0% saline solution through the orifice at a 
vacuum of 166 mmHg.
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Procedure

If possible, prepare your sample when you are ready to start the analysis. If you prepare 
your sample in advance, be sure to place a lint-free cover over the beaker to prevent the 
entry of air-borne particles.

1. Place approximately 0.2 gram of sample into a 25-mL beaker.

2. Add 20 mL of electrolyte to the beaker.

3. Place the beaker in an ultrasonic bath for approximately 1-2 minutes.

4. Clean the external glassware (orifice tube, electrode, and stirrer):

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Hold a beaker under the glassware and, using the squeeze bottle, thoroughly rinse 
each piece of glassware.

5. Place the analysis beaker on the sample stand; position the electrode next to the 
orifice tube so that it will be submerged in the beaker. 

If your sample tends to agglomerate, add a few drops of surfactant. Mix until it 
resembles paste.

If sample particles are fragile, do not use the ultrasonic bath; gently stir with a 
spatula instead.
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6. Add an appropriate amount of sample mix to the analysis beaker; enough to achieve a 
1% coincidence level.

7. Using the schematic (with manual control enabled), ensure that the stirrer is off.

8. Raise the sample stand using the knob on the front. (Refer to User Interface, page 
2-3 if you need assistance on raising and lowering the sample stand.)

9. Close the sample compartment door on the right side; adjust the light and camera if 
needed.

10.  Close the sample compartment door on the front side.

If your sample contains large particles, manually stir the sample mixture while 
transferring to the analysis beaker. This is to prevent the larger particles from 
remaining in the transferring beaker. 

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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Performing an Analysis

Before you start your analysis, be sure you have:

3 cleaned and calibrated your orifice tube; page 3-52

3 filled your supply container with filtered electrolyte; page 3-28

3 emptied your waste container

3 optimized instrument settings for the current electrolyte (this also can be done on 
the second view of the Sample Analysis dialog before you begin your analysis); 
page 3-31

3 created your sample file using appropriate analysis conditions (this also can be 
done from the Sample Analysis dialog); page 3-10)

If your application is noise-sensitive, read the discussion in Appendix H, page H-1 for 
guidelines in obtaining optimum performance from your elzone.

1. Select Unit > Sample Analysis; the Sample Analysis dialog is displayed.

2. Click Browse; the Select a File for Analysis dialog is displayed.

3. Select your file, then click OK; the Sample Analysis dialog now contains all the 
parameters in the file you selected.
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4. Ensure that all parameters are appropriate, then click Next; the User Log in dialog is 
displayed. Enter your password and click OK; the second view of the Sample 
Analysis dialog is displayed.

5.     Click Start to begin the analysis.

After the analysis ends (progress bar reaches 100%), Save is enabled allowing you to 
save the data into the sample file.
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Printing File Contents

You can print the contents of one or more sample file, parameter file, or file template. For 
example, if you print the contents of an analysis conditions file, you will receive the 
parameters used for the analysis conditions associated with the file.

• A Developer can print the contents of sample files, sample templates, parameter 
files, and parameter templates.

• An Analyst can print the contents of sample files, sample templates, and parameter 
templates (not parameter files).

Refer to Print, page 4-59 for detailed information on printing file and template contents.

1. Select File > Print; a drop-down list containing file types is displayed. 

2. Choose the file type; a dialog similar to this one is displayed.

3. From the Files list box, select the desired file. If you plan to print the contents of 
multiple files, hold down Ctrl while clicking on the desired files.

4. Choose whether you wish to print the contents to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to 
four copies.

5. Click Print; the file is printed to the specified destination.

Unavailable 
for an 
Analyst.

These fields do not display if you are printing the contents of a 
parameter file or template.

You can use the Status drop-down list and/or the Date Range push button to limit 
the files displayed in the Files list; refer to page 2-10 for details.
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Listing File Statistics

You can generate a list of the following information on a sample file, parameter file, or 
sample template for one or more files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

Refer to List, page 4-62 for detailed information on listing file statistics.

Perform the following steps to list file statistics:

1. Select File > List.

2. From the List drop-down menu, select the type of file on which you wish 
information. A dialog similar to the one shown below is displayed:

3. From the Files list box, choose the desired file(s). If you wish to include all files, 
leave all files deselected. 

4. Choose whether you wish to print statistics to the screen (Preview) or to a printer 
(Print). If you choose Print, the Copies field is enabled allowing you to print up to 
four copies.

5. Click List, a list for the requested file(s) is sent to the specified destination.

Unavailable for 
an Analyst.
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Importing Sample and Parameter Files

The Import function allows you to import files which have been created on a computer 
other than the one controlling the analyzer and have them display in the Files list window. 

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of 
another copy

Perform the following steps to import a file:

1. Copy the file(s) you wish to import, then paste into the Import directory. Files must 
be copied into this directory; otherwise they will not display in the Files window of 
the Import File dialog.

2. Select File > Import; a drop-down list containing file types is displayed.

3. Choose the file type; a dialog similar to this one is displayed.

4. Select the directory into which you wish to have the file imported. If you are 
importing a parameter file, the Category and Subcategory fields do not display. 
Parameter files are copied automatically into the directory assigned for parameter 
files.

5. Select the file(s) you wish to import; this enables the Import push button.

6. Click Import to import the file.

An Analyst is not authorized to import sample or parameter files.

Does not display 
when importing 
parameter files.

Destination 
fields do not 
display when 
importing 
parameter files.
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Exporting a Sample Information File

Export allows a Developer to:

• export the entire sample file to the Export directory. For example, you may wish to 
use this option to transfer a sample file to another computer.

• copy the full-resolution or isotherm data in a sample information file and export it 
as ASCII text.

You may select multiple files by holding down Ctrl while selecting the desired files. 
Refer to Appendix C on page C-1 for a description of the format used for exported data.

Perform the following steps to export a sample information file or ASCII data:

1. Select File > Export. Then from the drop-down menu, choose Sample information 
or the type of data you wish to export. This example shows exporting a sample 
information file; the dialog for exporting ASCII data is the same.

2. From the Files list box, choose the file(s) you wish to export. You can select multiple 
files by holding down Ctrl while clicking on the desired files. Note that the confirm 
program has assigned a name with an smp extension for each file. Make a note of the 
smp file name(s) you are exporting. You will need this information when you retrieve 
the file(s) from the Export directory.

An Analyst is not authorized to export sample files.

You can use the Status drop-down list and/or the Date Range push button to limit 
the files displayed in the Files list.
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3. Click Export; the file is exported automatically to the export directory.

4. Access the Export directory to retrieve the exported file(s).

Converting Sample Files

The Convert function enables you to convert two different file types to a format 
compatible with the current Elzone program.

• Elzone: copies and converts data from sample files used with the Model 5380 
Series of analyzers

• ASCII: copies and converts data from a text file

Regardless of which type of file you are converting, it must first be copied into the Import 
directory so that it will appear in the Convert dialog. 

Elzone Files

1. Select File > Convert > Elzone; the Convert Elzone Dialog is displayed.

2. In the Destination group box, choose the directory(ies) into which the file is to be 
saved.
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3. Select the file, then click Convert. If converting multiple files, hold down the Ctrl 
key while selecting the files. A conversion dialog containing conversion results is 
displayed.

4. Click X in the upper right-hand corner to close the dialog.

ASCII Text

1. Select File > Convert > ASCII Text; the Convert Text Files Dialog is displayed.

2. In the Destination group box, choose the directory(ies) into which the file is to be 
saved.

Click here to 
close the 
dialog.
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3. Select the file, then click OK. If converting multiple files, hold down the Ctrl key 
while selecting the files. The Select Parameters for Converting (file name) dialog is 
displayed.

This dialog enables you to select the type of data contained in the text file. If you 
have selected multiple files, a dialog is displayed for each file (the name of the file is 
in the header).

4. Click OK; a conversion dialog containing conversion results is displayed (refer to 
page 3-43 for an example of this dialog).

5. Click X in the upper right-hand corner to close the conversion dialog.
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Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or 
multiple graphs for one sample. Graphical lines are differentiated by the use of varying 
symbols and reported in a legend on the report. If color output capability is available, dif-
ferent colors are used instead of symbols.

Graph overlays can be implemented in three ways:

• Multiple Sample Overlays 
Overlay results for up to eight samples on top of a previously selected sample. 

• Multiple Graph Overlays
Overlay two different types of graphs from one sample. 

• Multiple Tests Overlays
Overlay all tests from the sample file. 

Multiple Samples Overlay

This type of overlay enables you to overlay up to eight plots of the same type on top of 
the current plot. The data can be collected on the Elzone, the Saturn DigiSizer 5200, the 
SediGraph 5100, or the SediGraph 5120. 

1. Select File > Open > Sample Information to display the Open Sample Information 
File dialog. 

2. Select a sample on which to overlay graphs of other samples, then click Open; the 
Sample Information dialog is displayed.

An Analyst must click Advanced to access the Report Options tab in order to 
perform these procedures.
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3. Click the Report Options tab to display the Report Options dialog.

4. Choose the desired graph and click Edit; a graph options dialog like the following is 
displayed. 

5. Click on the down arrow at the Overlay field and choose Samples, then click OK to 
close the dialog.

Choose Samples 
from the drop-down 
list.
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6. On the Report options dialog, click Overlays; the Graph Overlay Samples dialog is 
displayed.

7. Click Browse to the right of the Sample 1 field; the Plot Overlay Sample Selection 
dialog is displayed.

8. Choose a sample file, then click OK. You may choose up to eight files in this manner.

9. After selecting the desired number of sample files, click OK to return to the main 
Report Options dialog.

10. Make any other selections if desired.

11. Click Save if you wish to save your Selected Reports list; a dialog prompting for a 
reason is displayed. Even if you don’t save, all of the options regarding overlays and 
anything else are available as your reports are generated. 

12. Select Reports > Start Report; the Start Report screen is displayed with the name of 
your primary file highlighted. 

13. Click Report; one of the following occurs:

• if you clicked Save to save specified overlay options, the Select Reports dialog is 
displayed. 

• If you did not click Save, a dialog stating that a preview report will be generated or 
you can cancel the operation is displayed. If you choose to generate the preview 
report, the Select Reports dialog is displayed.

14. Ensure that the desired graph is selected (preceded with a check mark), then click 
OK.
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Multiple Graphs Overlay

This option enables you to overlay two types of graphs from the same file.

1. Select File > Open > Sample Information to display the Open Sample Information 
File dialog.

2. Select the desired file, then click Open; the Sample Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog (shown on page
 3-45).

4. Choose the desired graph and click Edit; a graph options dialog like the following is 
displayed. 

5. Click on the down arrow at the Overlay field and choose Plot, the Edit push button 
adjacent to the Overlay field is enabled.

Choose Plot from 
the drop-down list.
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6. Click Edit; the Report Options dialog enabling you to specify the plot to overlay is 
displayed.

7. Make your selections and click Ok to return to the graph options dialog, then OK 
again to return to the Report Options dialog. 

8. Make any other selections if desired.

9. Click Save to save your Selected Reports list. Even if you don’t save, all of the 
options regarding overlays and anything else are available as your reports are run. 

10. Select Reports > Start Report; the Start Report screen is displayed with the name of 
your primary file highlighted. 

11. Click Report; one of the following occurs:

• if you clicked Save to save specified overlay options, the Select Reports dialog is 
displayed. 

• If you did not click Save, a dialog stating that a preview report will be generated or 
you can cancel the operation is displayed. If you choose to generate the preview 
report, the Select Reports dialog is displayed.

12. Ensure that the desired graph is selected (preceded with a check mark, then click OK.
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Multiple Tests Overlay

This option enables you to overlay all tests of the same file.

1. Select File > Open > Sample Information to display the Open Sample Information 
File dialog.

2. Select the desired file, then click Open; the Sample Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog (shown on page
 3-45).

4. Choose the desired graph and click Edit; a graph options dialog like the following is 
displayed. 

5. Click on the down arrow at the Overlay field and choose Tests, then click OK to 
return to the Report Options dialog. 

6. Make any other selections if desired.

7. Click Save to save your Selected Reports list. Even if you don’t save, all of the 
options regarding overlays and anything else are available as your reports are run. 

8. Select Reports > Start Report; the Start Report screen is displayed with the name of 
your primary file highlighted. 

Choose Tests from 
the drop-down list.
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9. Click Report; one of the following occurs:

• if you clicked Save to save specified overlay options, the Select Reports dialog is 
displayed. 

• If you did not click Save, a dialog stating that a preview report will be generated or 
you can cancel the operation is displayed. If you choose to generate the preview 
report, the Select Reports dialog is displayed.

10. Ensure that the desired graph is selected (preceded with a check mark), then click 
OK.
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4.  FILE MENU

The File menu contains options that allow you to manage sample files, parameter files, 
and templates.

Description

Listed below are brief descriptions of the File menu options. Detailed descriptions follow 
this section

.
New Enables you to create a sample information or parameter 

file. Page 4-3.

Open Allows you to open an existing sample or parameter file, 
or a sample template. Page 4-49.

Save Saves the file in the active window. Page 4-55.

Save As Enables you to save the file in the active window as a dif-
ferent name. You also can use this command to save a 
subset of a sample file as an independent parameter file. 
Page 4-55.
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Save As Template Enables you to save the values from the open file as a 
template for a sample information or parameter file. Page 
4-57.

Save All Saves all open files. Page 4-57.

Close Closes the file in the active window. Page 4-57.

Close All Closes all open files. Page 4-58.

Print Enables you to print details of a sample information file, 
a parameter file, or a template. Page 4-59.

List Generates a list of certain information for a sample infor-
mation file, a parameter file, or a template. Page 4-62.

Import Allows you to import a sample information or parameter 
file into the assigned application directory. Page 4-63.

Export  Enables you to export data from a sample file in ASCII 
format or the entire sample file. Page 4-64.

Convert Enables you to convert data from a text file or from an 
earlier version of the Elzone program to a format compat-
ible with the Elzone 5390 program. Page 4-65.

Blend Enables you to blend (combine) data from multiple sam-
ple files. Page 4-65.

Average Enables you to obtain an average for data in multiple 
sample files. Page 4-69.

Log In Allows you to log into the application. Page 4-71.

Log Out Allows you to log out of the application. Page 4-72.

Exit Exits the Elzone 5390 program. Page 4-72.
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New

New allows you to create a sample information or parameter file. Regardless of the type 
of file you are creating, a dialog allowing you to choose a template is displayed.

A Developer can create sample information and parameter files. An Analyst can create a 
sample information file using predefined parameter files chosen from drop-down lists.

After you choose a template, click Create to display a dialog for the associated file.

Title bar indicates 
type of file you are 
creating.
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Sample Information

Sample Information files contain information used to control the analysis. Therefore, an 
analysis cannot proceed until it has been assigned a sample information file. A sample 
information file consists of:

• Sample information
• Analysis conditions
• Material properties
• Report options
• Entered or Collected (appears after analysis is complete) data 

Portions of the sample file can also exist as parameter files separate from the sample 
information file itself. These parameter files contain frequently used analysis conditions, 
material properties, and report options that can be conveniently loaded into a new sample 
information file. 

A sample information file can be created by an Analyst or a Developer. A Developer can 
create a sample file in its entirety, specifying values for all parameters; all fields on the 
dialogs are enabled for input from a developer. An Analyst can create a sample file by 
selecting predefined parameter files from drop-down lists.

Analyst

The Sample Information dialog displays in this manner for an Analyst.
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Sample This field defaults to the description of the template. You 
must enter a new description or edit the existing one; the 
Confirm program does not allow duplicate descriptions. 
The description you enter in this field appears in the Files 
list window on the Open Sample Information dialog. You 
can use up to 50 alphanumeric characters.

Analysis Conditions
Material Properties
Report Options

These fields contain the descriptions of the current 
parameter files. Click on the down arrow to the right of 
the fields to choose different files. These drop-down lists 
contain predefined files created by a Developer. You can 
view the values contained in the files by clicking 
Advanced; however, you cannot edit the values.

Orifice Tube Displays the orifice tube specified in the Analysis Condi-
tions file.

Number of tests Enables you to enter the number of tests you wish to per-
form using this file; you can perform up to eight tests 
with each file.

Background Select this option to have background data collected. If 
you select this option, be sure that Full-resolution is 
selected as the type of data in the analysis conditions dia-
log (Data Setup push button).

Stirrer Speed Enables you to specify a stirrer speed. 

The speed ranges from 1 to 10 with 1 being the lowest; 0 
(zero) turns the stirrer off.

Stirrer Direction Enables you to specify a direction for the particle circula-
tion. 

Up rotates the stirrer in a direction that pushes the parti-
cles upward. Down rotates the stirrer in the opposite 
direction, pushing the particles downward. 

This option is not applicable if you have a hydropulser 
installed on the Elzone analyzer.
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Dilution Factor Enables you to enter the ratio of sample volume to elec-
trolyte volume. This value can be easily determined using 
the following formula:

         

Mass Concentration Enter the mass concentration of the sample you are ana-
lyzing.

Rinse Select this option to have rinse(s) performed; all options 
in this group box are enabled.

Use the times field to enter the number of rinses desired. 
Then choose when the rinse(s) is(are) to be performed; 
you can rinse before or after the analysis.

From the two options on the right side of the group box, 
choose the type of rinse desired. Drain and fill com-
pletely drains the system, then refills it. Flush simply 
flushes concentration through the system, maintaining 
liquid in the system at all times.

Select Purge Volumetric Pump to have the volumetric 
pump (if installed) purged during the rinsing process.

Replace All Click this push button to replace all parameters of the 
current sample file with those from another one.

Revert Displays the Revert dialog allowing you to choose a pre-
vious version (if any exist) of the sample file.

This dialog lists previous versions of the current file and 
the comment entered for each one; it does not list the cur-
rent version. You can use the drop-down list to choose 
other versions; each version’s comments will be listed in 
the Comments window.

DF
sample volume  electrolyte volume+

sample volume
----------------------------------------------------------------------------------------------------=
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Reports to Generate Displays a list of available reports. Reports preceded by a 
check mark are those that have been selected for the cur-
rent template. To select additional reports, simply dou-
ble-click on the desired report. Alternatively, you can 
highlight the report and press the Spacebar. Reports are 
deselected in the same manner.

Save Displays the Save As Sample Information File dialog.

From this dialog, choose the directory in which to save 
the file. Enter a comment and edit the ID of the file. The 
Save push button becomes enabled allowing you to com-
plete the save operation after you make an entry. 

If Save does not become enabled after an entry is made 
in the Comments window, a file with the same ID cur-
rently exists in the selected directory. You must choose a 
different directory or edit the identification of the current 
file. The Elzone Confirm program does not allow dupli-
cate descriptions.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog box closes.

Advanced Displays the sample information dialog in the Devel-
oper’s format. This format allows you to view details of 
the sample file and allows some fields to be edited. Refer 
to the next section for a description of the fields for the 
Developer’s format.
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Developer

The Sample Information dialog displays in a manner similar to that of an index card file 
for a Developer. Each parameter has its own tab and is accessed by clicking the tab. Or, 
you can use Next and Prev to move back and forth through the dialogs. 

The prompts for the Sample, Operator, Submitter, and Bar code fields may be 
customized by selecting Options > Edit Labels. Refer to Edit Labels, page 7-4 for 
instructions on having these prompts display differently.

Some fields on the Developer’s view of the Sample Information dialog are also enabled 
for an Analyst when Advanced is clicked from the Analyst Sample Information dialog.

Sample Displays the description for the current sample template. 
You must enter a new description or edit the existing one; 
the Elzone confirm program does not allow duplicate 
descriptions. The description you enter in this field 
appears in the Files list window on the Open Sample 
Information dialog. You can use up to 50 alphanumeric 
characters.

Operator 
Submitter

Enter the name of the operator who will be using this file 
to perform the analysis and the name of the person (or 
department) submitting the sample for analysis. You can 
use up to 40 characters in each field.

A Collected Data tab 
displays here when 
analysis is complete.

An Entered Data tab 
displays if you choose 
Manually entered, 
allowing you to enter 
the data.
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Bar code This field enables you to enter bar code information. If 
bar code information is not being used, you can use this 
field to enter additional information about the sample; for 
example, you may wish to enter the lot number of your 
sample. You can enter up to 40 characters in this field.

This field will also accept data from a bar code reader.

You can edit this prompt to display as a different label if 
desired, or you can omit it entirely from the sample file 
editor (refer to Edit Labels, page 7-4).

Type of Data You can have data collected automatically, manually 
enter data, or collect data for a background.

If you choose Manually entered, an “Entered” tab is 
added so that you may enter the desired data. You cannot 
enter data if you are creating the file on a computer that is 
not attached to the analyzer. 

If you choose Background, be sure to select full resolu-
tion data using the Data Setup push button on the Analy-
sis conditions dialog.

User Parameters These fields are used primarily for SPC (Statistical Pro-
cess Control) reporting. However, they can be used for 
other data as well. You may wish to enter specific analy-
sis conditions or sample criteria such as the weight. 
These parameters will print on the Summary section of 
the Combined report. Select Options > Edit Labels to 
specify the parameters you wish to report. The parame-
ter(s) you specify replace the User Parameter label(s) 
displayed here.

If desired, you can have these fields omitted from the 
sample information file (refer to Edit Labels, page 7-4).

Dilution Factor Enables you to enter the ratio of sample volume to elec-
trolyte volume. This value can be easily determined using 
the following formula:

             DF
sample volume  electrolyte volume+

sample volume
----------------------------------------------------------------------------------------------------=
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Mass Concentration Enter the mass per unit volume (in grams per L) for the 
sample you are analyzing.

Comments Use this field to enter any comments about the sample or 
the analysis conditions that you wish to note. Comments 
entered here are printed in the header of some reports.

You can enter up to 500 alphanumeric characters.

Add Log Entry Displays a dialog allowing you to enter pertinent infor-
mation relating to the sample. Any information you enter 
here is printed as part of the Sample Log report (select in 
Report Options).

Revert Displays the Revert dialog allowing you to revert back to 
a previous version of the sample file.

The Revert dialog lists previous versions of the current 
file and the comment entered for each one; it does not list 
the current version. You can use the drop-down list to 
choose other versions; each version’s comments will be 
listed in the Comment window.

Replace All Click this push button to replace all parameters of the 
current sample file with those from another one.
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The Analysis Conditions, Material Properties, and Report Options tabs of the 
Advanced presentation sample information file are described in subsequent sections.

Save Displays the Save as Sample Information File dialog 
(shown on page 4-7). 

This dialog allows you to choose the directory in which 
to save the file. The Save push button becomes enabled 
allowing you to complete the save operation after you 
make an entry in the Comments window. If Save does 
not become enabled after an entry is made in the Com-
ments window, a file with the same identification cur-
rently exists in the selected directory. You must choose a 
different directory or edit the identification of the current 
file. The Confirm program does not allow duplicate 
descriptions.

Save as Template Enables you to save all parameters of the current file as a 
sample information file template.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog closes.

Basic Displays the sample information dialog in the Analyst 
format (explained in the previous section). 
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Analysis Conditions

This dialog allows you to specify analysis conditions for your sample. You can create an 
Analysis Conditions file as an independent parameter file or as part of a sample 
information file. You can also save the analysis conditions portion of a sample 
information file as an analysis conditions file.

An Analyst is not authorized to create Analysis Conditions files.

Analysis Conditions Displays a description of the current Analysis Conditions 
template. Enter a new description or add to the existing 
one if desired; the Elzone Confirm program does not 
allow duplicate descriptions. 

Be sure to use an intuitive name (perhaps one that charac-
terizes the analysis conditions) so that it can be easily 
recognized when needed. 

You can enter up to 40 alphanumeric characters in this 
field.

Replace Allows you to replace the values in the current file with 
those from an existing file. Simply click the push button, 
choose the desired file, and click OK. The values of the 
chosen file are copied into the current file; you can edit 
them as desired.
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Orifice Tube This drop-down list contains existing orifice tubes. If the 
orifice tube has not been calibrated, its name (descrip-
tion) is preceded with an asterisk (*). The diameter of 
the selected orifice tube is displayed adjacent to the Ori-
fice Tube field.

You must select an appropriate orifice tube before you 
can perform an analysis.

Add Orifice Displays the Add Orifice Tube dialog so that you can 
add an orifice tube to the drop-down list. 

Delete Orifice Deletes the orifice tube currently displayed in the 
Orifice Tube field; a confirmation dialog is displayed 
before the tube is deleted from the list.

Particle Size Range These options enable you to specify a diameter range or 
specify instrument settings.

Specify Diameter 
range

Enables you to specify a range for the size of particles to 
be read. You should stay within 2% to 70% of the orifice 
diameter and should not exceed a 30:1 ratio.

When you choose this option, the instrument settings are 
automatically set by the software. Most Elzone users 
choose this option.

Use instrument 
settings

Enables you to specify settings for the instrument. This 
option is used by a more advanced user. This option can 
also be used if you have a sample file used in an analysis 
and which contains appropriate settings.

Settings Displays the Signal Settings dialog allowing you to 
define signal settings for analysis conditions.
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If you choose Specify Diameter range on the Analysis 
Conditions dialog, the fields on this dialog are disabled 
and display the settings automatically set by the 
software. If you feel the settings are inappropriate, you 
can select Use instrument settings and edit the values 
as required.

Use instrument settings This option enables you to specify instrument settings 
and should be used only by a more advanced Elzone 
user.

Current
Gain

Adjust these values to determine the size of particles to 
be read. Increase the settings to include smaller particles; 
decrease them for larger particles.

Low Threshold Enabled when you deselect Keep size range constant, 
allowing you to enter a value for the threshold.

The threshold is the lower limit of the size distribution. 
The lowest optimum threshold is determined 
automatically by the software. 

Load Resistor Enabled when you deselect Keep size range constant, 
allowing you to choose a different value for the load 
resistor. 

This function helps to reduce the noise level for high- or 
low-conductive electrolytes. Typically, a larger load 
resistor corresponds to smaller orifices.
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Keep size range 
constant

If this option is selected, you can adjust the current and 
gain only. Each time you edit one, the other is automati-
cally adjusted to keep the range constant for the selected 
ratio.

If you deselect this option, the Low Threshold and Load 
Resistor fields, and the options in the Measured Parti-
cle Scale group box are enabled.

Measure conductivity 
before each test

Select this option to have the conductivity measured 
before each test specified in the file. 

If you deselect this option, the last conductivity recorded 
for the current orifice tube and liquid will be used.

Measured Particle 
Scale

Provides options for a linear or logarithmic scale. If you 
choose Logarithmic, the Particle Diameter ratio field 
is enabled, allowing you to choose a ratio (largest particle 
to the smallest particle) from the drop-down list.

Electrode 
Connections

Enables you to choose a normal or reversed connection. 

Normal transmits the electric current from the inside of 
the orifice tube to the outside.

Reversed transmits the electric current from the outside 
of the orifice tube to the inside.

Rinse Select this option to have rinse(s) performed; all options 
in this group box are enabled.

Use the times field to enter the number of rinses desired. 
Then choose when the rinse(s) is(are) to be performed; 
you can rinse before or after the analysis.

From the two options on the right side of the group box, 
choose the type of rinse desired. Drain and fill com-
pletely drains the system, then refills it. Flush simply 
flushes concentration through the system, maintaining 
liquid in the system at all times.

Select Purge Volumetric Pump to have the volumetric 
pump (if installed) purged during the rinsing process.

Number of tests Enables you to enter the number of tests you plan to per-
form using the current file; you can perform up to eight 
tests with each file.
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Stirrer Speed Allows you to specify a stirrer speed (or pulse rate). The 
lower the number, the lower the speed; 0 (zero) turns the 
stirrer (or hydropulser) off.

Stirrer Direction Enables you to specify a direction for particle circulation. 

Up rotates the stirrer in a direction that pushes the parti-
cles upward. Down rotates the stirrer in the opposite 
direction, pushing the particles downward.

This option is not applicable if you have a hydropulser 
installed on the Elzone analyzer.

Flow Control Displays the Flow Control dialog allowing you to specify 
the flow rate of the analysis liquid and to choose a block-
age detection method.

Flow Control Choose the type of flow control desired; then enter a 
value in the adjacent field. 

Differential Pressure is the default and typically is used 
for collecting sizing data. This is the method used on the 
Elzone 5380 series analyzers.

Differential Flow Rate typically is used for concentra-
tion and sizing analyses in which a known volume of liq-
uid is measured.

Volumetric Flow Rate is used for the same type of anal-
yses as Differential Flow Rate; however, data typically 
are a little more accurate. This option is not available if 
you do not have the volumetric pump installed. 
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Blockage You can choose to have blockages detected and cleared 
during analysis (default) and/or at the start of the analy-
sis.

Pump and fan off during 
data collection

Turns the pump and fan off during data collection. You 
may wish to use this option for extremely noise-sensitive 
applications, such as when using a small orifice tube (19 
or 30 m) with low conductivity electrolytes.

Data Setup Displays the Data Setup dialog enabling you to specify 
how raw data are to be produced. 

After analysis is complete, the parameters for data setup 
can be edited by clicking Data Setup on the Collected 
Data dialog explained on page 4-43.
539-42822-01 (Rev B)  - Nov 2017                                                    4-17 



Elzone II 5390 Confirm New
Calibration Displays the date and time for the type of calibration 
selected. Click Change to choose a different type of 
calibration; the Calibration Type dialog is displayed. 

Reference material measurement
Uses data from a reference material measurement.

Mass integration measurement
Before the analysis, displays Measured; after analysis, it 
will display the date and time of the analysis that was 
used for the measurement.

Entered calibration factor
Enter the desired calibration factor. The following table 
provides the nominal Kd values for Elzone orifice tubes.

Nominal Kd values for Elzone Orifice Tubes

Orifice Size Kd

19 33
30 42
48 60
76 93
95 120
150 185
190 250
300 448
380 582

Calibration copied from sample
Uses calibration data from a completed sample file that 
used the same orifice tube; the Browse push button is 
enabled allowing you to choose the file.
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Correct for 
Coincidence

Select this option to have coincidence correction applied.

It is always possible that two or more particles may pass 
through the orifice at the same time, this is known as 
coincidence. Coincidences cause a portion of the true dis-
tribution to be absent and a distorted distribution of over-
size, spurious particles. The coincidence correction 
removes distortion from the distribution and restores the 
missing pulses.

Subtract Background This option enables you to subtract any particles that may 
have been detected in the background measurement.

When you select this option, be sure to click Browse and 
choose a background file or select Use most recent 
background. If you choose a background file that con-
tains numerous tests, the test that is selected from the 
Test drop-down list on the Report Options dialog is the 
one that will be used for the background subtraction.

Subtract Background
(continued)

If you neglect to choose a background, you will be 
warned at the time of analysis and given another opportu-
nity to select a background. If a background is still not 
selected, a “null” background will be used for data reduc-
tion.

The type of background subtraction you use will be 
printed in the report header.

Use most recent 
background

Select this option to use the most recent background.

If you wish to use a different background file, deselect 
this option and use the Browse push button to choose the 
file containing the desired background.

Size Classes The options in this group box enable you to specify how 
distribution data are binned (sorted).

You can choose to report data as linear or logarithmic 
by diameter or volume. 

Use the classes field to specify the number of classes 
desired, and the range fields to enter a range.

Distribution Enables you to choose the manner in which data are pre-
sented; choose one from each column.
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Smoothing Select Smooth Data to reduce data scattering.

Use the Groups of drop-down list to choose the number 
of size classes to be included.

The smoothing process defaults to 1; however, you can 
have it repeated by choosing 2 from the Repetitions 
drop-down list.

Data Format Enables you to choose the type of data format you wish 
to store in the sample file. These choices affect the size of 
the sample file. 

Full resolution
This option saves and stores full-resolution data. Be sure 
to select this option if you plan to generate pulse length 
reports or if you are collecting background data.

Reduced
This option saves only the binned data; high-resolution 
data are lost. The size of the file is reduced but you can-
not edit any data setup parameters (collected data dialog) 
other that distribution and smoothing.

Store pulse length vs. particle size data
Select this option to have pulse length and particle size 
data collected and stored for the Pulse length vs. particle 
size data report. If this option is not selected, you will be 
unable to generate the report.

Extrapolation Use this feature to complete data below the ending point 
when data does not return to zero on the y-axis; missing 
points will be calculated automatically.

You can also have data extrapolated after the analysis 
(see Collected Data, page 4-43).

Ending Conditions  Choose one of these options to specify when to end the 
analysis.

Time Analysis ends when the specified time interval expires.

Volume Analysis ends when the specified liquid volume is 
reached.
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Total count Analysis ends when the specified number of particles 
over the entire range is reached.

Modal count Analysis ends when the specified number for the particle 
size is reached. 

Save Displays the Save as Analysis Conditions File dialog

If the Save push button is not enabled, a file with the 
same ID currently exists. You must edit the identification 
of the current file before it can be saved. The Elzone 
Confirm program does not allow duplicate descriptions.

Save as Template Enables you to save all parameters of the current file as 
an Analysis conditions template.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog closes.
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Material Properties

This dialog allows you to specify the properties of the sample material being analyzed 
and the electrolyte solution in which it is dispersed. You can create a Material Properties 
file as an independent parameter file or as part of a sample information file. You can also 
save the materials properties portion of a sample information file as a material properties 
file.

An Analyst is not authorized to create Material Properties files.

Material Properties Displays a description of the current Material Properties 
template.

Enter a new description or add to the existing one if 
desired; the Elzone Confirm program does not allow 
duplicate descriptions. Be sure to use an intuitive name 
(perhaps one that characterizes the sample’s properties) 
so that it can be easily recognized when needed.

You can enter up to 40 alphanumeric characters,

Replace Allows you to replace the values in the current file with 
those from an existing file. Simply click the push button, 
choose the desired file, and click OK. The values of the 
chosen file are copied into the current file; you can edit 
them as desired.
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Sample Material Displays a list of available sample materials. After you 
select a sample material from the list, its description and 
properties are displayed. 

Description Displays the sample material you select from the list. 
This field is also used to add sample materials to the list. 

Density Displays the density of the selected material. 

Shape Factor Displays the shape factor of the selected material, or 
enables you to enter a shape factor for a material you are 
adding to the list.

The shape factor is an adjustment for non-spherical parti-
cles.

Maximum current Displays the maximum current for the selected method.

Add Enables you to add sample materials to the list.

Use the Description, Density, Shape Factor, and Maxi-
mum Current fields to enter your material and its prop-
erties, then click Add to add it to the list.

Delete Deletes the selected material from the list.

Electrolyte Solution Displays a list of available electrolyte solutions (dispers-
ing liquids). After you select a solution from the list, its 
description and properties are displayed.

Description Displays the electrolyte solution you select from the list. 
This field is also used to add liquids to the list.

Density Displays the density of the selected electrolyte solution. 

Viscosity Displays the viscosity of the selected electrolyte solution.

Add Enables you to add sample materials to the list.

Use the Description, Density, and Viscosity fields to 
enter your electrolyte and its properties, then click Add to 
add it to the list.

Delete Deletes the selected electrolyte solution from the list.
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Dispersion Enables you to enter pertinent information about the dis-
persion. The information you enter in this window 
appears in the Options report.

Save Displays the Save as Materials Properties File dialog (see 
page 4-21 for an example of this dialog). 

If the Save push button is not enabled, a file with the 
same ID currently exists. You must edit the identification 
of the current file before it can be saved. The Elzone 
Confirm program does not allow duplicate descriptions.

Save as Template Enables you to save all parameters of the current file as a 
Materials properties template.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog box closes.
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Report Options

This dialog enables you to select report options. You can create a Report Options file as 
an independent parameter file or as part of a sample information file. You can also save 
the Report Options portion of a sample information file as a report options file

An Analyst is not authorized to create Report Options files.

Report options Displays a description of the current Report Options tem-
plate. 

Enter a new description or add to the existing one if 
desired; the Elzone Confirm program does not allow 
duplicate descriptions. Be sure to use an intuitive name 
so that it can be easily recognized when needed. 

You can enter up to 40 alphanumeric characters.

Replace Allows you to replace the values in the current file with 
those from an existing file. Simply click the push button, 
choose the desired file, and click OK. The values of the 
chosen file are copied into the current file; you can edit 
them as desired.

A report is 
selected when 
preceded with a 
check mark.
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Show report title Select this option to have a title appear at the top of your 
report; use the adjacent field to enter the text.

You can enter up to 40 characters.

Show graphic Select this option to have a graphic (bitmap or enhanced 
metafile) display above the report title. For example, you 
may wish to display your company logo. Click Browse 
to select the desired graphic, then use the Height and 
Width fields to specify the size. This image can be edited 
from the report window.

Test Use this drop-down list to choose the test on which to 
report data. You can report data from the first test, the last 
test, an average of all tests, or on all tests.

For background files, the test selected in this field is the 
one that will be used for any background operation; for 
example if you have selected this file to use for subtract-
ing a background.

Reference Displays the Reference Sample dialog so that you can 
specify a sample file with which to compare analysis 
results of the current sample; produces a Difference of 
Reference report.

Click Browse to display the Reference Sample File 
Selection dialog containing a list of sample files from 
which to choose a file. 

Use Clear to clear a field of its entry.
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Specification Displays the Specification Samples dialog so that you 
can specify the sample files to be used for the boundaries 
of the coarse and fine specifications; produces an Out of 
Specification report. Then you can quickly determine if 
the results of the current sample are within the specified 
boundaries.

Click Browse to the right of each field to display the 
Specification Sample File Selection dialog containing a 
list of sample files from which to choose a file. 

Use Clear to clear a field of its entry.

Overlays Displays the Graph Overlay Samples dialog so that you 
can choose the sample files containing the data you wish 
to overlay onto a selected plot.

Click Browse to the right of the sample number field(s) 
to choose the desired file(s). Use Clear to clear a field of 
its entry. You can select up to eight files.
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Overlays
(continued)

After choosing the desired files, be sure to edit the type 
of graph you are overlaying and choose the Overlay 
samples option. 

Peaks Displays the Peak Detection Settings dialog, allowing 
you to choose how peaks are detected.

Auto Select this option to have peaks detected automatically. 
When you select this option, the Minimum distribution 
to report and Minimum valley depth to separate 
peaks fields are enabled, allowing you to specify a 
threshold for the peak size.

The valley depth option enables you to specify a 
threshold for resolving multiple peaks. Valley depth is 
calculated as:

a b–
a

------------ 100%
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Auto
(continued)

where a = the smaller peak
b = lowest point between the two peaks

If the depth is greater than the value you enter as the 
minimum, the two peaks are treated as separate; 
otherwise, they are treated as one peak.

Manual This option enables you to define the peaks by Diameter 
or Volume. Use the table to enter the minimum and 
maximum values for each peak to be detected.

Reports to Generate Contains a list of available reports.

A report is selected when it is preceded with a check 
mark. Select reports by double-clicking the desired 
report(s). Alternatively, you can highlight the desired 
report and press Spacebar. Reports are deselected in the 
same manner. Certain reports can be edited by highlight-
ing the desired report and clicking Edit. 

You can also generate Statistical Process Control (SPC) 
reports using the options on the Reports menu.

Edit Enables you to edit the highlighted report. Refer to sub-
sequent sections for editing details on the reports avail-
able with the Elzone program.

The following reports cannot be edited:

• Calibration
• Log Probability
• Options
• Rosin Rammler
• Sample Log 

a b
539-42822-01 (Rev B)  - Nov 2017                                                    4-29 



Elzone II 5390 Confirm New
Save Displays the Save as Report Options File dialog (see 
page 4-21 for an example of this dialog). 

If the Save push button is not enabled, a file with the 
same ID currently exists. You must edit the identification 
of the current file before it can be saved. The Elzone 
Confirm program does not allow duplicate descriptions.

Save as Template Enables you to save all parameters of the current file as a 
report options template.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog box closes.
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Graphs

All graph report options are similar and are edited in the same manner. Click Edit for a 
selected graph report; a dialog similar to the following is displayed.

Data Plot
Difference from Reference
Out of Specification

From this group, choose the type of plot desired.

If you select Difference from Reference or Out of Spec-
ification, be sure to click the related push button on the 
Report Options dialog to choose the file(s).

Points
Curve
Histogram
Curve and Points

Enables you to choose the manner in which to have data 
plotted.

X-Variable Enables you to choose the x-axis variable.

Y-Variable Enables you to choose the y-axis variable and the manner 
in which it is to be plotted.

Overlay Click on the down arrow to display the types of overlays 
available.
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Samples Enables you to overlay the current curve with the same 
type of curve from multiple sample files. Click Overlays 
on the Report Options dialog to choose the sample file(s) 
containing the desired curves.

Tests Enables you to overlay the same type of curve from all 
tests performed with this file.

Plot Enables you to overlay a different variable with the 
selected variable (the one you are currently editing). Use 
the Edit button to specify details.

Edit Enabled when you choose Plot as the type of overlay 
allowing you to choose the overlay variable and specify 
details; the Overlay Settings dialog is displayed.

X-Axis
Y-Axis

Allows you to choose between a Linear or Logarithmic 
scale as well as autoscale options.

Autoscale Select this option to have the Y-axis scaled automatically. 
The scale begins at zero; the highest values collected dur-
ing analysis are the ending points. 

If you deselect this option, the adjacent fields become 
enabled so that you may specify a range. Valid ranges are 
displayed in the information bar when the field is 
selected.
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Editing Tables

Select a table to edit; a dialog similar to this one is displayed.

The Standard Class Size Table and the Standard Sieve Table are fixed and, therefore, do 
not contain a table of values, nor push buttons.

• The Standard Class Size Table is fixed based on the classes specified in Analysis 
conditions (Data Setup). After the analysis is finished, data can be edited from the 
Collected Data dialog.

• The Standard Sieve Table is fixed based on the sieves specified using the Data 
presentation, Sieve Table option on the Options menu. 

Table Enter the values at which you wish the data to be reported 
(or accept the defaults).

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

The title bar 
displays the 
name of the 
table being 
edited.

Included only on the Cumulative 
Fraction Table dialog.

The table and editing push buttons do not display 
if you are editing the Standard Class Size or 
Standard Sieve Table.
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Rosin Rammler

The Rosin Rammler report depicts the collected data as applied to the Rosin Rammler* 
theory; this report cannot be edited.

Insert Inserts a point above the selected point.

Use Ctrl  to add points at the beginning of the table and 
Ctrl to add points at the end of the table.

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

Delete Deletes the selected point.

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

Clear Clears all but one point from the table; one point is 
required.

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

Column [n] Select these options to choose the type of data to display 
in report columns. Then click its adjacent Edit push but-
ton to specify details.

Sort Order Choose whether you wish to have points collected in an 
ascending or descending order.

Truncate table at
distribution limits 

Select this option to have the table shortened to the limits 
of the distribution.

Cumulative table by Enables you to select the manner in which to display the 
Y-axis.

Displays only on the Cumulative Fraction Table dialog.

*Rosin, P. and Rammler, E., J. Inst. Fuel, 7, 20 (1933)
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Log Probability Report

The Log Probability Report provides a comparison of the collected data to that of a log-
normal distribution; it cannot be edited. 

Summary Report

The Summary report provides a condensed listing of analysis statistics and data results. 
The Summary Report Options dialog allows you to choose the type of information to 
include in the report.

Statistics 
Type/Distribution

Choose the type of statistics and distribution you wish to 
report.

Arithmetic Statistics Choose the arithmetic statistics you wish to include in the 
report.

Statistics Select the variables you wish to include in the report.

Reports Choose the type of distribution(s) you wish to report.
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Percentiles Displays the Summary Percentiles dialog.

This dialog allows you to report the particle diameter (or 
radius) corresponding to each specified coarser (or finer) 
percentile. You can enter up to 10 values in any order. If 
you enter zero (0.00), a blank line is shown on the 
report.

Sizes Displays the Summary Sizes dialog.

This dialog allows you to report the cumulative percent 
(or fraction) coarse (or finer) for each specified diameter 
(volume). You can enter up to 10 values in any order. If 
you enter zero (0.00), a blank line is shown on the 
report.
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Peaks Displays the Summary Peaks dialog.

This dialog enables you to specify the types of data to 
display in the columns of the peak table. Column 1 is 
fixed and cannot be edited.

Sample Choose the sample parameters you wish to include in the 
report.
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Background Report

Select Background to edit; the Background Options dialog is displayed.

Overlay backgrounds Choose this option to overlay the background of this 
sample analysis with the background(s) of other analyses. 
Click Overlays on the Report Options dialog to choose 
the files containing the backgrounds you wish to overlay.

Points
Curve
Histogram
Curve and Points

Choose the manner in which you wish the background 
data to display.

X variable Choose the variable you wish to display for the X-axis.
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Pulse Length vs. Particle Size Report

Select Pulse Length vs. Particle Size to edit; the Pulse Length vs. Particle Size Report 
Options dialog is displayed.

This dialog enables you to specify a variable for the x- and y-axes. You must also ensure 
that the pulse length and particle size data are stored to obtain this report. This is 
requested on the Analysis conditions screen; click Data Setup and select the Store pulse 
length vs. particle size data option located on the lower portion of the dialog. If this 
option is not selected, appropriate data will not be stored and, therefore, the Pulse Length 
vs. Particle Size report cannot be produced. You must also choose Full Resolution data 
on the Data Setup dialog (page 4-20) to generate this type of report.
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Pulse Length Report

Select Pulse Length to edit; the Pulse Length Report Options dialog is displayed. When 
generating this type of report, you must choose Full Resolution data (page 4-20) on the 
Data Setup dialog before analysis.

X Axis Variable Enables you to have the X-axis variable reported as Pulse 
Duration or Pulse Length. When Pulse Length is 
selected, the Subtract Orifice Length field is enabled; 
this allows you to have the orifice length subtracted from 
the pulse length.

Y Axis Variable Enables you to have the Y-axis variable reported as Incre-
mental or Cumulative.

Overlay Select Tests to overlay data from all tests in the current 
file, or Samples to overlay data in the current file with 
data from other analyses.

If you select Samples, select Overlays on the Report 
Options dialog to choose the files you wish to use.

X-axis
Y-axis

Allows you to choose between a Linear or Logarithmic 
scale as well as autoscale options.
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Options Report

The Options report is a subset of the contents report; it provides pertinent information for 
the following:

• the sample
• analysis conditions
• material properties
• data collection

The Options Report cannot be edited.

Calibration Report

The Orifice Tube Calibration report contains tabular data for the reference material and 
goodness of fit, as well as a graphical representation of the goodness of fit. This report 
can also be generated using the Orifice Tube Calibration command on the Reports menu; 
refer to Orifice Tube Calibration, page 6-7 for additional information on this report.

The Calibration Report cannot be edited.

Sample Log Report

The Sample Log Report provides the following statistics:

• manual control operations performed during analysis
• Information entered using the Add Log Entry push button on the sample file editor
• warnings and/or errors that occurred during analysis

The Sample Log Report cannot be edited.

Autoscale Select this option to have the X- and/or Y-axis scaled 
automatically. Both axes begin at zero; the highest values 
collected during analysis are the ending points. 

If you deselect this option, the adjacent fields become 
enabled so that you may specify a range. Valid ranges are 
displayed in the information bar when the field is 
selected.
539-42822-01 (Rev B)  - Nov 2017                                                    4-41 



Elzone II 5390 Confirm New
Combined Report

Select the Combined Report to edit; the Combined Report Options dialog is displayed.

The list of reports for the Combined Report is almost identical (the Combined report, of 
course, is not included in this list) to the list of reports generated in the normal manner. 
The difference is that the reports generated from the selections on this dialog contain no 
page breaks or headings. And, unless too many are selected, all reports display on a 
single page.
4-42                                                    539-42822-01 (Rev B)  - Nov 2017



New Elzone II 5390 Confirm
Collected Data

The tab for Collected Data does not appear on the Developer’s Advanced dialog 
presentation until after analysis.

Table Displays data points for the current test selected from the 
Test drop-down menu.

Test Displays the current test for this sample file. If you wish 
to view data for another test, click on the down arrow to 
select the desired test.

Delete Test Click this push button to delete the test displayed in the 
Test field. If only one test exists, this push button is dis-
abled; one test must remain in the file.

Merge with external 
data

Enables you to merge data collected by some other 
method with the data of the current test. Click External 
Data to enter the data to be merged.

External Data Enabled when you select Merge with external data. 
Displays the External Data dialog so that you can enter 
the data you wish to have merged.
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Full scale volume
percent

Select this option if you analyzed part of the sample by 
another method but you do not wish to merge the results 
with the reports for the current test. Specify the volume 
percent of the sample actually analyzed by the analyzer 
versus the percent that is manually analyzed. The data are 
scaled accordingly. 

Disabled when Merge with external data is selected.

Distribution Type Allows you to choose the type of distribution to display 
in the table.

Data Setup Displays the Data Setup dialog. This dialog enables you 
to edit the manner in which the data are displayed. If 
Reduced was selected as the Data Format, many of the 
options are disabled and cannot be edited. 

Subtract Background Enabled for Full resolution data allowing you to subtract 
particles that may have been detected in the background 
measurement. After you select this option, click Browse 
to choose the background file you wish to use.

If you choose a background file containing multiple tests, 
be sure to access the Report Options dialog in the file and 
ensure that the desired test is selected in the Test field 
prior to selecting it on this dialog.
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From Graph This option enables you to choose a size range marked on 
the graph by a set of cross hairs. This button does not 
become enabled until you have marked the range.

Simply click in the graph at the point you wish to begin 
the range to place the first cross hair. Hold down the Shift 
key and click at the ending range to place the second 
cross hair. Then click From Graph to set the range.

The total number of particles in the specified range dis-
plays in the lower left of the dialog.

Distribution Enables you to select the manner in which data are pre-
sented in the graph. Each time you select a different 
option, the data are rescaled accordingly.

Extrapolation Use this feature to complete data below the ending point 
when data does not return to zero on the y-axis; missing 
points will be calculated automatically.

A From Graph push button is also provided for this 
feature (it works in the same manner as the one 
explained above).

This feature is available for full-resolution or reduced 
data; the extrapolation point is displayed in the report 
header.

Remaining fields on 
this dialog

Refer to page 4-17 for a description of their functions.
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Save Displays the Save as Sample Information File dialog (see 
page 4-7 for an explanation of this dialog). 

If this is not the first time the file has been saved, a dialog 
prompting you for a reason for the change is displayed. 

After you make an entry in the window, Save is enabled 
allowing you to complete the save operation.

Save as Template Enables you to save all parameters of the current file as a 
Sample Information File template.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog box closes.
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Entered Data

An Entered Data tab displays when you select Manually entered on the Sample 
information dialog. The dialog for Entered Data enables you to enter data as opposed to 
having it collected automatically during analysis.

You cannot enter data if you are using a computer other than the one that is connected to 
the analyzer.

Table Enables you to enter the desired data; data are entered in 
an ascending order.

Insert Inserts a row above the selected row.

Delete Deletes the selected row.

Clear Clears the table of all entries but two; two are required.

Size Type Enables you to select the type of size data you plan to 
enter; you can enter particle size or sieve size data.

Distribution Type Enables you to select the type of distribution for the data 
you plan to enter.

Use this key 
sequence to 
add rows to the 
list.
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Save Displays the Save as Sample Information File dialog (see 
page 4-7 for an explanation of this dialog). 

If this is not the first time the file has been saved, a dialog 
prompting you for a reason for the change is displayed. 

After you make an entry in the window, Save is enabled 
allowing you to complete the save operation.

Save as Template Enables you to save all parameters of the current file as a 
Sample Information File template.

Close Closes the dialog. If the file contains unsaved changes, 
you are prompted to save before the dialog box closes.
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Open

Open enables you to open an existing sample or parameter file, as well as a sample or 
parameter template.

Sample Information File

The following dialog displays for the Analyst and Developer when File > Open > 
Sample information is selected.

A sample file can be edited by a Developer or an Analyst. The changes can also be saved. 
If you choose to save the changes, a dialog prompting for a reason is displayed. After you 
enter a reason in the Comments field, Save is enabled so that you can complete the save 
operation. These changes are saved as a version of the sample file, becoming part of the 
sample file history. All versions of the sample file (of the Status selected) can be viewed 
when you click Revert on the Sample file dialog.

Category/Subcategory These drop-down lists contain existing archive locations 
(directories) in which files have been stored. The direc-
tory labels shown in this example are defaults. Many lab-
oratories use the Year/Month system. A Developer can 
edit these labels to display differently if desired. Refer to 
Edit Labels, page 7-4 for information on editing the 
labels and adding directories (archive locations).
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Analyst

When an Analyst opens a sample information file, the dialog displays in this manner:

If desired, an Analyst can click Advanced to access the Developer’s view of the dialog. 
This view allows an Analyst to review the parameters used in the analysis. An Analyst 
can edit certain parameters of the sample file; the fields for those parameters are enabled. 
Report options can also be edited and reports generated.

Status This drop-down list allows you to choose the types of 
sample files to display in the Files window. All files of 
the type you choose, within the range of dates, and in the 
current directory are displayed. Refer to Table 2-2. File 
Status and Description, page 2-11 for a description of 
file types.

Date Range Click this push button to display files created within a 
specified range of dates. Refer to page 2-10 for an expla-
nation of this dialog.

Files window Lists the file(s) of the type selected in the Status list 
within the selected directory and range of dates.
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Developer

When a Developer opens a sample information file, the dialog displays in this manner:

A Developer can view all parameters of the file, as well as edit certain parameters; those 
parameters are enabled. Report options can also be edited and reports generated. 

A Developer’s view of the dialog includes a Collected Data tab (if the file status is 
Complete) which allows you to view the points collected during analysis. Refer to 
Collected Data, page 4-43.

The Save As Template push button displays on each parameter allowing you to save the 
values contained in all parameters of the file as a sample file template. 
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Templates

Sample and Parameter templates can be opened and their contents viewed by a Developer 
or an Analyst. However, you cannot make changes to an existing template. If you wish to 
make changes, a Developer will have to create a new template. An Analyst is not 
authorized to create templates.

Sample Files

A Developer or an Analyst can view the contents of a Sample Template by selecting File 
> Open > Sample Template; the Open Sample Template dialog is displayed.

Choose the template(s) containing the parameters you wish to view and click Open; the 
template(s) you choose is(are) displayed.
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Parameter

A Developer or an Analyst can view the contents of a Parameter Template by selecting 
File > Open > (parameter); in this example Analysis conditions is chosen as the 
parameter. The Open Analysis Conditions Template dialog is displayed.

A Developer can use this dialog to open a template or a parameter file; an Analyst cannot. 
The Location portion of this dialog does not display for an Analyst.

Choose the template(s) containing the parameters you wish to view and click Open; the 
template(s) you choose is(are) displayed.

Does not display 
for an Analyst.
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Parameter Files

Parameter files (Analysis Conditions, Material Properties, and Report Options) can be 
opened only by a Developer. When you select File > Open > (parameter file), an Open 
(parameter) dialog is displayed. 

This same type of dialog displays when you open a parameter file template. You simply 
click Template to display the templates.

Location Allows you to open a Parameter file or a Template for a 
parameter file. You can open a template and view the details 
but you cannot edit the values. If you wish to make changes, 
you will have to create a new template. You can edit and save 
changes in a parameter file.

Date Range Allows you to choose a range of dates in which to display 
files in the Files window. Refer to page 2-10 for information 
on using this push button.

Title bar displays the 
type of file you are 
opening.

Click Parameter to 
open a parameter 
file.

Click Template to open 
a template.
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Save

Save enables you to save any changes made to the file in the active window. The file is 
saved under its current name. If a sample information file is in the active window, a 
dialog requesting a comment on the change is displayed.

Enter the reason and click Save to complete the save operation.

Save As

Save As is unavailable for an Analyst; a Developer can use this function to:

• save a sample file in the active window as another sample file with a different 
name. 

When you select this option, this type of dialog is displayed.
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Enter a description in the ID field; you can use up to 50 characters. You must also 
enter a comment in the Comment window to enable the Save push button. If the 
Save push button does not become enabled, a file with the same description already 
exists. The Elzone Confirm program does not allow duplicate descriptions. The new 
file is saved as specified, but does not remain in the active window. Be sure to open 
the new file before making any changes.

• save a parameter file in the active window with a different name. The parameter file 
must be of the same type; for example, you can save an Analysis conditions file 
only as another Analysis conditions file.

When you save as a parameter file, this type of dialog is displayed.

Enter a description in the ID field; you can use up to 50 characters. If the Save push 
button does not become enabled, a file with the same description currently exists. 
The Confirm program does not allow duplicate file descriptions. Edit the 
description to enable the Save push button.

• save a subset (parameter) of the sample file in the active window as a standalone 
parameter file. For example, select Analysis Conditions from the Save As menu to 
create a standalone parameter file of the analysis conditions portion of the active 
sample file.

When you save a subset of a sample as a parameter file, the same type of dialog as 
shown above is displayed.
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Save As Template

Save As Template is unavailable for an Analyst; a Developer can use this function to:

• save the values of the sample file in the active window as a sample template

• save a subset (parameter) of the sample file in the active window as a parameter file 
template

• save the values of a parameter file in the active window as a parameter file template

Save All

Save All enables you to save all open files under their current names. This option 
provides a faster way to save all open files at one time and avoids having to perform a 
Save operation on each individual file. 

A dialog prompting for a reason for the current change version of each file is displayed.

Close

Close enables you to close the file in the active window. If the file contains changes that 
have not been saved, the following message is displayed:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file 
closes.

Click No to close the file without saving the changes.

Click Cancel to return to the active file.

An Analyst is not authorized to create sample and parameter file templates.
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Close All

Close All enables you to close all open files under their current names. The following 
message displays for every file containing changes that have not been saved:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the file 
closes.

Click No to close the file without saving the changes.

Click Cancel to return to the active file.
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Print

Print enables you to print details of a sample file, sample template, or parameter file. For 
example, if you choose to print the contents of an analysis conditions file, you will 
receive the parameters used for all analysis conditions associated with the file.

Sample Information 

Contents of a Sample Information file can be printed by a Developer or an Analyst; the 
Print Sample Information dialog is displayed.

Category/Subcategory These drop-down lists contain the existing directories in 
which files are stored. 

Status This drop-down list allows you to choose the types of 
sample files to display in the Files window. (Refer to 
page 2-11 for a description of the status types.) All files 
of the type you choose, within the range of dates, and in 
the current directory are displayed. 

Date Range Allows you to specify a range of dates for the files you 
wish to display in the Files list window, or you can 
choose All for all files to display. The range you choose 
is displayed below the push button. (Refer to page 2-10 
for information on using this push button.)

Does not display 
for an Analyst.
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Sample Template

Contents of a Sample Template can be printed by a Developer or an Analyst; the Print 
Sample Template dialog is displayed.

Refer to the previous page for an explanation of the fields on this dialog.

Preview
Print
Export

Choose Preview to view the file on the computer screen; 
you can then print the file from the preview window.

Choose Print to send the file directly to the printer; you 
can print up to 4 copies. 

Choose Export to print to a file; use the field below the 
Export option to enter a name. The Export option is 
unavailable for an Analyst.

Files window Displays the file(s) of the type selected in the Status list 
within the selected directory and range of dates.

You may print the contents of multiple files by holding 
down Ctrl while selecting files.

Does not display 
for an Analyst.
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Parameter Files and Templates

The contents of a parameter file can be printed only by a Developer. The contents of 
parameter file templates can be printed by a Developer or an Analyst. This type of dialog 
displays for a Developer. A Developer simply selects whether the contents of a Parameter 
file or a parameter template are to be printed.

Refer to page 4-59 for an explanation of the fields on this dialog.

An Analyst can print the contents of parameter file templates (not parameter files) by 
selecting File > Print > (parameter file). In this example, Analysis Conditions is 
selected as the parameter; the Print Analysis Conditions Template dialog is displayed.    

Select Parameter for 
parameter files or 
Template for parameter 
templates.
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List

List enables you to list the following statistics for a selected sample file, parameter file, or 
a sample template.

• File name
• Date the file was created
• Time the file was created
• File identification
• File status

Regardless of the type of file you choose, the dialogs are similar; the options presented in 
the header vary slightly. The types of dialogs displayed are identical to the ones displayed 
for the Print function; you simply obtain different types of information. This example 
shows a dialog for sample files.

Permissions for listing statistics are the same as for the printing file contents. For 
example, an Analyst can list statistics for parameter file templates, but not for parameter 
files.

Refer to the Print section, page 4-59 for an explanation of the fields on this dialog box.

You may request a list of multiple files by holding down Ctrl while selecting files. If no 
files are selected, a list is generated for all files.
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Import

A Developer can use this option to import files that have been created external to the 
Confirm software and copied into the Import directory. If the files are not copied into the 
Import directory, they will not display in the Files window

An Analyst is not authorized to import sample and parameter files.

Use Windows Explorer to copy the files into the Import directory.

Status 
Date Range

Use these two options to limit the files displayed in the 
Files window. The Status drop-down list does not dis-
play when importing parameter files. (Refer to page 2-10 
for information on using these options.)

Category 
Subcategory

Use these drop-down lists to choose the directory into 
which to import the file. Refer to Add Archive Loca-
tion, page 7-3 for information on creating directories.

These drop-down lists do not display when importing 
parameter files. Parameter files are imported into an 
assigned directory.
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Export

A Developer can use the Export option to:

• export the entire sample file to the Export directory. For example, you may wish to 
use this option to transfer a sample file to another computer.

• copy the reduced or full-resolution data in a sample information file and export it as 
ASCII text. ASCII data can be imported into other applications, such as 
spreadsheets. The data are exported in a comma-delimited format. Refer to 
Appendix C, page C-1 for a description of exported data.

Files are assigned a sample number automatically and generated to the Export directory. 
Use Windows Explorer or a file transfer utility to transfer the file to the desired location.

All fields on this dialog function in the same manner as other dialogs, such as the Import 
and Print dialogs. Refer to Print, page 4-59 if you need information on these fields.

An Analyst is not authorized to Export sample files.

Make a note of this 
number so you will 
be able to identify 
the file when 
accessing the 
Export directory.
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Convert

Convert allows a Developer to convert, two types of files:

• Elzone: copies and converts data from sample files used with the Model 5380 
Series of analyzers

• ASCII: copies and converts data from a text file. The text should be comma-
delimited; for example: size 1, quantity 1; size 2, quantity 2; etc.

These data are converted to a format compatible with the Elzone II program. The files to 
be converted must be copied into the Import directory so they will display in the Convert 
dialog. A dialog like the following is displayed regardless of the type of file you are 
converting.

An Analyst is not authorized to convert sample files.

Files Contains a list of the files available for conversion. If 
you are converting Elzone sample files, the extension 
will be *.HST. If you are converting a text file, the 
extension will be *.CSV. 

To select multiple files, hold down the Ctrl key while 
selecting the files.

Displays the type 
of file you are 
converting.
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Category 
Subcategory

Use these drop-down lists to choose a location for the 
converted file(s). Refer to Add Archive Location, page 
7-3 for information on creating directories. These drop-
down lists do not display when importing parameter files. 
Parameter files are imported into an assigned directory.

Date Range Use this push button to specify a date range in which to 
display files. Refer to Selecting Files, page 2-10 if you 
need help on using this push button.

Convert Converts the data of the selected file(s); a confirmation 
dialog is displayed.

If you are converting ASCII text files and select this push 
button, a dialog enabling you to select data parameters is 
displayed before the confirmation dialog.

This dialog enables you to select the type of data con-
tained in the text file. If you have selected multiple files, 
a dialog is displayed for each file (the name of the file is 
in the header).

Cancel Cancels the operation and closes the dialog.

Click here to close 
the dialog.
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Blend

Blend enables you to merge data from multiple analyses in which different orifice tubes 
were used. A single orifice tube is capable of measuring particles within a certain size 
range. You can use multiple orifice tubes to measure the distribution over a wider range. 
The Blend option enables you to blend the data from all of the orifice tubes used in the 
analysis. Blending is the preferred method of completing the data. The Blend Sample 
Files dialog is displayed.

You can also edit graph properties; for example, you may wish to hide data from one of 
the sample files. Right-click in the graph area and select Hide curve, then choose the one 
you wish to hide. Refer to Shortcut menus for graphs, page 6-26 for an explanation of 
the options available.

Fields 1 through 5 Display the file you choose using Browse.

Browse Click this push button to choose the desired file.

Clear Clears the field of its entry.

Range fields Displays the range for overlapped data. This range is 
determined automatically by the analysis program; how-
ever these values may be edited. The blend ranges are 
marked on the graph with circles.
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Show Blend Select this option to blend the data from all files and plot 
the graph as if it were one distribution. 

Show Overlays Plots the data from each file as overlays.

Size Classes Defaults to the number of size classes for the first data set 
(field 1); this value can be edited as desired.

Save As Displays the Save as Blend dialog.

This dialog enables you to save the blended data as a 
sample file. If desired, you can then use Report > Start 
Report to generate reports to the printer or to the screen 
to view data.

Print Becomes enabled after you save the blended data. Click 
this push button to display the Report Settings dialog so 
that you can specify output options.

Close Closes the dialog.
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Average

Average enables you to choose up to five sample files and average the data from all files. 
Or, you can choose Add to add and combine the data from the selected files. A graph is 
drawn on the right side of the dialog and updates automatically each time a file is added 
(or removed). The Add or Average Samples dialog is displayed.

Fields 1 through 5 Display the files you choose using Browse.

Browse Click this push button to choose the desired file.

Clear Clears the field of its entry.

Scale Enables you to scale the distribution. Users typically use 
this to scale data in relation to sample concentration or 
analysis time. For example: you are averaging data from 
two files. One was analyzed for 60 seconds and the other 
one for only 30 seconds. Enter 2.00 in the Scale field of 
the 30-second analysis to scale the data to match the 60-
second analysis. After editing the value in this field, 
click in the graph area to initiate the rescale. 

You can also use negative values in this field to subtract 
distributions.
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Add Enables you to obtain a total of all data sets in the 
selected sample files.

Average Enables you to obtain an average for all data sets in the 
selected sample files.

Save As Allows you to save the data as a sample file.

Cancel Closes the dialog; all entries are lost.
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Log In

Log in enables you to log into the application; the User Log in dialog is displayed.

Simply enter your user name and password, then click OK. 

User name Typically in this field, you should enter your Windows 
User name, unless your Administrator has specified a dif-
ferent user name.

Password Enter your password. If you enter your password incor-
rectly a specified number of times (your Administrator 
determines the number when setting up system options; 
the default is three), the application will lock and you 
will not be allowed to proceed. Contact the Administrator 
to unlock the application and assign a new password.

The first time you log into the application after the Con-
firm software is installed, you will be prompted to 
change your password to one of personal preference. You 
must enter at least six characters.

Change password Select this option to change your password after you have 
logged in; the Set password dialog allowing you to 
change your password is displayed.
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Log Out

Select this option to log out of the system. If files are open and contain changes that have 
not been saved, you are prompted to save or discard them before you can log out. 

Exit

Exit enables you to exit (close) the Confirm program. 

• If a window containing a modified file is open, the following message is displayed:

(file name) has been changed. Save changes before closing?

Yes No Cancel

Click Yes; a dialog prompting for a reason for the change is displayed before the 
file closes.

Click No to close the file without saving the changes.

Click Cancel to return to the active file.

• If an analysis is in progress, the following message is displayed:

2459- An analyzer is busy. A delay in restarting this application 
could result in loss of new data. continue with program exit?

                  Yes                     No

Click Yes to exit the analysis program but the analysis will continue until 
completion; analysis data are collected and stored in the analyzer’s memory.

Click No to allow the analysis program to remain active and the analysis to finish

• If a report is in progress, you are cautioned that reports are being generated, and 
given the opportunity to either cancel the print job or allow the reports to print 
before exiting.

Although data are stored in the analyzer when you exit the program during 
analysis, they are not saved in the file until the program is restarted. At that time 
the data are saved automatically. If a power failure occurs in the interim and you 
do not have an Uninterruptible Power Supply (UPS) attached, loss of data will 
result.
4-72                                                    539-42822-01 (Rev B)  - Nov 2017



Description Elzone II 5390 Confirm
5.  UNIT MENU

The Unit menu contains the operations which can be performed with the Elzone analyzer. 
The main menu contains a Unit menu for each attached analyzer. For example, if you 
have two attached analyzers, the main menu contains two Unit menus. The unit number 
and the serial number appear in the title bar of the operational window(s). 

For easy differentiation, the status windows for each unit are display in a different color. 
This feature is especially useful when you have two units attached to the same computer.

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are 
found later in this chapter.

The Unit menu does not appear on the menu bar if the analysis program is being 
used for offline data manipulation.

Sample Analysis Use this mode of operation to perform single sample 
analyses. This option is disabled if analyses are being 
performed in another mode. Page 5-3.
539-42822-01 (Rev A) - Nov 2017                                                    5-1 



Elzone II 5390 Confirm Description
QuickStart Analysis Use this mode of operation to perform successive sample 
analyses. Page 5-14.

Change Orifice Tube or 
Liquid

Enables you to change the orifice tube or the liquid. Page 
5-19.

Rinse Enables you to rinse the system (internal glassware). 
Page 5-20.

Fill System Enables you to fill the system with liquid. Page 5-21.

Flush System Enables you to flush liquid through a filled system. Page 
5-21.

Drain System Drains the system of all liquid. Page 5-22.

Clear Blockage Enables you to clear a blockage from the orifice tube. 
Page 5-22.

Orifice Tube Calibration Enables you to calibrate the orifice tube. Page 5-23.

Background List Allows you to edit the background list. Page 5-31.

Zero Pressure Scale Enables you to zero the pressure transducer to atmo-
spheric pressure. Page 5-32.

Diagnostics Enables you to perform predefined user diagnostics. 
Page 5-33.

Enable Manual Control Allows you to control certain instrument components 
manually. Page 5-36.

Show Instrument 
Schematic

Displays the instrument schematic. Page 5-42.

Show Status Displays only the status window of the operational win-
dow, enabling you to view the status of the operation in 
progress. Page 5-43.

Show Instrument Log Displays the instrument log. Page 5-44.
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Sample Analysis

Use this mode of operation to perform up to eight tests (analyses) on a single sample. 

When you select this option, the Sample Analysis dialog containing greyed fields is dis-
played. Click New to create a new file or Browse to choose an existing one. After a 
sample file has been designated, the Sample Analysis dialog is displayed. The fields now 
contain the values for the selected file, or if creating a new file, the specified defaults.

Unit Configuration Displays the configuration of the analyzer. Page 5-47

Calibration Enables you to perform certain instrument calibrations. 
The options on this menu are enabled only with the direc-
tion of a Micromeritics service representative. 5-49.

Service Test Allows you to perform certain troubleshooting proce-
dures. This option is enabled only under the direction of a 
Micromeritics service representative. Page 5-49.
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View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

New Displays the Create a File for Analysis dialog, allowing 
you to choose a template from which to create a new file.

Browse Displays the Select a File for Analysis dialog, allowing 
you to select an existing sample file for your analysis.

Sample Displays the identification of the sample.

Replace All This push button allows you to replace the values for all 
parameters of the current file with the values from an 
existing file. Simply click the push button, choose the 
desired file, and click OK. The values of the chosen file 
are copied into the current file; you can edit them as 
desired.

Analysis Conditions Displays the description of the analysis conditions file in 
the selected sample information file. 

Use the drop-down list to select a different file if desired.

Data Setup Displays the Analysis Conditions Data Setup dialog 
enabling you to edit analysis conditions. Data does not 
display in this view of the dialog.

Refer to page 4-17 for a description of the fields on this 
dialog.
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Orifice Tube Displays a description of the orifice tube specified in the 
Analysis Conditions file. If the identification is preceded 
with an asterisk, the orifice tube has not been calibrated 
for this instrument. Orifice tubes should be calibrated to 
obtain accurate results.    

Material Properties Displays a description of the materials properties file in 
the selected sample information file. 

Use the drop-down list to select a different file if desired.

Report Options Displays a description of the report options file in the 
selected sample information file. 

Use the drop-down list to select a different report options 
file if desired.

Reports to Generate Displays the selected reports (the ones preceded with a 
check mark) from the file you select from the Report 
Options drop-down list; these selections may be edited if 
desired.
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Number of tests Allows you to enter the number of analyses you wish to 
perform using this sample file; you can perform up to 
eight tests with each file.

Background This option enables you to have the data collected in this 
analysis saved as a background.

Stirrer Speed Displays the stirrer speed specified in the sample file; 
you can edit this value if desired. The lower the number, 
the lower the speed; 0 (zero) turns the stirrer off.

Stirrer Direction Displays the stirrer direction (particle circulation) speci-
fied in the sample file; you can change the direction if 
desired.

Dilution Factor Displays the dilution factor specified in the sample file; 
you can edit this value if desired.

Mass Concentration Displays the concentration specified in the sample file; 
you can edit this value if desired. 

Rinse Displays the rinse options selected in the sample file; you 
can edit these options if desired.

Report after analysis Displays the Reports Settings dialog so that you can 
specify report output options.

Select the option on this dialog to have reports printed 
automatically after analysis. If you do not wish to have 
reports generated automatically, you can generate them 
after the analysis using the Start Report option on the 
Reports menu.

This option does 
not display for an 
Analyst.
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Preview Prints the report to the monitor screen. This option allows 
you to customize reports with details such as font and 
column placement. Refer to Onscreen Reports, page 6-
22 for the options available for onscreen reports.

Print Prints the report to the printer designated as the default 
printer. When you choose this option, the Copies field is 
enabled allowing you to print up to four copies.

Export Exports report data to a file. When you choose this option 
the adjacent field containing a default name is enabled; 
you can edit the name if desired. This option is unavail-
able for an Analyst. 

Export after Analysis Enables you to export data automatically after analysis; 
the Export Settings dialog is displayed.

 If you do not wish to have reports exported automati-
cally, you can export them after the analysis using the 
Export option on the File menu.

Export Type You can export Reduced Data or Full resolution Data.

File Type You can export the data as a text file (TXT) or in a 
spreadsheet format (XLS).

File name The data will be exported as the file name and the appro-
priate extension to the application directory. You can 
enter a different directory if desired.

Include average 
of tests

Select this option to export values for the average of all 
tests included in the file.
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After verification of the user, the next view of the Sample Analysis dialog is displayed.

Next Click this push button to advance to the next view of the 
Analysis dialog; a logon dialog is displayed.

This dialog is used to verify that the logged-in user is per-
forming the analysis.  

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log
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Report Enables you to generate a report for the data collected up 
to the time you request the report.  

Sparkle Display Displays during data collection or while in Preview 
mode. 

The Sparkle display emulates an oscilloscope (turned 90º 
to the right). The analyzer measures the change of resis-
tance across the orifice and displays a dynamic scan of 
pulses (tips) in real time.

Coincidence Displays the current coincidence level.

Preview Enables you to view signals (in the Sparkle display) and 
the coincidence rate.

Orifice Displays the serial number and the size of the orifice tube 
being used in this analysis.

Diameter Range Displays the range in which to detect particles.

Instrument Setup Displays the Instrument Setup dialog, enabling you to 
edit certain analysis conditions prior to analysis.

Disabled for an Analyst.
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Optimize Settings Enables you to have the optimum Load Resistor, Current, 
and Gain determined. These values will be stored in the 
analysis conditions file as well as in the collected data, 
and as the optimized settings for the orifice/electrolyte 
combination.

Typically, it is best to optimize settings with a beaker 
containing only electrolyte; no sample. Then add your 
sample after optimization is complete. Refer to Optimiz-
ing Instrument Settings, page 3-31 for additional infor-
mation.

Disabled for an Analyst.

Data Setup Enables you to edit data parameters.

Disabled for an Analyst.
5-10                                                    539-42822-01 (Rev A) - Nov 2017



Sample Analysis Elzone II 5390 Confirm
From Graph This option enables you to choose a size range marked on 
the graph by a set of cross hairs. This button does not 
become enabled until you have marked the range.

Simply click in the graph at the point you wish to begin 
the range to place the first cross hair. Hold down the Shift 
key and click at the ending range to place the second 
cross hair. Then click From Graph to set the range.

The total number of particles in the specified range dis-
plays in the lower left of the dialog.

Refer to page 4-17 if you need assistance on this dialog.

Save Settings Displays the Save as Analysis Conditions dialog allow-
ing you to save the current settings as an Analysis condi-
tions file. 

Disabled for an Analyst.

Actions The following actions are available prior to analysis:

• Drain: drains the system, leaving the glassware empty

• Fill: fills the glassware with electrolyte solution

• Flush: flushes solution through the glassware; it does 
not empty the glassware

• Rinse: displays the Rinse dialog enabling you to spec-
ify rinsing preferences

• Clear Blockage: clears any blockage that may be in 
the orifice tube. This option is also available during 
analysis, but only up to the point where data collection 
begins.

• Turn Stirrer Off: turns the stirrer off.

Ending Conditions Displays the Ending Condition dialog so that you can edit 
the ending criteria if desired.

Disabled for an Analyst.

Time, Volume, Total and 
Modal count  

Displays the parameters for the current ending condi-
tions.
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Start/Continue Enables you to start or continue (when stopped) data col-
lection. 

Stop Stops data collection. 

Clear Discards all data collected for this analysis. This action is 
recorded in the instrument log.

Save Enables you to save the collected data into the sample file 
as the next test. The data are discarded after being saved.

Finish Enabled when all setup parameters are appropriate for the 
analysis; displays the Finish Analysis dialog.

After verifying information in this dialog, click OK to 
close the dialog and complete the analysis.

After the analysis is complete, you will be returned to the 
first dialog in the Analysis series to begin another test or 
end the session.

Cancel Cancels the current operation.

Close Closes the dialog; you will be prompted to save data 
before the dialog closes.

Status Window Displays the status of the current analysis. Refer to Show 
Status, page 5-43 for additional information on this win-
dow.
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Click Start to begin the analysis; data starts to collect and the dialog now looks like this:

After data are collected (progress bar reaches 100%), Save is enabled allowing you to 
save the data into the sample file.

Becomes 
enabled when 
progress bar 
shows 100%.

Progress Bar
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QuickStart Analysis

Use this mode of operation to analyze a series of samples of the same type which contain 
the same analysis conditions; sample files are created automatically. When you select this 
option from the Unit menu, the QuickStart dialog is displayed.

     
View Allows you to view one of the following in the current 

window:

• the current operation
• the instrument schematic
• the instrument log

Sample Displays the identification of the selected file; you may 
edit this identification if desired.

Report after analysis Select this option to have reports printed automatically 
after analysis. If you do not wish to have reports gener-
ated automatically, you can generate them after the analy-
sis using the Start Report option on the Reports menu. 
Refer to page 5-6 for an explanation of report output 
options.
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Export after Analysis Select this option to export full-resolution data or 
reduced data automatically after analysis.

Refer to page 5-7 for an explanation of export output 
options.

Next Advances you to the next view of the QuickStart dialog. 

New Displays the Create a File for Analysis dialog containing 
templates. Select the template containing the desired con-
ditions and click Create.

Browse Displays the Select a File for Analysis dialog enabling 
you to choose an existing file.

Sample Displays the identification of the selected file; you may 
edit this identification if desired.

Save as background  Select this option to have the data collected for this anal-
ysis saved as a background. For example, you may wish 
to have the first run of the current series of analyses 
saved as the background analysis. 
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Measure Conductivity Select this option to measure the conductivity for the 
current orifice tube and liquid. The date and time of the 
last recorded measurement for this tube/liquid 
combination displays to the right of the push button.

Optimize Settings Enables you to have the optimum Load Resistor, Current, 
and Gain determined. These values will be stored in the 
analysis conditions file as well as in the collected data, 
and as the optimized settings for the orifice/electrolyte 
combination.

The analyzer is placed in the plumbing state and remains 
there until optimization is complete. 

Refer to Optimizing Instrument Settings, page 3-31 for 
additional information on this option. 

Turn Stirrer On
Turn Stirrer Off

This toggle switch enables you to turn the stirrer on or off 
during analysis.

Check Concentration Use this push button to check the concentration level of 
the electrolyte after you have specified a range in the 
Counts/Sec fields. The measured rate of the concentra-
tion will display between the range fields and the 
progress bar will indicate visually whether or not the 
concentration is within range.

Counts/Sec These fields are provided to enter a range for the amount 
of particles per second that you wish to have pass 
through the orifice. The valid range is 0 to 10000.

Progress bar The progress bar indicates the concentration in relation 
to the specified range. When the Check Concentration 
push button is clicked, the status bar is divided into three 
sections, separated with vertical bars; the first represent-
ing 0 to the minimum range you specify, the second 
minimum to maximum ranges, and the third maximum 
range you specify to the limit of 10000.
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The bar will be colored up to the measured concentra-
tion. For example: a bar colored like this one indicates 
low concentration; add more sample.

A bar colored like this one indicates the concentration is 
within the specified range.

A bar colored like this one indicates the concentration is 
too high; add more electrolyte or discard sample and 
start over.

Rinse Displays a dialog containing the rinse options selected in 
the sample file; you can edit these options if desired. 
Refer to page 4-15 for information on the fields in this 
dialog.

Status Window Displays the status of the current analysis. Refer to Show 
Status, page 5-43 for additional information on this win-
dow.

Next Enabled after you load your sample. When you click this 
push button, the User Log on dialog is displayed so that 
you can enter your password. After you enter your pass-
word and click OK, analysis begins and you advance to 
the next analysis screen.

Indicates 0 to minimum (value in left 
range field)

Indicates minimum to maximum 
(range specified in the range fields).

Indicates maximum (value in right 
range field) to 10000.
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This view of the dialog displays the data as they are collected.

After the analysis is finished, you are returned to the second view of the QuickStart dialog 
allowing you to add sample and continue analyses.

Sparkle Display Displays during data collection. 

The Sparkle display emulates an oscilloscope (turned 90º 
to the right). The analyzer measures the change of resis-
tance across the orifice and displays a dynamic scan of 
pulses (tips) in real time.

Time, Volume, Total and 
Modal count  

Displays the parameters for the current ending 
conditions.

Progress bar Displays the percentage of completion for the current 
operation.

Cancel Cancels the current analysis and returns you to the orig-
inal sample selection window.
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Change Orifice Tube or Liquid

This option enables you to change the orifice tube or liquid; the Change Orifice Tube or 
Liquid dialog is displayed.

This dialog is the first of a series of dialogs that guide you through the process of chang-
ing the orifice tube or liquid. After you click Start on this dialog, you receive (in 
sequence):

• a dialog showing the status of the initial draining step; after draining operation is 
completed, you are advanced to the next dialog automatically

• a dialog prompting you to replace the orifice tube or liquid; after you have 
performed the requested action, click Continue to proceed to the next dialog

• a dialog showing the status of the draining/filling operations; after this operation is 
complete, you are advanced to the next dialog automatically

• a dialog indicating that the operation is complete; this dialog contains two push 
buttons:

Next Liquid For some liquids, one or more intermediate liquid changes 
are required; click Next Liquid if this is the case with your 
liquid.

Example: If you are using as the electrolyte sodium chlo-
ride in water and you wish to change to a lithium chloride in 
IPA, you should use this option. This enables you to rinse 
first with the water (base for current solution), then with 
IPA (base for new solution), then with the new electrolyte 
solution.

Refer to Changing the Liquid in the Supply Container, 
page 3-29.

Done Click this push button to close the dialog
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Rinse

This option enables you to rinse the system (internal glassware); the Rinse dialog is 
displayed.

   

Drain and fill Choose this option to drain, rinse, and refill the system 
with liquid.

Flush Choose this option to flush the system with liquid; liquid 
remains in the glassware at all times.

Rinses Enter the number of times you wish to perform the 
selected option.

You can perform up to nine rinses.

Purge Volumetric Pump Select this option to have the volumetric pump (if 
installed) purged during the rinsing process
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Fill System

This option enables you to fill a drained system (internal glassware) with liquid. Before 
selecting this option, place a beaker of electrolyte on the sample stand and raise the stand.

Flush System

This option enables you to flush liquid through the system; the Flush System dialog is 
displayed.

Before selecting this option, place a beaker of electrolyte on the sample stand and raise 
the stand.

Start Click this push button to begin filling the beaker.   

Cancel Cancels the operation.

Start Click this push button to start the flushing process.   

Cancel Cancels the operation.
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Drain System

This option enables you to drain the liquid from the system; the Drain System dialog is 
displayed.

Before selecting this option, be sure that the sample stand is in its lowest position; your 
orifice tube should not be submerged for this operation.

Clear Blockages

This option enables you to clear blockages from the orifice tube; the Clear Blockage dia-
log is displayed.

Start Click this push button to start the draining process.   

Cancel Cancels the operation.

Start Click this push button to start the process.   

Cancel Cancels the operation.
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Orifice Tube Calibration

This option enables you to calibrate an orifice tube to a selected sample and electrolyte 
solution. A sample file for the calibration is created automatically and stored in the calib/
serial number subdirectories, which are located in the data subdirectory of the applica-
tion. A sample identification containing the orifice identification and size is automatically 
assigned making it easy to recognize the calibration. 

The fields on this dialog are identical to the fields on the Analysis conditions dialog; refer 
to Analysis Conditions, page 4-12 for an explanation of this dialog. 
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Click Next to advance to the next view of the calibration dialog.

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

Reference Material
Identification List

This window lists the reference material(s) required to 
calibrate orifice tubes. Reference materials required for 
the current calibration must be selected (check mark). 
Double-click on the reference material to place (or 
remove) a check mark.

If the reference materials required for the calibration are 
not in the list, use the Add push button to add them.

Show only materials in 
range of orifice tube

Select this option to show only the materials appropriate 
for the current orifice tube.

Be sure the 
reference 
materials 
required in the 
calibration are 
checked.
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Add Displays the Reference Material dialog so that you can 
add a new reference material to the list.

The information required in these fields can be found on 
the reference material bottle or its accompanying booklet.

Identification Enter an appropriate description; you can use up to 20 
alphanumeric characters. Most users enter the size of the 
orifice tube and the serial number (located on the orifice 
tube).

Lot Number Enter the lot number; you can use up to 20 alphanumeric 
characters.

Size Enter the size specified on the reference material.

If you enter a value in this field that is not within the 
range allowed for the orifice tube being calibrated, a 
warning is displayed. 

Tolerance Enter the tolerance level.

Size statistic in Select appropriate statistic.

Edit Displays the Reference Material dialog (shown above) 
enabling you to edit the selected material.

Delete Deletes the selected material from the list.

Maximum Current Choose the maximum current; typically this choice will 
be Particle. If you wish to specify a different value, 
select the third choice and enter the desired current. 
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Click Next to advance to the next view of the calibration dialog

The fields on this dialog are identical to the fields on the Sample Analysis dialog 
explained previously on page 5-3.

Electrolyte Solution Displays a list of available electrolyte solutions (dispers-
ing liquids). After you select a solution from the list, its 
description and properties are displayed.

Description Displays the electrolyte solution you select form the list.

Density Displays the density of the selected electrolyte solution. 

Viscosity Displays the viscosity of the selected electrolyte solution.

Add Enables you to add sample materials to the list.

Use the Description, Density, and Viscosity fields to 
enter your electrolyte and its properties, then click Add to 
add it to the list.

Delete Deletes the selected electrolyte solution from the list.

Becomes 
enabled when 
calibration is 
complete.

Progress bar
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The values on the left side of this dialog display the calibration information of the current 
calibration as well as the previous one (if one exists). If a reference material is out of tol-
erance, it will be displayed just below the calibration information.

Save Enabled when the calibration is complete (progress bar 
reaches 100%) allowing you to save the data.

Finish Displays the Finish Analysis dialog.

This dialog enables you to verify that the reference mate-
rial data were saved. You should also verify that a 0 
(zero) is in the Number of Tests Remaining field; other-
wise another calibration will be performed.

When you click OK on this dialog, the final Orifice Tube 
Calibration screen is displayed.

Indicates the data 
were saved.

Be sure 0 (zero) 
is displayed here.

Choose the reference 
material on which to 
display information from 
this list.
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The values on the right side of the dialog are specific to a reference material. The refer-
ence material is selected from the drop-down list just above the information.

Report Generates the calibration report to the computer screen. 
You can print a hard copy of the report from the report 
window if desired.

Show collected data
Show fit

The collected data option is selected automatically. Select 
Show fit to show the goodness of fit.

Reference Material 
drop-down list

Choose a reference material used in the calibration to dis-
play its related information (below the list).

Use in calibration Initially, this option is checked for all materials included 
in the calibration, indicating that all will be included in 
the line-fit calculation. If you do not wish to have a refer-
ence material included in the calculation, deselect this 
option when the desired reference material is displayed in 
the field of the drop-down list.

Edit Displays the Pulse Height dialog.

The pulse height is initially calculated by the software;  
this dialog enables you to manually enter a pulse height.  
The pulse height can also be edited with cross-hairs (see 
Graph below).
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From Graph This option enables you to:

• set the pulse height at the position of a single cross hair

Simply click in the graph at the desired location for a 
single cross hair, then click From Graph.

• have the mean (mode or median) value calculated 
between two cross hairs

Click in the graph at the left side of the desired peak 
for the first cross hair. Hold down the Shift key and 
click at the right side of the desired peak. Then click 
From Graph.

Calculate Click this push button to recalculate the pulse height to 
its original value.

Force Fit Through Zero Select this option to force the calibration fit to where 
zero voltage of the peak detector corresponds to a parti-
cle of zero size.

This example 
shows a graph in 
which two cross 
hairs are used.
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Fit Order Enables you to choose the highest order for the polyno-
mial fit. If the fit is invalid, the order will decrease to the 
next lowest selection and refit.

The coefficients of the polynomial fit are displayed on 
the left side of the dialog.

Accept If values are within tolerance and are as desired, click 
Accept to save the calibration and close the dialog

The file is automatically assigned a name and saved into 
the CALIB\(serial number) directory. These directories 
are created in the DATA directory the first time an ori-
fice tube calibration is performed. If you have two 
instruments attached, directories for each instrument 
serial number will be created.
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Background List

The software maintains a list of backgrounds performed on the analyzer; the Maintain 
Backgrounds dialog is displayed.

Orifice Tube Contains a list of the orifice tubes that have been used 
with the analyzer.

Electrolyte Solution Contains a list of electrolyte solutions that have been 
used with the analyzer.

Background list Lists the backgrounds available for the selected orifice 
tube/electrolyte solution combination.

This window lists the:

• minimum and maximum particle diameter range
• date and time for the background
• sample file identification

An asterisk preceding the values listed in the minimum 
and maximum fields indicates approximate values.

Add Enables you to add a sample file for an analysis whose 
data you wish to use for a background.

Remove Removes the selected file from the list; it does not delete 
the file. You can add it back to the list using the Add push 
button if desired.   
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Zero Pressure Scale

This option enables you to zero the pressure transducer to atmospheric pressures; the 
Zero Pressure Scale dialog is displayed.

List All Generates a report of the window contents to the screen, 
enabling you to print or save the list.

Close Closes the dialog.

Start Click this push button to start the zeroing process. When 
the operation is complete, the dialog closes automati-
cally.    

Cancel Cancels the operation.
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Diagnostics

This option enables you to perform a diagnostic test to determine if the signal processing 
circuitry is operating properly. This test actually emulates an analysis sending electronic 
pulses through a series of predefined ranges. Your service representative may request this 
test when data results are inaccurate and you have been unable to resolve the problem. 
The data generated from this test may be insignificant to you as a user, but can be very 
helpful to your service representative. Your service representative may be able to view 
the results of this test and resolve the problem, eliminating downtime and repair costs.

This test generates a file to the cfr5390\Service\userdiag directory. Your service repre-
sentative will request that you E-mail this file to him so that he may examine it. If Mail is 
unavailable, you may print the report and fax it. Your service representative will provide 
you with the applicable destination information.

When you select Unit [n] > Diagnostics, the Service Test dialog is displayed:

View Allows you to view the current operation (operate), the 
instrument schematic, or the instrument log in the Ser-
vice Test dialog. Operate is the appropriate choice for 
this test.

Sequence Displays the test file number. This number is assigned 
automatically and incrementally sequenced by the soft-
ware each time a test is performed. This also serves as 
the name of the file that is generated to the userdiag 
directory, and will be appended with SVT. For example, 
the name of the file for the test shown in the above dia-
log is 0018.SVT.
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Report after test Select this option to have a report generated automati-
cally after the test; page 5-6 provides an explanation of 
output options.

If you do not select this option, you can still have a 
report generated from the report window.

Cancel Cancels the test.

Next Begins the test; displays the next view of the Service test 
dialog.

Report Contains a list of predefined pulse ranges. Unless other-
wise instructed, this choice should remain as Linear. 

Item [n[ Enables you to display data for the selected report as a 
Histogram and a Graph. 

Report Enables you to generate a report.

Cancel Cancels the test.

The following push buttons become enabled when the test is complete.

Repeat Repeats the test; not applicable for this test.
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Next Returns you to the first view of the Service Test window.

Close Closes the dialog.
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Enable Manual Control

Select this option to manually control the system. Manual control typically is only used 
for service issues; normal operation does not require manual control. If the instrument 
schematic is not displayed, select Show Instrument Schematic from the Unit menu.

When you enable manual control, the symbols for pumps and valves change color on the 
control screen to indicate manual operation.. 

Use one of the following options to move among the system components depicted on the 
instrument schematic:

• click on the desired component
• use the Tab key or arrow keys to move the desired component   

Manual Control is disabled if an automatic operation is in progress.

Valves: Open = Green

Closed = Yellow

Pumps: On = Green
Off = Yellow
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A component is selected when it is surrounded by a dotted line. Each component has a 
shortcut menu displaying the operations available for that paticular component. These 
menus may be accessed by right-clicking on the desired component, or by using the 
shortcut keys Shift + F9 when the component is selected.

Components on the instrument schematic are:

Volumetric pump The volumetric pump is optional and displays only when 
installed on the Elzone. The arrow indicates direction of 
flow. If a volumetric pump is not installed, the fill valve 
is connected directly to the orifice.

The arrow indicates direction of flow. 

 indicates the syringe is emptying and resetting to 
the Start position (towards start) where it will fill. 

 indicates the syringe is filling (towards end). When 
in this position, liquid is being pulled from the outside of 
the orifice tube through the orifice for analysis, or 
through the Fill valve if open0

The emptying/filling sequence repeats until the 
requested volume is obtained.

Actions: Turn Off
Move to Start
Move to End
Move Volume
Move Steps

Move to Start empties the pump syringe and goes to the 
starting position.

Move to End fills the pump syringe, pulling liquid 
through the orifice for analysis, or through the Fill valve 
if open.

Arrow
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Volumetric pump

(continued)

Move Volume displays a dialog enabling you to specify 
flow direction, the total volume to move, and the flow 
rate.

Move Steps displays a dialog enabling you to specify 
flow direction, the number of steps to move, and the rate 
at which to move the steps. 

Air valve Supplies air to the system for draining the liquid; auto-
matically opens when you perform the draining opera-
tion.

Actions: Open
Close
Close All

Close All closes all valves and turns off the Servo valve.

Fill valve Allows fillling of the orifice with liquid.

Actions: Open
Close
Close All

Close All closes all valves and turns off the Servo valve.

Arrow

Shows valve 
in a closed 
position.

Shows valve 
in an open 
position.
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Stirrer/Orifice tube A stirrer or optional hydropulser is used to maintain par-
ticle suspension in the sample beaker. The current speed 
is displayed in the icon.

Actions: Turn On  (green)
Turn Off  (yellow)
Increase Speed 
Decrease Speed
Set Speed
Set Stirrer Direction Up (stirrer only)
Set Stirrer Direction Down (stirrer only)

Set Speed displays the Stirrer Speed dialog enabling you 
to specify a speed for the stirrer (or hydropulser); the 
value you specify (and the operating speed) is displayed 
in the icon.

The speed range is 1 through 10; the higher the number, 
the faster the rotation. 

Sample Valve Allows the sample to flow through the orifice. This valve 
is also used during filling and draining operations.

Actions: Open
Close
Close All

Close All closes all valves and turns off the Servo valve

If the sample compartment is not closed, Door Open (in 
red text) is displayed above the valve. Both sample com-
partment doors should always be closed during analysis.

Vacuum pump Provides vacuum for system operations.

Actions: Pump On   (green)
Pump Off  (yellow)
Fan On  
Fan Off 

There is no icon associated with fan operations.

Stirrer

The icon displays 
in this manner if a 
hydropulser is 
being used.

Electrodes

Orifice tube Sample beaker
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Servo valve Regulates system vacuum pressure.

Actions: Turn On
Turn Off
Vent
Set Target
Flow

Vent allows air into the system.

Set Target displays the Set Target dialog enabling you to 
specify a target differential pressure.

Flow displays the Flow dialog enabling you to specify 
flow requirements.

The choice you make enables its corresponding fields so 
that you can enter appropriate values.

Pressure reading This rectangular box located to the right of the vacuum 
pump displays the amount of pressure below atmo-
spheric.

Actions: Zero Pressure Scale

Zero Pressure Scale simply zeroes the pressure scale, 
assuming that the current pressure is at atmospheric.
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Sensors There are two sensors displayed on the schematic; one 
for the waste container and one for overflow of the waste 
container.

Colors: White; indicates no liquid present at the 
sensor level
Blue; indicates liquid is present at the 
sensor level

Waste Represents the Waste container. The sensor to the right of 
the icon indicates the presence (blue) or absence (white) 
of liquid at the sensor’s height. If the waste sensor dis-
plays blue, the waste container is full; current operation 
will be canceled automatically. You must empty the 
waste container before proceeding.

Overflow The Overflow sensor is provided as a safety precaution in 
the event the Waste sensor did not detect a full container. 
For example, the Waste sensor may not have been 
securely connected. If the Overflow sensor turns blue, the 
pump stops automatically to prevent liquid from reaching 
internal components. Terminate all operations and con-
tact your Service Representative.
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Show Instrument Schematic

Select this option to display a schematic of the Elzone analyzer. 

You can determine the state of the valves and pumps by color.

• Valves: Closed = White* Open = Green
• Pumps: Off = White* On = Green           

*Closed and Off positions are yellow if manual control is enabled. Select Enable Man-
ual Control from the Unit menu to control components manually (refer to page 5-36 for 
a description of the components on the instrument schematic).
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Show Status

Select this option to show only the status window of an operation in progress.

You may wish to use this option if:

• You have an automatic operation in progress and you wish to edit a sample file, for 
example. This way, you can monitor the operation while performing another task.

• You have two units attached to your computer. You can select Show Status on each 
unit menu and view the status of the operations on both units at the same time.

The following items display in the status window:

Sample ID The path and name of the sample file being used with the 
current analysis.

Test The current test being used with the sample file; you can 
perform up to eight tests with each sample file. 

Plumbing The current plumbing operation: Draining, Filling, 
Flushing, Rinsing. Idle displays when a plumbing oper-
ation is not in progress. 

Data Collection The current operation in preparation for data acquisition 
or calibration: Optimizing Settings, Blockage Detec-
tion, Checking Blockage, Testing Conductivity, Col-
lecting Data, Calibrating. Idle displays when an 
operation is not in progress. 
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Show Instrument Log

Select this option to display a log of recent analyses, calibrations, errors or messages, and 
conductivity details. By default, information for analyses and messages are retained 60 
days; calibration and conductivity information is retained 90 days. You may change the 
time for which this information is retained in the Unit section of the WIN5390.INI file.

You can choose the type of information to display in the window by selecting only the 
desired item(s). For example, check the Analysis box to display only analysis 
information.

Analysis 
Conductivity 
Calibration
Message

Enable you to choose the type of entries to display in the 
window. For example, if you select Analysis, only Anal-
ysis operations are displayed.

Add Log Entry Becomes enabled when you make an entry in the adja-
cent field. Entries display in the Log Report.

Report Enables you to display on the screen or print a report of 
log entries; the Log Report Settings dialog is displayed.
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Start Date Use this field to specify a date at which to begin listing 
entries. You can specify a start date using any of the fol-
lowing methods:

• Highlight the field (or press F2 to clear the field) and 
type in the desired date.

• Double-click in the field (or press F4) to display a cal-
endar to choose a date.

• Press F2 to clear the field, then F3 to insert the current 
date.

Copies Enabled when you choose Printer for the destination, 
allowing you to print up to four copies.

Destination Specify a report destination. 

Choices:   Screen, Printer,  File

File name Enabled when you select File for the destination, enter a 
file name.

Use this set of left/right arrows to select a year.

Use this set of left/right arrows to select a month.

Click the desired date.
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Conductivity Report Enables you to display on the screen or print a report of 
conductivity for a selected orifice tube and electrolyte 
solution; the Conductivity Report Settings dialog is dis-
played.

The Orifice Tube and Electrolyte solution drop-down 
lists enable you to choose the combination desired.

The remaining options function in the same manner as 
the Log Report (explained on the previous page).
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Unit Configuration

Select this option to display software/hardware configurations for the selected analyzer. 
When you select Unit Configuration from the Unit menu, the Unit Configuration dialog  
is displayed.

 
Software Versions  Displays the software versions for components being 

used by the analyzer.

Last analysis Displays the last orifice and electrolyte solution used by 
the analyzer, or unknown. If known, the calibration date 
of the orifice tube is also shown.

Calibration Displays calibration dates for components being used by 
the analyzer.

Options Indicates whether the volumetric pump is installed. Also 
displays the type of stirrer installed on the analyzer.

Configuration Displays the analyzer’s IP address. Also enables you to 
view details of the boards installed in the analyzer.
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Board ID Displays the Board ID dialog containing information on 
the circuit boards installed in the computer; the Board ID 
dialog is displayed.

Change Displays the Unit IP Setup dialog.

This dialog shows the IP address and Subnet mask that 
were assigned during installation. Do not edit these num-
bers unless directed by a Micromeritics service 
representative.
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Calibration

The Calibration option provides a method of storing instrument calibration data. Your 
Micromeritics service representative may use this option to enter calibration data or per-
form component calibrations for future reference when servicing the analyzer.

This option is enabled only when the analysis program is operating in Service Test mode 
(refer to Service Test Mode, page 7-8 for additional information).

Service Test

Certain service tests are included in the operating program, but can be performed only 
with the assistance of a trained Micromeritics service representative. These tests are 
designed to provide your service representative with instrument readouts, as well as to 
assist him in troubleshooting potential problems and, perhaps, eliminating unnecessary 
repair services. This service strategy allows you to conduct expert tests in less time than it 
would take to be properly trained in servicing the instrument.

This option is enabled only when the analysis program is operating in Service Test mode 
(refer toService Test Mode, page 7-8 for additional information).
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6.  REPORTS MENU

The options on the Reports menu enable you to generate reports on:

• sample analyses
• orifice tube calibrations
• statistical process control parameters
• historical particle size distribution

This chapter provides a description of these options, as well as sample copies of some of 
the reports available with the Elzone program. Refer to Report Options, page 4-25 for 
details on editing reports.

Description

Listed below are brief descriptions of the commands contained on the Reports menu. 
Detailed descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis or on the data collected thus far for an analysis in 
progress. Page 6-3.

Close Reports Closes all open report windows. Page 6-6.

Open Report Enables you to open a report saved from the report win-
dow. Page 6-6.

Orifice Tube Calibration Allows you to generate a report on an orifice tube. 
Page 6-7.

SPC Report Options Allows you to specify the sample data to be included in 
SPC reports. Page 6-8.
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Regression Report Allows you to generate a regression report. Page 6-11.

Control Chart Allows you to generate a control chart report. Page 6-15.

PSD History Allows you to generate a particle size distribution history 
report. Page 6-19.
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Start Report

Select this option to generate a report on a sample analysis. Select Start report from the 
Reports menu to display the Start Report dialog

Category/Subcategory Use these drop-down lists (directories) to navigate to the 
desired file(s).

Status This drop-down list determines the type of sample files 
displayed in the Files list window in the specified direc-
tory for all dates, or within the specified range of dates 
(using push button).

Choices: All, Analyzing, Complete, Entered

Refer to Table 2-2. File Status and Description, page 2-
11 for a description of the status types.

Date Range Displays the Select Dates dialog so that you may specify 
a range of dates. Refer to Selecting Files, page 2-10 for a 
description of this push button.
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Preview Choose this option to have the report(s) generated to the 
screen. If a printed copy is desired, you can print the 
report from the report window.

Options for customizing and fine-tuning data are avail-
able for onscreen reports (page 6-22).

Print Choose this option to have the report(s) generated 
directly to the printer. If you choose this option, the Cop-
ies field is enabled allowing you to print up to four cop-
ies.

Export Choose this option to print to a file; use the field below 
the Export option to enter a name. The Export option is 
unavailable for an Analyst.

Files window Displays a list of the available sample files for the choice 
shown in the Status field and in the selected date range.

Comments Displays statistics for the selected file.

Version Displays the version of the selected file. If more than one 
version exists, the drop-down list containing the versions 
available is enabled. 

Report Generates the report to the requested destination.
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If you choose a single sample file, the Selected Reports dialog is displayed when you 
click Report. The reports selected are the ones you specified in the sample file. This dia-
log allows you to deselect reports or select additional ones.

Double-click on the report(s) you wish to select (or deselect). A check mark is placed 
before each selected report. Pressing the Spacebar performs the same function. After you 
make your report selection and click OK, the requested reports are sent to the specified 
destination.

If you choose more than one file, this dialog is not displayed. The reports you specified in 
each sample file will be generated and sent to the specified destination.

Check marks indicate 
selected reports.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having 
to select close on each report window.

Open Report

This option enables you to open a report that has been saved from the Report window; the 
Report window opens with an Open dialog positioned on top. 

After you navigate to the desired directory, select your file, and click Open, your report is 
displayed in the Report window.

Report Window
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Orifice Tube Calibration

This option enables you to generate a report on an orifice tube calibration; the Start Ori-
fice Tube Report dialog is displayed.

Instrument Drop-down list containing the serial number of the 
instrument(s) installed on the current computer. You can 
have up to two instruments on one computer.

Orifice Tube Drop-down list containing the calibrated orifice tubes 
that exist for the selected instrument.

Calibration date 
and time

Displays the date and time of the calibration for the 
selected orifice tube.

Report settings Choose Preview to have the report generated to the 
screen. If a printed copy is desired, you can print the 
report from the report window.

Choose Print to have the report generated directly to the 
printer. If you choose this option, the Copies field is 
enabled allowing you to print up to four copies.

Choose Export to have the data exported to a file; its cor-
responding field is enabled with a default name assigned. 
You can edit the name if desired. This option is not avail-
able for an Analyst.

Not displayed for an 
Analyst.
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SPC Report Options

When you select SPC Report Options, the SPC Calculations dialog is displayed.

Test This drop-down list contains analysis choices for SPC 
calculations.

Last reports statistics for the last analysis performed.

First reports statistics for the first analysis performed.

Average reports an average based on all tests in the 
selected sample file(s).

Statistics Type Allows you to choose the type of statistics for which the 
SPC variables are to be calculated.

Distribution Type Allows you to choose the type of distribution data for 
which the SPC variables are to be calculated.

Arithmetic Statistics Allows you to choose the type of arithmetic statistics for 
which the SPC variables are to be calculated.

Statistics Displays a list of the variables available for SPC report-
ing; you may choose as many as you wish.

Displays the range 
for the selected 
field.
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Sample Displays the Sample SPC Options dialog, allowing you 
to select the sample parameters you wish to have 
reported.

Specific parameters can be designated for the fields 
labeled Parameter [n]. Refer to Edit Labels, page 7-4 
for additional information.

Analysis Displays the SPC Analysis Conditions Options dialog, 
allowing you to select the analysis conditions you wish to 
have reported.
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Sizes Displays the SPC Size Options dialog, allowing you to 
specify up to 10 sizes and 5 distribution types at which 
the cumulative percent finer (or coarser, depending on 
the selection in the Units dialog) is to be reported.

Percentiles Displays the SPC Percentile Options dialog, allowing 
you to specify the percentiles and distribution types for 
which the cumulative percent finer (or coarser, depend-
ing on the selection in the Units dialog) is to be reported.

Peaks Allows you to choose the peaks to include in SPC cal-
culations; you can include up to 10 peaks.
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 Regression Report

Select this option to generate a regression report. The regression report is used to deter-
mine the interdependency between two variables. Up to three dependent variables (Y-
axis) may be plotted against a single independent variable (X-axis). The degree of corre-
lation between the variables also is reported. The graphs for the regression report are 
scaled so that all three fit on a single page. If you choose less than three, the graphs are 
scaled to fill most of the page.


Show report title Select this option to have a title display on your report. 

Accept the default or enter a new title. You can enter up 
to 40 alphanumeric characters. 

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your 
report title. For example, you may wish to display your 
company logo. The graphic must be a bitmap (bmp) or 
enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited 
in the report window (when printed to the screen), or 
removed if desired.

Not displayed for an 
Analyst.
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X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. 
Click on the down arrow to display a list of variables. The 
variables in this list are the ones you specified in the SPC 
report options.

With this option, you can plot the regression of up to 
three Y-axis variables against the X-axis variable. The X-
axis specifies the independent variable for the regression, 
while the Y-axes provide the dependent variables.

Axis Range Enables you to specify the beginning and ending values 
for the X- and Y-axis ranges. Data collected outside these 
ranges are not included in the plot. These fields are dis-
abled if you choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled automat-
ically. When scaled automatically, both axes begin at 
zero. The analysis program uses the highest values col-
lected during analysis as the ending points.

Recalculate archived SPC 
results

Select this option to have archived SPC values recalcu-
lated. This ensures that any changes made to the SPC 
Report Options are included in the new report; however, 
it does lengthen the time required to generate the report.

Tabular report Enables you to generate tabular, as well as graphical, data 
of the included samples. A tabular report contains the 
numeric values contributed by each sample.

Label data Allows you to label the points on the plot to correspond 
with the values in the sample files.

Samples Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.
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Category
Subcategory

Drop-down lists containing current directories. The Cat-
egory represents the Directory, and the Subcategory rep-
resents the Subdirectory of the selected Directory.

Status This drop-down list determines the type of sample files 
that display in the Available Samples pane in the 
selected directory for all dates, or within the specified 
range of dates (using Date Range push button). Refer to 
Table 2-2. File Status and Description, page 2-11 for an 
explanation of the Status types.

Date Range Displays the Select Dates dialog so that you can specify a 
range of dates. Refer to page 2-10 for an explanation of 
this dialog.

Use all files in 
this location

Select this option to include all files in the selected direc-
tory in the Regression report.

Available Samples This pane contains the sample files residing in the 
selected directory and within the selected range of dates. 

Selected Samples This pane contains the sample files you select to include 
in the report. 
539-42822-01 (Rev B)  - Nov 2017                                                     6-13 



Elzone II 5390 Confirm Regression Report
Add Moves the selected file to the Selected Files pane. Alter-
natively, you can simply double-click on the desired 
file(s). You can select multiple files by holding down Ctrl 
while making your selections. You can include up to 200 
sample files.

Remove Removes the selected file from the Selected Files pane 
and places it back into the Available Files pane.

Save As Default Saves the current definition of the report as the default.

Preview Choose this option to have the report(s) generated to the 
screen. If a printed copy is desired, you can print the 
report from the report window.

Print Choose this option to have the report(s) generated 
directly to the printer without reviewing them first. If you 
choose this option, the Copies field is enabled allowing 
you to print up to four copies.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a 
statistic.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. 

Deselect this option to omit the report title.

Range: 40 characters

Show graphic Select this option to have a graphic display above your 
report title. For example, you may wish to display your 
company logo. The graphic must be a bitmap (bmp) or 
enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited 
in the report window (when printed to the screen), or 
removed if desired.

Order x-axis by Enables you to choose the order in which X-axis statistics 
are placed. You can have them placed by Time, File 
name, Date, Minutes, or Days.

Not displayed for an 
Analyst.
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X-axis Order by

(continued)

Time places the files on the graph at numerical points in 
the order of the date/time the files are analyzed.

File name places the files on the graph at numerical 
points in alphanumeric order.

Date places the files on the graph at points representing 
the actual date/time the files are analyzed.

Minutes places the files on the graph at points represent-
ing the minutes that have elapsed from the first file 
placed on the list, which is the earliest-analyzed file.

Days places the files on the graph at points representing 
the number of days that have elapsed from the first file 
placed on the list, which the earliest-analyzed file.

Graph [n] Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected 
on the SPC Report Options dialog. The variable you 
choose will be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If 
you wish to specify a range, deselect this option and enter 
ranges in the From and To fields.

Center Line Displays placement options for the variable’s optional 
value. Choose Entered to specify placement of the line.
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Limit Lines Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation or at specified positions (Entered).

When you select Entered, the High limit and Low limit 
fields are enabled, allowing you to enter appropriate val-
ues.

Recalculate archived 
SPC results

Select this option to have archived SPC values recom-
puted. This ensures that any changes made to the SPC 
Report Options are included in the new report. It also 
lengthens the time required to generate the report.

Tabular report Allows you to generate tabular, as well as graphical, data 
of the included samples. A tabular report contains the 
numeric values contributed by each sample.

Samples Displays the Control Chart Sample Selection dialog, 
allowing you to choose the sample files on which you 
wish to report. 

This dialog functions in the same manner as the Regres-
sion Report Sample Selection Dialog explained earlier in 
this chapter. Refer to page 6-12 if you need assistance on 
the fields of this dialog.
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Summary Statistics Allows you to select the statistics to display in the report.

Coefficient of Variation is the Standard Deviation
divided by the Mean.

Confidence Interval of the mean value (shown on the 
same line below the graph on the report). When you 
select this option, the Confidence Level field is enabled 
allowing you to enter the percentage.

Select Number of Samples to have the number of sam-
ples analyzed included in the report.

Save as default Saves the current definition of the report as the default.

Preview Choose this option to have the report(s) generated to the 
screen. If a printed copy is desired, you can print the 
report from the report window.

Print Choose this option to have the report generated directly 
to the printer without reviewing it. If you choose this 
option, the Copies field is enabled allowing you to print 
up to four copies.

Export Choose this option to have the report generated to a File; 
the field just below the option becomes enabled allowing 
you to enter a name for the file.

Report Generates the report.
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PSD History

This option enables you to report a sequence of full particle size distribution graphs.


Show report title Select this option to have a title display on your report. 

Accept the default or enter a new title. You can enter up 
to 40 alphanumeric characters.

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your 
report title. For example, you may wish to display your 
company logo. The graphic must be a bitmap (bmp) or 
enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited 
in the report window (when printed to the screen), or 
removed if desired.

X-axis Order By Enables you to choose the order in which X-axis statis-
tics are placed. You can have them placed by Time, File 
name, Date, Minutes, or Days. Refer to page 6-16 for 
an explanation of these options.

Samples Displays the PSD History Sample Selection dialog, 
allowing you to choose the sample files on which you 
wish to report. 

Not displayed for an 
Analyst.
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This dialog functions in the same manner as the Regres-
sion Report Sample Selection Dialog explained earlier in 
this chapter. Refer to page 6-12 if you need assistance on 
the fields of this dialog.

Save As Default Saves the current definition of the report as the default.

Preview Choose this option to have the report(s) generated to the 
screen. If a printed copy is desired, you can print the 
report from the report window.

Print Choose this option to have the report(s) generated 
directly to the printer. If you choose this option, the Cop-
ies field is enabled allowing you to print up to four cop-
ies.

Export Choose this option to have the report generated to a File; 
the field just below the option becomes enabled allowing 
you to enter a name for the file.

Report Generates the report.
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Printed Reports

Header

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics, as shown in this example.

The report header may contain a graphic (such as a company logo) and/or title if speci-
fied. The header also contains: 

• Sample and instrument statistics such as date and time of analysis, analysis 
conditions, and background data for tabular and graphical reports.

• Comments entered in the Comments window on the sample information dialog.

• Notes of any changes to the sample file which occur after analysis (excluded in 
summary reports).

• SPC and PSD report headers also display the range of dates of the selected samples 
as well as the current date. 
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Onscreen Reports

When you choose Preview as the report destination, reports are printed to the screen. 
Onscreen reports provide many options for customizing and manipulating reports: 

• a tool bar
• shortcut menus
• zoom feature
• axis cross-hairs 

When reports are printed to the screen, they are printed in a window like the one shown 
below. Each requested report is listed in the Reports window on the tool bar; they are also 
indicated by selectable tabs across the top of the report header. To view a specific report, 
select its tab or select the report in the Reports window and click Show.

Header

List of 
Requested 
reports

Toolbar

Displays 
graphical (or 
tabular) data

Tabs display for each type of report generated.
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Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the 
report has been hidden, it and its associated tab will 
become visible.

Delete Deletes the selected report. A deletion confirmation dia-
log is displayed since this function cannot be undone. 
The deleted report(s) will have to be regenerated if 
deleted in error.

Hide Hides (removes) the selected report from the report win-
dow. The report’s associated tab is also removed. 

Open Allows you to open a previously saved report file

Print Displays a print dialog so that you can choose an appro-
priate printer for report output.
539-42822-01 (Rev B)  - Nov 2017                                                     6-23 



Elzone II 5390 Confirm Onscreen Reports
Print
(continued)

A list of available reports is displayed in the window on 
the right side of the dialog

For convenience in selecting which reports to print, push 
buttons are provided beneath the report window. Or, you 
can make your selection by clicking on the desired 
reports. 

Current selects the report displayed in the report 
window.

Shown selects only the shown reports; any non-high-
lighted reports indicate they are hidden. You can still 
select hidden reports from this window to print.

All selects all reports, including those that may have 
been hidden.

Clear clears all selections. 

Save Saves all reports of the currently open file in a report for-
mat using the same name as the sample file, only with an 
rep extension. If you wish to specify a name and/or spe-
cific reports to save, use the Save As push button.

Save As Saves all or specified reports from the currently open file. 
The push buttons displayed on this dialog perform in the 
same manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows 
you to reopen the file using the push button on the Report 
window tool bar.

Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be 
imported into programs accepting this type of file.
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Default Style Displays the Default Style dialog so that you can edit 
report defaults.

Fonts Contains a list of report elements for which the font can 
be edited. Simply highlight the desired element and click 
Edit; a font dialog is displayed so that you can specify the 
desired font and attributes.

Curve The items in this group box enable you to specify a thick-
ness for report curves and, when using histograms, the 
type of fill to apply.

Graph border 
line thickness

Enables you to specify a thickness for the border of the 
graph.

Load Loads the last saved defaults.

Save Saves the changes as the defaults. If you do not click 
Save, the changes will apply to the current report set 
only. The next reports will revert to the defaults.

Close Closes the dialog and applies the changes. If you clicked 
Save, the changes become the defaults. If you did not 
click Save, the changes apply to the current report only.

Close Closes the report window.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

Tabular Reports

Resize column Displays a dialog so that you can specify the width of the 
selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column 
to the left or to the right.

Align column Enables you to right-align, left-align, or center the data in 
the selected column.

Hide column Displays a list of the columns that have not been hidden, 
enabling you to select the one you wish to hide.

Show column Displays a list of all hidden columns, enabling you to 
select the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attri-
butes for the tabular data in the current report. 

Header font Displays a Font dialog, allowing you to change font attri-
butes for column headers in the current report.
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Graphs

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns 
are tab-delimited, allowing easy alignment

Autoscale Sets the axis boundaries to autoscale, presenting the sig-
nal in full scale.

Redraw Sets axis boundaries to its original view.

Show curve Shows any curve(s) that has been hidden. This option is 
disabled (greyed) if no curves have been hidden.

Hide curve Hides (removes from view) any unwanted curve(s).
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Edit curve Displays the Curve Properties dialog, allowing you to 
edit curve properties.

Title Displays the title of the curve you are editing. You can 
edit the title if desired.

Style This drop-down list contains the styles in which collected 
data can be displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve Contains options for curves and points. You can: 

• choose a linear or Akima Spline interpolation for the 
curve (disabled when points is chosen)

• choose a style and color for curves and/or points

• specify a line thickness for curves

The options in this group box are disabled if Histogram is 
chosen from the Style drop-down list.

Histogram Allows you to specify the type of fill as well as the color 
when Histogram is chosen as the style for collected data. 

The options in this group box are disabled if Curve, 
Points, or Curve/Points is chosen from the Style drop-
down list.
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Edit axis Displays the Axis Properties dialog, allowing you to edit 
axis properties.

Title Displays the title of the axis you are editing; use the Title 
font push button to edit font attributes if desired.

Scale The items in this group box enable you to:

• choose a linear or logarithmic scale
• invert the scale 
• edit the autoscale values
• edit the attributes for the scale font 

Gridlines This drop-down list enables you to choose solid or dotted 
grid lines, or you can choose None to omit grid lines.

Edit legend Displays the Legend Properties dialog, allowing you to 
edit the placement of the legend. You can also edit the 
font if desired.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine 
fine details. To use this feature, simply hold down the left mouse button and drag the 
mouse cursor (drawing a box) across the area you wish to view; then release the button. 
The enlarged area immediately fills the graph area. You can return to the normal view by 
right-clicking on the graph and selecting Redraw or Autoscale from the shortcut menu.

Edit title Displays the Title Properties dialog, allowing you to edit 
the current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing 
you to paste it into other applications accepting Windows 
metafiles. 

Copy as text Copies the data used to generate the graph as a series of 
tab-delimited columns of text.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this fea-
ture, simply left-click in the desired area of the graph.

Right-click in the graph area and choose Autoscale or Redraw from the shortcut menu to 
remove cross-hair lines and return to the normal view. Alternatively, you can click out-
side of the graph area.

Y-axis position

Point of Coordination

X-axis position
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Report Examples

The remainder of this chapter contains samples of some of the reports that can be gener-
ated by the Elzone 5390 Confirm Program. Most of the reports can be varied through 
entries on the report options screens.
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Combined Report
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Incremental Number vs. Particle Diameter 
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Incremental Volume Percent vs. Particle Diameter
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Standard Class Size Table
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7.  OPTIONS MENU

The choices on the Options menu allow you to configure the system to your laboratory’s 
requirements. With the options on this menu, you can:

• Add directories
• Edit labels for sample files and directories
• Specify data presentation modes
• Specify default sieve sizes

Some functions on the Options menu cannot be performed by an Analyst; those are marked 
accordingly.

Description

Listed below are brief descriptions of the options contained on the Options menu. Detailed 
descriptions follow this section.

The only functions available to an Analyst on the Options menu are to add an archive location 
or check the orifice tube and liquid. All other operations are initiated by a Developer.

Add Archive Location Allows you to add a directory. Page 7-3.

Edit Labels Allows you to specify names for the labels that appear on the 
sample file editor. Page 7-4.
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Update File List Allows you to update the cache file for the sample or param-
eter file directory. This operation has to be initiated by the 
Administrator. Page 7-5.

Units Enables you to choose the manner in which to display units 
of measurement, pressure, and temperature. Page 7-5.

Invert size axis Enables you to invert the size axis. Page 7-6.

Graph Grid Lines  Enables you to choose the type(s) of grid lines to show on 
your report. Page 7-6.

Sieve Table Allows you to specify defaults for sieve sizes. Page 7-7.

Check Orifice Tube and 
Liquid

Use this default option to have the program verify at the start 
of an analysis that the orifice tube and liquid in the current 
analysis match those of the previous analysis. Page 7-7.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
under the direction of a Micromeritics service representative. 
Page 7-8.
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Add Archive Location

Archive locations (directories) can be added by an Analyst or a Developer; the Add Archive 
Location dialog is displayed.

Category
Subcategory

These fields allow you to create new directories and/or sub-
directories for the repository. 

The drop-down lists in the All Locations column contain the 
existing directories and subdirectories.

The fields in the New Location column allow you to enter 
new directories. Category represents the “Directory,” and 
Subcategory represents the “subdirectory.” You can add a 
subdirectory to an existing directory by choosing the direc-
tory from the drop-down list, then entering the new directory 
name in the Subcategory field.

The labels for the directories can be changed by the Devel-
oper (see following section). Many laboratories use the 
month/year combination for organizing files.

These directories and their contents are not visible through the use of Windows 
Explorer; they can only be viewed within the analysis program.

Sequence number Allows you to enter a new sequence number for the directory 
you create. This number is incrementally sequenced for each 
sample file you create and displays as part of the identifica-
tion if the sample template includes a $ symbol.

Add Enabled when you make an entry in the Subcategory field, 
allowing you to add the new directory and close the dialog 
box.
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Edit Labels

Edit labels allows the Developer to edit the labels that display on the sample file editor; the 
Edit Labels dialog is displayed.

An Analyst is not authorized to edit sample file labels.

Repository Levels The Top and Second Levels represent the directory (category) 
and subdirectory (subcategory) for the location of sample 
files.

Sample Information 
prompts

These are the labels that appear on the sample information 
dialog. You can edit the labels to display differently if 
desired; for example, you may wish to use Material rather 
than Sample.

If you do not wish to have the Operator, Submitter, and/or 
Bar code (or other specified names) lines, you can click 
Omit to have them excluded.

User Parameters The fields in this group box are used primarily for SPC (Sta-
tistical Process Control) reporting. They are used to specify 
characteristics of the sample or its manufacturing process.

For example, you may wish to report the relationship of the 
motor speed of a grinder used in the manufacturing process 
to the median diameter of the sample. Enter Motor speed as 
a Parameter; add the value in the sample file. When you add 
the value in the sample file, you can save the file as a Tem-
plate, making it available when desired. Specified 
parameters display in the SPC Sample Options dialog 
(accessed through the SPC Calculations dialog).
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Update File List

This function cannot be performed by an Analyst nor a Developer, unless the Developer has 
Administrator rights. This is an Administrator function only; details for performing this oper-
ation are covered in the Administrator’s Guide.

This option allows the directory to be updated when files have been added outside of the 
application. For example, if you need to restore the directory with a backup file.

Units

This menu command displays the Units Selections dialog which allows you to choose the 
manner in which to display units. 

 

User Parameters
(continued)

Once specified, these parameters display on the sample editor 
and in the SPC Sample Options dialog (accessed through the 
SPC Report Options dialog).

These fields can also be used to record analysis conditions or 
sample information so that it can be printed on the Summary 
report.

Select Omit if you are not reporting SPC data; this will pre-
vent them from displaying on the sample information dialog.
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Invert Size Axis

Select this option to invert the size axis.

Graph Grid Lines

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; the 
Graph Grid Lines dialog is displayed.

An Analyst is not authorized to invert the size axis.

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to dis-
play in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Style Allows you to choose the type of grid line to display if 
grid lines are being shown.
7-6                                                    539-42822-01 (Rev A) - Nov 2017



Sieve Table Elzone II 5390 Confirm
Sieve Table

Displays the Sieve Table allowing you to specify default sieve sizes for sieve data.

To select sizes, move to the desired size, then double-click the left mouse button or press 
Spacebar. A sieve size is selected when it is preceded by a check mark. 

Check Orifice Tube and Liquid

Select this option to have the analysis program check at the beginning of each analysis to ver-
ify that the orifice tube and liquid specified in the sample file match the ones used in the 
previous analysis. If the tube and liquid do not match, an error message is displayed.  

An Analyst is not authorized to specify sieve defaults.

Indicates the size is 
selected.
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Service Test Mode

Certain service tests are included in the operating program, but can be performed only with 
the assistance of a trained Micromeritics service representative. These tests are designed to 
provide your service representative with instrument readouts, as well as to assist him in trou-
bleshooting potential problems and, perhaps, eliminating unnecessary repair services. This 
service strategy allows you to conduct expert tests in less time than it would take to be trained 
in servicing the instrument properly.

When you select Service Test Mode from the Options menu, a dialog box is displayed 
prompting you to enter a password. This password can be provided only by your service rep-
resentative; therefore, you will not be able to enter Service Test Mode and perform these tests 
without his guidance
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8.  TROUBLESHOOTING AND MAINTENANCE

The Elzone II 5390 analyzer has been designed to provide efficient and continuous ser-
vice. However, in order to obtain the best results over the longest period of time, certain 
maintenance and service procedures should be followed. This chapter contains informa-
tion regarding common operational problems and corrective action, and maintenance and 
service procedures. 

If you encounter a problem that is not covered in this chapter, contact your Micromeritics 
service representative. 

Troubleshooting

The following table lists some solutions for common operational problems that may be 
incurred.

Table 8-1. Common Operational Problems

Problem Reason Solution

No liquids flow when 
the valves are open; the 
vacuum pump is oper-
ating properly.

Possible valve damage Access the instrument sche-
matic and be sure that valves 
are open and that the pump is 
operating. Then contact your 
Micromeritics service 
representative. 

Sizes are incorrect 
when analyzing refer-
ence material.

The orifice may be partially 
blocked.

Clean the orifice tube. Refer to 
Cleaning Orifice Tubes, page 
8-9.

The orifice may have changed 
size or may be cracked

Replace the orifice tube.

The sample you analyzed did 
not represent the reference 
sample

Prepare a new sample or use 
another reference material.

The wrong calibration data 
were used.

Ensure that the correct calibra-
tion and setup data were used.

Air bubbles are stick-
ing to the inside of the 
orifice tube around the 
orifice.

The surface of the orifice tube 
may not be clean.

Clean the orifice tube; refer to 
Cleaning Orifice Tubes, page 
8-9.
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Problem Reason Solution

There is a high back-
ground count on 
electrolyte.

The electrolyte may be 
contaminated.

Filter the electrolyte.

Front and/or side panel doors 
are open.

Ensure that the doors are 
securely closed.

The orifice tube may be 
cracked.

Check the orifice tube; replace 
if necessary.

Noise from electronics, power 
line, or radio frequency (RF) 
may be causing interference.

Have an electrician check for 
noise on the power line or for 
RF noise. 

Noise from CRT monitor may 
be causing interference.

If possible, place the monitor to 
the left side of the analyzer 
where it will be away from the 
sample compartment. If not 
possible, place the monitor at 
least two feet away from the 
sample compartment on the 
right side.

Use an LCD monitor if 
available.

Instrument is unable to 
measure conductivity 
within the normal 
range.

There is no electrolyte in the 
sample beaker.

Fill the beaker with electrolyte.

The external electrode is not in 
the sample beaker.

Place the electrode in the 
beaker.

The external electrode is not 
plugged in securely.

Ensure that the plug is securely 
seated in the connector.

The orifice is blocked. Use one (or more) of the fol-
lowing options on the Unit 
menu to clear the orifice tube:

• Clear Blockage
• Flush System
• Drain System; if you use this 

option, be sure to refill the 
system

• Fill System

Faulty circuit board. Contact your Micromeritics 
service representative.

The orifice tube is not filled 
completely.

Fill the orifice tube.
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Problem Reason Solution

System won’t fill. Waste container lid may not be 
securely screwed onto the 
container.

Tighten lid on waste container, 
then try to fill the system.

Supply tube may not be sub-
merged in the Supply container.

Be sure the supply tube is com-
pletely submerged in the supply 
liquid.

Leak in plumbing system. Access instrument schematic 
and enable manual control. 
Right-click on servo valve; set 
target to 100. Turn on servo 
valve and pump. When target 
reaches 100, open sample 
valve. If vacuum drops signifi-
cantly, a leak is indicated. Call 
your Micromeritics service 
representative. 

Valves may not be functioning 
properly.

Call your Micromeritics ser-
vice representative.

Vacuum is unable to reach the 
target vacuum.

See below. 

Vacuum does not reach 
target.

Calibration files may have 
become corrupted.

Have your Administrator (or 
someone with Administrator 
rights) reinstall calibration files. 
If you are still unable to reach 
the target, call your Micromer-
itics service representative.

Filters to servo valve may be 
blocked.

Call your Micromeritics ser-
vice representative.

Vacuum pump may be faulty. Call your Micromeritics ser-
vice representative.
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Preventive Maintenance

Table 8-2 lists the preventive maintenance procedures you should perform to keep your 
system operating at peak performance. Instructions for each procedure follow the table.

Table 8-2. Preventive Maintenance Schedule

Maintaining Orifice Condition

A clean, undamaged orifice jewel is essential for collecting valid data. Contaminated sur-
faces or obstructions cause signal noise and false pulse amplitudes. Check the orifice 
daily for changes.

The orifice tube may remain connected to the analyzer when not in use. When not in use, 
immerse the orifice tube in clean water or detergent rinse. If this practice is not followed, 
evaporate buildup and/or slow-to-wet active sites on orifice surfaces will cause signal 
noise or false amplitude.

The following practices will help keep the orifice in proper condition and help detect 
potential problems.

Storing Orifice Tubes

If the orifice tube is removed from the analyzer, store it as follows:

1. Clean the orifice tube (refer to Cleaning Orifice Tubes, page 8-9).

2. Store the orifice tube in a dust-free container.

Maintenance Required Frequency

Maintain orifice condition, page 8-4 Daily

Clean the sample area, page 8-6 Daily

Clean the system, page 8-6 Monthly

Replace the air filter, page 8-8 Monthly

Clean the orifice tube, page 8-9 Monthly
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Preventing Orifice Blockages

Sample materials are seldom sources of fibers or debris in sufficient amount to cause fre-
quent blockages. If blockages do occur due to sample materials, you can “scalp off” 
debris by wet-sieving the prepared suspension through a clean mesh that is roughly 75% 
of the orifice diameter.

At all times, there must be no substantial source of dust or debris:

• in the outer surface of the orifice tube or inner surface of the sample beaker
• on the operator’s hands or clothing
• on the instrument or bench-top
• in the ambient air

A good technique is to filter the electrolyte properly through a 0.1-m microporous mem-
brane. Clean all surfaces in contact with this filtered electrolyte with detergent and then 
rinse two to three times with the filtered electrolyte.

Do not use towels to dry sample beakers. Keep sample beakers covered or inverted on a 
clean surface.

Stress Cracking of Orifice Jewel

The orifice jewel seal is a ceramic bonding of synthetic sapphire and glass which with-
stands virtually all chemicals. By nearly matching thermal expansion coefficients, the 
bonding is strong but can, in time, develop stress cracks in the glass around the jewel, 
which may cause a noise signal. Repeated cracking will require remount of the jewel in 
new glass or replacement of the orifice tube.

Check the orifice jewel periodically for signs of cracking. The illustrations below show 
the jewel portion of the orifice tube. The illustration on the left shows a jewel in good 
condition while the one on the left shows a jewel that has begun to crack.

This is a jewel in good 
condition.

This is the jewel of the same 
orifice tube; note how it is 
beginning to crack.

Cracking
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Cleaning the Sample Area

For this procedure you will need the following:

• Lint-free cloth
• Isopropyl alcohol (IPA), mild detergent, or hydrogen peroxide solution

Use a clean, lint-free cloth to wipe up spills as they occur. 

All surfaces of the analyzer should be kept clean and dry at all times. You may use a 
clean cloth, dampened with IPA, a mild detergent, or a 3% hydrogen peroxide solution to 
clean the outer casing of the analyzer.

Cleaning the System

You should clean the Elzone system (internal glassware) at least every 30 days.

For this procedure, you will need the following:

• a sample beaker of water
• 500 - 1000 mL beaker of  water
• 500 - 1000 mL beaker of soapy water

1. Install an orifice tube onto the sample port.

2. Place a sample beaker of water on the sample stand, then raise the sample stand. Be 
sure the tube is submerged.

3. Disconnect the Supply tube from the side of the analyzer, then remove the tube from 
the bottle allowing any contents to drain back into the Supply bottle.

4. Reattach the Supply tubing to the side of the analyzer; place the other end of the 
tubing into 500 - 1000 mL the beaker of water.

Your system may require cleaning more often, depending on the type of sample 
being analyzed.
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5. Select Unit > Rinse to display the Rinse dialog.

Select Drain and fill and enter 1 in the Rinses field (as shown in the dialog).

6. Click Start; the dialog closes automatically when the rinsing operation is complete.

7. Remove the Supply tube from the 500 - 1000 mL beaker of  water, then place it into 
the 500 - 1000 mL beaker of soapy water.

8. Select Unit > Rinse to display the Rinse dialog again; ensure that Drain and fill is 
selected and enter 2 in the Rinses field.

9. Click Start; the dialog closes automatically when the rinsing operation is complete.

10. Remove the Supply tube from the 500 - 1000 mL beaker of soapy water. Rinse the end 
of the tube thoroughly to remove any soap residue, then place it back into the 500 - 
1000 mL beaker of water.

11. Select Unit > Rinse to display the Rinse dialog again; ensure that Drain and fill is 
selected and enter 3 in the Rinses field.

12. Click Start; the dialog closes automatically when the rinsing operation is complete.

13.  Remove the Supply tube from the 500 - 1000 mL beaker of water and place it into the 
Supply container.

14. Lower the sample stand and remove the sample beaker of water.
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Replacing the Air Filter

The air filter on the rear panel should be replaced every 30 days (more often in environ-
ments with increased levels of dust).

1. Remove the filter by inserting a pointed object, such as a flat-blade screwdriver, into 
the outer edge of the retaining cover; then pop off the cover. You do not have to 
remove the screws.

2. Discard the old filter and replace with a new one from your accessories kit.

3. Replace the retaining cover.

Insert screwdriver 
here.

Do not remove these screws.
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Cleaning Orifice Tubes

Orifice tubes must be kept clean to ensure accurate analysis results. Follow the procedure 
below to clean an orifice tube when:

• the orifice tube will not be used for at least one week
• air bubbles are forming on the inside of the orifice tube
• at least once a month when the orifice tube is in use

You will need the following items to perform this procedure:

• Scrub brush (provided in the accessories kit)
• Rubber gloves
• Detergent
• Nitric acid
• Acetone

1. Protect your hands with rubber gloves.

2. Use detergent and the scrub brush to scrub the inside of the tube, then scrub across the 
outside of the jewel.

Do not touch or breathe vapors from the solvents used in this procedure. Failure 
to observe these precautions could result in a health hazard. Refer to the Nitric 
Acid MSDS and the Acetone MSDS for proper handling instructions. Dispose of all 
solvents appropriately.

Do not attempt to clean the orifice with a hard or pointed object or by immersing 
the orifice tube in an ultrasonic cleaner. Doing so could damage the orifice jewel.
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3. Rinse off the detergent with water.

4. Rinse the inside and outside of the tube with acetone.

5. Let the tube dry and store it, or place it on the analyzer.

Orifice tubes should be cleaned on a monthly basis as follows:

1. Perform steps 1 through 4 (above).

2. After rinsing with acetone, rinse with water. Make sure all acetone is rinsed off.

3. Place the tube in a nitric acid solution, which can be concentrated or diluted. Be sure 
to fill half the tube with the nitric acid solution.

4. Soak the tube for at least one hour. You can soak the tube overnight or over a weekend 
if desired.

5. Rinse the tube with water to remove completely all acid.

6. The tube is ready to be placed on the analyzer or you can rinse it with acetone and 
allow it to dry for storage.
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Clearing Blockages

Occasionally, a particle may become lodged in the orifice and cannot be cleared through 
the use of the software. Perform the following steps to manually clear a blockage from 
the orifice.

1. Click Stop on the Analysis window (if  not stopped by the software) to stop the 
analysis.

2. Lower the sample stand to gain access to the orifice tube.

3. Using the bent orifice brush provided in the accessories kit, brush the orifice area of 
the tube. Then rinse the outside of the tube to remove any debris that may have 
remained from the brush.

4. Raise the sample stand; click Continue to restart the analysis.

• If the orifice is still blocked, proceed to the next step.

• If the orifice is unblocked, continue with the analysis.

5. Lower the sample stand to gain access to the orifice tube.

6. Using the larger orifice tube brush provided in the accessories kit, brush the orifice 
area of the tube. Then rinse the outside of the tube to remove any debris that may have 
remained from the brush.

7. Raise the sample stand click Continue.

• If the orifice is still blocked, proceed to the next step.

• If the orifice is unblocked, continue with the analysis.

8. Select Unit > Drain to drain the system.

9. Lower the sample stand and remove the sample beaker to gain access to the orifice 
tube.

Bent brush

Straight brush
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10. Remove the orifice tube and clean it thoroughly (refer to Cleaning Orifice Tubes, 
page 8-9 for instructions).

11. After cleaning the tube, check the orifice to see if it is unblocked;  a good procedure 
for doing this is:

a. Rinse the tube with cold tap water.

b. Holding the tube underneath the faucet, fill completely until it is in a meniscus 
state.

c. Place your index finger over the top of the tube and press downward; this will 
spew water out of the orifice if the tube is unblocked. You may have to hold the 
tube against a darker background to obtain a clear view of the stream of water.

12. Reinstall the orifice tube.

13. Prepare a new beaker of electrolyte and place it on the sample stand.

14. Raise the sample stand, submerging the orifice tube in the beaker.

15. Select Unit > Fill to fill the system with electrolyte.

16. Prepare a fresh sample mixture and restart the analysis.

If the orifice is still blocked, call your Micromeritics Service representative.
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Installing the Hydropulser

The hydropulser and stirrer are installed in the same location, the back wall of the sample 
compartment. 

These instructions are assuming you have a stirrer currently installed on your analyzer.

1. Ensure that the sample stand is in its lowest position.

2. Grasp the propeller and pull downward to remove it from its rubber connector.

3. Gently pull downward on the external electrode to remove it from its red connector.
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4. Turn the four captive thumb screws counterclockwise to loosen the stirrer assembly.  

5. Slide the stirrer assembly out and store in a secure location for future use.

6. Insert the hydropulser assembly, ensuring that the back plate of the hydropulser 
assembly slides into the two slots inside the opening.

7. Make sure the hydropulser assembly is flush with the analyzer back panel; this 
ensures that the connector on the back plate of the hydropulser plugs into the 
connector inside the analyzer.

8. Turn the four captive thumb screws clockwise to tighten.
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9. Gently slide the external electrode back into its red connector.

10. Use the clip to attach the hydropulser tube to the orifice tube when performing an 
analysis.

Retaining clip
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Cleaning the Hydropulser

The hydropulser tube should be cleaned daily between sample analyses and more thor-
oughly on a monthly basis, or when the hydropulser is not to be used for long periods of 
time.

Daily

Clean the hydropulser tube after each analysis and at the end (or the beginning) of the 
work day.

1. Place a beaker of clean electrolyte on the sample platform.

2. Raise the sample platform until the orifice tube, electrode, and hydropulser tube are 
submerged (as shown above).

3. Enable manual control and use the instrument schematic to turn on the hydropulser. 

a. Double-click on the stirrer icon; the icon is green when it is on. 

b. Allow the electrolyte to cycle through the tube for approximately 10 seconds

c. Double-click on the icon to turn the hydropulser off; the icon is yellow when 
turned off.

4. Proceed with the next step if you are ready to load the sample. If you are not ready to 
load the sample, allow the glassware to remain submerged in the electrolyte.
8-16                                                   539-42822-01 (Rev A) - Nov 2017 



Installing the Hydropulser Elzone II 5390 Confirm
5. Fill a squeeze bottle with clean, filtered electrolyte or water and thoroughly rinse the 
hydropulser tube, the orifice tube, and the electrode. Do not squeeze electrolyte up 
into the hydropulser tube.

6. Place your sample into the beaker and start your analysis.

Monthly

The hydropulser tube should be removed and thoroughly cleaned on a monthly basis. It is 
good practice to perform this procedure on the first of each month so it will be easy to 
remember.

1. Lower the sample platform.

2. Remove the retaining clip from the orifice tube; it is not necessary to remove it from 
the hydropulser tube.

3. Grasp the tube and remove it from its barbed fitting.     

Do not squeeze electrolyte up into the hydropulser tube. Liquid may get into the 
hydropulser assembly and damage the assembly, or cause erratic results. Remove 
the tube, clean, and dry it thoroughly if this occurs.
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4. Place the tube into a beaker of diluted detergent, then place the beaker into an 
ultrasonic bath for approximately five minutes.

If an ultrasonic bath is not available, use a pipette or a syringe attached to the end of 
the tube; cycle the detergent solution in and out of the tube at least ten times.

5. Flow water through the tube until all detergent is completely removed.

6. Allow the tube to dry completely. Pour IPA through the tube to speed the drying 
process.

7. Reattach the hydropulser tube to the barbed fitting.

8. Perform the steps given for Daily cleaning in the previous section.
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9.  ORDERING INFORMATION

The Elzone 5390 system components and accessories can be ordered using one of the follow-
ing methods: 

• Call our Customer Service Department at (770) 662-3636
• Access our web site at www.micromeritics.com
• Contact your local sales representative

When ordering, please use the information provided below to place your order:

Part Number Item and Description

538-61704-01 Stirrer, medium propeller; enables you to maintain dispersion of 
samples. The stirrer provides a rotary movement, the speed of which 
is specified in the software.

538-61704-02 Stirrer, large propeller

539-34020-00 Hydropulser; provides a more gentle method of maintaining disper-
sion of samples. The hydropulser uses a fluid pulsing movement, the 
speed of which is specified in the software.  

539-33602-00 Camera, for viewing the orifice jewel; includes a backlight and 
mounting hardware

539-33604-00 Volumetric pump, enables you to measure particle concentration 

539-33610-00 Orifice Tube Kit;  includes one 19-m orifice tube, reference 
materials, and reference booklet

539-33611-00 Orifice Tube Kit; includes one 30-m orifice tube, reference 
materials, and reference booklet

539-33612-00 Orifice Tube Kit; includes one 48-m orifice tube, reference 
materials, and reference booklet

539-33613-00 Orifice Tube Kit; includes one 76-m orifice tube, reference 
materials, and reference booklet

539-33614-00 Orifice Tube Kit; includes one 95-m orifice tube, reference 
materials, and reference booklet

539-33615-00 Orifice Tube Kit; includes one 150-m orifice tube, reference 
materials, and reference booklet

539-33616-00 Orifice Tube Kit; includes one 190-m orifice tube, reference 
materials, and reference booklet
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Part Number Item and Description

539-33617-00 Orifice Tube Kit; includes one 300-m orifice tube, reference 
materials, and reference booklet

539-33618-00 Orifice Tube Kit; includes one 380-m orifice tube, reference 
materials, and reference booklet

004-16840-00 Reference material, 1 m; approx. 8 mL

004-16840-01 Reference material, 2 m; approx. 8 mL

004-16840-02 Reference material, 3 m; approx. 8 mL

004-16840-03 Reference material, 5 m; approx. 8 mL

004-16840-04 Reference material, 10 m; approx. 8 mL

004-16840-05 Reference material, 20 m; approx. 8 mL

004-16840-10 Reference material, 30 m; approx. 8 mL

004-16840-06 Reference material, 40 m; approx. 8 mL

004-16840-07 Reference material, 60 m; approx. 8 mL

004-16840-08 Reference material, 100 m; approx. 8 mL

004-16840-09 Reference material, 160 m; approx. 8 mL

538-61703-00 Beaker, 150 mL, contoured

538-61703-01 Beaker, 240 mL, contoured

538-61706-00 Sample vial, 25-mL polystyrene with flat sides and snap cap

003-51130-01 Fuse, 1.0 A Slow-Blow, 5 x 20 mm (220/230 VAC)

003-51131-00 Fuse, 2.0 Amp, 3 AG, Slow-Blow (100/120 VAC)

004-25474-00 O-ring, -013, Kalrez®; for sample port

004-54615-00 Brush, for cleaning orifice tubes

004-54616-00 Brush, bent, for cleaning orifice jewel

004-32209-00 Squeeze bottle, 500 mL, for cleaning glassware

004-61039-01 Bottle, 2 liters, for supply liquid

004-32117-00 Bottle, 2 liters, for waste liquid

539-32804-00 Tubing, for waste bottle

539-32805-00 Tubing, for supply bottle
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Part Number Item and Description

539-60804-01 Sensor cable, for supply liquid

539-25856-00 Clip, hydropulser tube

539-32803-04 Tubing, flexible, hydropulser

539-32802-08 Tubing, rigid, hydropulser

004-27015-00 Air filter (rear panel), package of 10

539-42822-00 Operator’s manual

539-33022-00 Software package, Elzone 5390; includes current version of software 
and operator’s manual
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A.  ERROR MESSAGES

This appendix contains a numerical listing of the error messages associated with the Elzone 
program.

2200 and 2300 Series

2201- Cannot execute report subsystem.

2331- Logged-in Windows user is not an application user.

2333- You did not enter user name or password.

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: The software for the report subsystem has been corrupted and cannot 
be started.

Action: Reinstall the software.

Cause: You attempted to log into the application but the user logged into Win-
dows is not an application user.

Action A: Close the application, restart Windows, and log in as the windows user. 
Then log into the application. 

Action B: Contact your Administrator to assign application rights to the current 
logged-in Windows user.

Cause: You attempted to access the application without entering your user 
name or password.

Action: Enter your Windows OS user name and password in the User Logon 
dialog box.
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2334- Incorrect user name or password.

2335- Attempt of unauthorized access was detected. Please contact administrator.

2336- This user account is locked. Please contact administrator.

2337- The user is not an adminstrator.

Cause A: You entered an incorrect user name or password in the User Logon dia-
log box.

Action A: Reenter your user name and password. Ensure that Caps Lock is not 
enabled; entries are case-sensitive.

Cause B: You entered your user name but failed to enter your password.

Action B: Reenter your user name and password.

Cause C: You entered your application password in both fields.

Action C: Enter your Windows OS user name in the user name field and your 
password in the password field.

Cause: You have exceeded the allowed number of log-on attempts.

Action: Contact your Administrator.

Cause: You entered an incorrect password more than the allowed number of 
times (by default, this is three), and our account has been locked (dis-
abled).

Action: Contact your Administrator to unlock your account.

Cause: You attempted to log in and perform a task that only the Administrator 
is allowed to perform.

Action: Contact your Administrator to complete the task.
A-2                                                    539-42822-01 (Rev A) - Nov 2017 



Appendix A Elzone II 5390 Confirm
2338- Your password has expired or needs to be changed. You will not be able to log 
in without changing the password.

2339- Your password will expire soon. Do you want to change your password?.

2340- You must log in as a Windows OS user to change a password.

2341- Error writing file or the user is not Windows OS user.

2342- Please enter a valid password.

Cause: The allowed time using a password has expired.

Action: Change your password.

Cause: The allowed time for using a password is about to expire.

Action: Change your password.

Cause: You attempted to change your password but you are not logged in as 
the Windows OS user.

Action: You cannot change your password unless you are logged in as the Win-
dows OS user. Close the application, then restart Windows and log in 
as the user.

Cause: You attempted to log into the application but have been denied access. 
Your password file may have become corrupt.

Action: Contact your Administrator.

Cause: You entered an incorrect password.

Action: Reenter your password in both fields. Ensure that Caps Lock is not 
enabled; entries are case-sensitive.
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2343- This password is already in use. Please enter a valid password.

2344- Application locked.

2345- Attempt of unauthorized access was detected.

2346- This user account is disabled. Please contact an administrator.

Cause: You attempted to change your password but entered one that has 
already been used.

Action: Choose a different password.

Cause: Your account has been disabled.

Action: Contact your Administrator.

Cause: You attempted to log into the application but entered and incorrect 
login name or password.

Action: Confirm your login name and password.

Cause: You have attempted to log into the application repeatedly but all 
attempts have failed.

Action: Contact your Administrator.
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2400 Series

2401- FATAL ERROR: (Error message)

2430- Error accessing file (file name), error code = (number)

2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI 'FILE_READ' request.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause A: Hard disk may be damaged.

Action A: Run diagnostics.

Cause B: A software error occurred when the file was accessed.

Action B: Contact your service representative.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to diskette, delete 
them from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) - Subset # (number) wrote wrong amount of data.

2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

Cause: Several files (sample information, analysis conditions, or report 
options) have been added to this directory by some function other than 
the AutoChem program.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a few minutes.Click No if you do not 
want to spend the time updating the directory information. 

This option may be feasible if a large number of files has been copied 
into the directory and you know the name of the file you wish to 
access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Enter a valid path name (including the proper extension) and press 
Enter.

Cause: You entered an invalid file name.

Action: Enter the name of an existing file or select a file name from the Files 
list window.

Cause: You selected a disk drive that is presently inaccessible.

Action: Ensure that the disk in the disk drive is not write-protected
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2439- Could not register file.

2440- Subset not found.

2441- Seek within file failed.

2442- Had header in subset file.

2443- Subset owner denied access.

2444- Not a valid file format.

2445- Subset wrote the wrong amount of data.

2446- Error reading data.

2447- Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your operating sys-
tem or Windows manual and reenter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.
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2452- Attempt to write MICATTR.DIR in read only mode. File (file name).

2453- Attempt to append MICATTR.DIR in read only mode. File (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

Cause: The Read-Only attribute is turned on in the application's 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message.

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You are attempting to exit the application while the instrument is per-
forming a critical operation. This operation must be completed before 
the application can be stopped.

Action: Wait a short time and attempt to stop the application again.
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2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

2460- Fatal Communications error on (Unit n - S/N: nnnn)

2461- No instruments are in operation. This application will unconditionally 
terminate.

Cause: You attempted to exit the Elzone analysis program while an analysis is 
in progress. While this is possible, the data collected while the analysis 
program is inactive will not be permanently recorded until the analysis 
program is re-started. A power failure to the instrument could cause 
some data to be lost.

Action: If your are not concerned with potential loss of data if a power failure 
occurs, click Yes to continue with the exit; click No if you wish to wait 
for the analysis to finish.

Cause: There was a fatal error in the communications between the analysis 
program and the analyzer. All displays for the analyzer will close.

Action: Ensure that the analyzer’s ethernet connections are properly connected. 
Stop and restart the  analysis program. If the restarted application can-
not establish communications with the analyzer, turn the analyzer off, 
then back on. If this error persists, contact your Micromeritics service 
representative.

Cause: An analyzer must be active for the application to operate. The initial-
ization of the analyzes configured with the Setup program has failed. 
The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer's failure to initialize. See the instructions for that mes-
sage. 

Action B: Ensure that the analyzer is attached to the computer. Verify that the 
analyzer has the power switch in the ON position. If the application 
continues to fail in its attempts to initialize the analyzer, contact your 
service representative.
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2477- Unit n - S/N: nnnn did not properly initialize.

2478- Error copying sequential data segment.

2479- Unit n - S/N: nnnn The instrument is busy performing an operation of which 
this application is unaware. Do you want to cancel?

2480- File (name) cannot be analyzed. It is currently being edited.

Cause A: There were communication problems between the computer and the 
analyzer.

Action A: Check the communication cables and make sure they are connected 
securely.

Cause B: You selected Cancel during initialization.

Action B: None required.

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk. 

Contact your service representative if you continue to receive this mes-
sage.

Cause: During initialization, the instrument was found to be analyzing, but the  
analysis program has no record of it. 

Action: Click Yes to cancel the analysis and synchronize the analysis program 
with the instrument’s status. Click No to abort the initialization and 
allow the analyzer to continue the analysis.

Cause: You attempted to start an analysis using a file that is open for editing.

Action: Finish editing the file, save and close it; then restart the analysis.
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2481- Error accessing the sample information file (name).

2482- File (file name) cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

2484- The edit session for (file name) must be saved before the analysis. Save 
changes and proceed with the analysis?

2486- Cannot construct (name) report type. Program will terminate.

Cause: An unexplained error prevents you from accessing this file.

Action: The hard disk drive may be corrupt. Run diagnostics.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation

Cause: You attempted to start an analysis using a file that contains errors and is 
open for editing.

Action: Finish editing the file, save and close it; then start the analysis.

Cause: You attempted to start an analysis using a file that contains unsaved 
changes and is still open.

Action: Click Yes to save the changes and proceed with the analysis. Click No 
to cancel the analysis and continue editing the file.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.
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2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

2489- File (file name) cannot be opened for writing. It is already in use.

2490- No '.INI' file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing.

2492- This field's entry is invalid.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.

Cause: The file you specified is already open for editing.

Action: Check the windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII file containing initialization information and system 
options information used during program startup does not exist.

Action: Contact your Micromeritics service representative.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog. 

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.
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2493- An entry is required for this field.

2494- Value is out of the valid range.

2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

Cause: This field contains an invalid entry.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select a value within the indicated range. 
The valid range is shown in the information bar across the bottom of 
the dialog.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter a value between the range indicated. The 
valid range is shown in the information bar across the bottom of the 
dialog.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.
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2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered data) could not be done.

Action: Contact your service representative if you continue to receive this mes-
sage. Record the name of the sample file in which the problem 
occurred.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (name). Could not create DIO intermediate file.

2504- Cannot create output file for sample (name).

2505- Error Logger cannot be initialized. Error code (number). Program will exit.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your Micromeritics 
service representative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable.

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.
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2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2507- Error opening file (name) for printing. Error code: (number).

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

Cause: The selected output device is not installed.

Action: Install the device using the Control Panel, Printers operation.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the had disk.
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2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been canceled.

2513-  Unable to read the calibration file (file name).

2514-  Unable to write the calibration file (file name).

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files form the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no prob-
lems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems

Action A: Confirm the media containing the alleged calibration file has no prob-
lems.

Action B: Choose an alternate media to Save the calibration data.
539-42822-01 (Rev A) - Nov 2017                                                 A-17 



Elzone II 5390 Confirm Appendix A
2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

2519- Entered or merged data must have at least two points with unique mass per-
cent values.

2521- Unable to program controller.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: You have performed a calibration operation; a backup copy is recom-
mended.

Action: Perform a calibration Save operation.

Cause: You clicked Cancel on the calibration dialog; this will cancel the cal-
ibration you just performed and revert back to the previous calibration.

Action: If the calibration operation was successful, click Accept.

Cause: The entered and/or merged data included in the report being attempted 
does not have sufficient unique mass percent values.

Action: Review the entered or merged data. There must be at least two points 
and the mass percent value of the last point must be different than the 
mass percent value of the first point.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.
A-18                                                    539-42822-01 (Rev A) - Nov 2017 



Appendix A Elzone II 5390 Confirm
2522- Invalid controller application file.

2523- Programming the controller failed.

2524- CRC check failed on programming controller.

2525- Unknown error programming controller.

2526- Controller download was not successful.

2527- Controller CRC error on boot block.

2528- Controller DRAM error.

2529- Controller Com1: error.

2530- Controller Com2: error.

2531- Controller debug port error.

2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number)

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this error message.

Cause: The application has discovered a different version of software operat-
ing in the analyzer. 

Action: If there are no analyzers other than the one connected to the computer, 
select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this error message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.
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2535- The requested directory is not a repository location. Resetting to the default 
location.

2536- The maximum number of versions has already been created for this file.

2537- The directory (name) has already been added to the repository.

2538- The archive location name (name) has already been used.

2539- The repository location (name) cannot be created.

Cause: The directory last accessed is no longer available; the application 
defaults to the default location.

Action: Choose an appropriate directory to select a file.

Cause: The current file contains the maximum number of 676 versions.

Action: If additional versions are required, select File, Save As to create a new 
file from the current version.

Cause: An internal conflict with the repository structure has occurred.

Action: Contact your Micromeritics service representative.

Cause: An internal conflict with the repository structure has occurred.

Action: Contact your Micromeritics service representative.

Cause: You attempted to create a new directory (category) or subdirectory 
(sub-category) but the directory-creating function of the Windows 
operating system has prevented you from doing so.

Action: Contact your Administrator to review security permissions and local 
disk space.
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2540- Error getting log file name.

2541- Windows and application user’s rights conflict.

2542- The file (name) could not be written. Check that the directory permissions are 
correct.

2543- Cannot read from the repository. Check that the directory permissions are 
correct.

2544- Cannot write to the repository. Check that the directory permissions are correct

Cause: The Confirm application was unable to access (or create) the system 
log.

Action: Contact your Administrator to review user rights and local disk space.

Cause: You attempted to log into the application, but the windows user rights 
and Confirm application rights do not agree.

Action: Contact your Administrator to review user rights.

Cause: The system has prevented you from saving your file.

Action: Contact your Administrator to review user rights and local disk space.

Cause: The system has prevented you from accessing a file in the repository.

Action: Contact your Administrator to review user rights for the application 
and the Windows operating system.

Cause: The system has prevented you from saving your file to the repository.

Action: Contact your Administrator to review user rights for the application 
and the Windows operating system.
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2545- The repository appears to be empty. Check that the directory permissions are 
correct.

2546- The file list for the current repository location is missing. Contact an adminis-
trator to update the list.

2547- The instrument is busy. Exiting the application will result in the termination of 
the analysis. Continue with program exit? (Yes, No)

2549- Error accessing online manual file (name).

Cause: The application was unable to determine the repository structure.

Action: Contact your Administrator to review user rights and local disk space.

Cause: You attempted to access a file but the repository does not contain any 
files.

Action: Contact your Administrator to review user rights and local disk space.

Cause: You attempted to exit the application while an analysis is in progress. 

Action: If you are not concerned with cancellation of the analysis, click Yes to 
continue the exit; otherwise select No and allow the analysis to finish.

Cause: You were unable to open the online manual.

Action: Exit the application and reinstall the software. The manual may have 
been accidentally deleted.
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2550- Attempts to acquire the instrument’s status timed out.

Cause: Communication between the analyzer and application have been 
unsuccessful for more than one minute.

Action A: Exit the application, then restart it.

Action B: Ensure that the ethernet cable is securely connected to the computer 
and analyzer.

Action C: Exit the application. Turn off the analyzer, then turn it back on. Restart 
the application. If communication problems persist after all actions 
have been taken, contact your Micromeritics representative.
539-42822-01 (Rev A) - Nov 2017                                                 A-23 



Elzone II 5390 Confirm Appendix A
4200 Series

4200- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code # <number>)

4201- No reports selected.

4202- No valid data to report.

4203- The reference file is not valid. ‘Diff. from ref.’ column was deleted.

Cause: An internal error occurred while read control information was being 
read from a disk file.

Action: The disk on which the application is installed may have failed. Contact 
your Micromeritics service representative and report the code number 
given in the message.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit 
the sample for reporting.

Cause: The selected analysis in the sample file activated for reporting does not 
contain any valid data.

Action: If the sample is still analyzing, wait until enough data have been col-
lected to allow reporting. If the sample is complete, an error or operator 
intervention stopped this analysis before sufficient data could be col-
lected. The analysis may be deleted from the file

Cause: You requested a tabular report with Difference from reference selected 
as one of the columns. This quantity cannot be computed because the 
reference file is invalid.

Action: If no reference file has been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.
A-24                                                    539-42822-01 (Rev A) - Nov 2017 



Appendix A Elzone II 5390 Confirm
4204- Coarser specification file is not valid. ‘Out of spec.’ column was deleted.

4205- Finer specification file is not valid. ‘Out of spec.’ column was deleted.

4206- The tabular report has no valid columns selected. No report produced.

4207- No valid data are available for this report. No report produced.

Cause: You requested a tabular report with Out of Specification selected as 
one of the columns. This quantity cannot be computed because the 
coarse specification file is invalid.

Action: If no specification file has been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You requested a tabular report with the Out of Specification selected 
as one of the columns. This quantity cannot be computed because the 
finer specification file is invalid.

Action: If no specification file has been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You requested a tabular report with all of the columns set to none.

Action: Edit the options for that table and select a variable in at least one col-
umn of the table.

Cause: The selected test in the sample file activated for reporting does not con-
tain any valid data.

Action: If the sample is still analyzing, wait until enough data have been col-
lected to allow reporting. If the sample is complete, an error or operator 
intervention stopped this analysis before sufficient data could be 
collected. The analysis may be deleted from the file.
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4208- An overlay file is not valid. It was not included in the report

4209- The reference file is not valid. The report was not produced.

4210- Coarser specification file is not valid. The report was not produced.

4211- Finer specification file is not valid. The report was not produced.

Cause: The sample file you selected for overlay does not exist or contains 
invalid data.

Action: From the Report Options dialog, click Overlays and remove the sam-
ple file

Cause: You selected the Difference from Reference graph; it cannot be com-
puted because the reference file is invalid.

Action: If a reference file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You selected the Out of Specification graph; it cannot be computed 
because the coarse specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You selected Out of Specification graph; it cannot be computed 
because the fine specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.
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4212- At least one report item must be selected. Press Cancel if you do not want a 
report.

4213- Are you sure you want to delete the test?

4214- The reference file is not valid. The overlay was not produced.

4215- Coarser specification file is not valid. The overlay was not produced.

4216- Finer specification file is not valid. The overlay was not produced.

Cause: You failed to select reports in the “Reports to Generate” list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit 
the sample for reporting.

Cause: You selected Delete on the Collected Data editor.

Action: Click Yes to remove the indicated test from the sample file. Click No 
to have the test remain in the sample file.

Cause: The reference file specified in the current file does not exist.

Action: On the Report Options dialog, click Reference and choose a different 
file.

Cause: The file specified for the coarser specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.

Cause: The file specified for the finer specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.
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4217- No table entries are within the distribution limits.

4218- In order to use (option) you must select a Statistics Type or Arithmetic Statis-
tics Type.

4219- In order to use (option) you must select a Distribution Type.

Cause: Truncate to distribution limits is selected on the report editor, but 
table entries are not within the range of the collected data.

Action: Edit the table entries, or deselect Truncate to distribution on the 
report editor.

Cause: You requested a Summary report, but did not select a Statistics Type.

Action: Edit the Summary report and select at least one Statistics Type.

Cause: You requested a Summary report but did not select a Distribution Type.

Action: Edit the Summary report and select a Distribution Type.
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6000 Series

6001- DataAcq: Peak width read timed out. Height: (number)

6002-  DataAcq: Peak data sequence error. Height: (number) Width: (number) Status: 
(number)

6003-  DataAcq: Current D/A Converter Timed Out.

6004-  DataAcq: Test Pulse D/A Converter Timed Out.

6005-  DataAcq: Low Threshold D/A Converter Timed Out.

6006-  DataAcq: Electrode Current A/D Converter Timed Out. Status: (number)

6007- DataAcq: Preamplifier A/D Converter Timed Out. Status: (number)

6008- DataAcq: Amplifier A/D Converter Timed Out. Status: (number)

6009- DataAcq: Electrode Voltage A/D Converted Timed Out. Status: (number)

6010- DataAcq: Preamplifier Digital Potentiometer Timed Out.

6011- DataAcq: Amplifier Digital Potentiometer Timed Out.

6012-  DataAcq: Log Gain Digital Potentiometer Timed Out.

6013-  DataAcq: Log Reference D/A Converter Timed Out.

6030- Plumbing: Servo D/A Converter Timed Out.

6031- Plumbing: Stirrer D/A Converter Timed Out.

6032- Plumbing: A System Reset has occurred.

6050- Flow Control: Supply liquid reservoir is low.

Cause: An electronic malfunction has occurred.

Action: Contact your Micromeritics Service representative.

Cause: An electronic malfunction has occurred.

Action: Contact your Micromeritics Service representative.

Cause: Your supply bottle is almost empty.

Action: Refill the supply bottle with electrolyte.
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6051-  Flow Control: Differential pressure out of range for zero. Actual: (number) 
mmHg Allowed: (number) mmHg

6052-  Flow Control: Home detected out of range at (number) of steps, maximum 
allowed (number) of steps.

6053- Flow Control: Waste liquid reservoir full. It must be emptied before continuing.

6054- Flow Control: Waste liquid full sensor not present. It must be installed before 
continuing.

6055- Flow Control: Waste liquid reservoir overflowed. It must be emptied before 
continuing.

Cause: The pressure transducer is operating out of specification.

Action: Contact your Micromeritics Service representative.

Cause: The volumetric pump is operating out of specification.

Action: Contact your Micromeritics Service representative.

Cause: The waste bottle is almost full of expended electrolyte.

Action: Empty the waste bottle and reattach it to the analyzer before beginning 
another operation.

Cause: The sensor for the waste container is not properly installed.

Action: Insert the sensor cable and ensure that it is fully seated into the con-
nector. If you continue to get this message, contact your Micromeritics 
Service representatives.

Cause: Liquid has gotten into the tubing from the waste bottle to the vacuum 
pump. Further operation could damage the vacuum pump.

Action: Contact your Micromeritics Service representative.
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6056- Flow Control: Waste liquid overflow sensor not present. It must be installed 
before continuing.

6058- Flow Control: Differential pressure out of range. Actual: (number) mmHg 
Expected: (number) mmHg

6059- Flow Control: Volumetric pump home position found at (number) steps.

6060- Flow Control: Volumetric pump home position not found at (number) steps.

6061- Flow Control: Volumetric pump position (number) steps exceeds maximum 
position (number) steps.

6062- Flow Control: Volumetric pump movement stopped. Move was (number) steps 
at (number) steps/second, direction (number), stopped after (number) seconds.

6063- Flow Control: Volumetric pump movement timed out. Move was (number) steps 
at (number) steps/second, direction (number), stopped after (number) seconds.

6064- Flow Control: Flow operation superseded. Old operation code: (number)  New 
operation code: (number)

Cause: The overflow sensor is not properly installed.

Action: Contact your Micromeritics Service representative.

Cause: The differential pressure system is unable to set the required pressure.

Action: Verify that the waste bottle top is tightly screwed onto the bottle, and 
that the two vacuum lines are securely attached to the fittings on the 
waste bottle top and to the fittings on the side panel of the instrument.

Verify that an orifice tube is securely attached to the orifice tube port, 
and that the orifice is immersed in a beaker of electrolyte.

Restart the operation; if the message persists, contact your Micromer-
itics Service representative.

Cause: The volumetric pump has malfunctioned.

Action: Contact your Micromeritics Service representative.

Cause: A new flow operation was started before the previous operation had 
completed. The previous operation will not be completed.

Action: None required.
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6080- Data Collection: Measured current out of range. Actual: (number) mA  Min: 
(number) mA  Max: (number) mA

6081- Data Collection: Test pulse amplitude out of range. Measured: (number) mA 
Set: (number) mA

6082- Data Collection: Test pulse frequency out of range. Measured: (number) Hz Set: 
(number) Hz

6083- Data Collection: Test pulse width out of range. Measured: (number) microsec-
onds Set: (number) microseconds

6084- Data Collection: Preamp signal out of range. Actual: (number) V  Min: (number) 
V  Max: (number) V

6085- Data Collection: Amplifier signal out of range. Actual: (number) V  Min: (num-
ber) V  Max: (number) V

6086- Data Collection: Log range out of range. Measured: (number) to (number) Set: 
(number) to (number)

6087- Data Collection: Low threshold out of range. Measured: (number) V Set: (num-
ber) V

6088- Data Collection: Failed to automatically clear blockage. The blockage must be 
cleared manually before continuing.

6089- Data Collection: Orifice Conductivity too low. Minimum = (number) S/m, Actual 
= (number) S/m. Orifice Resistance = (number) k ohms.

Cause: An electronic malfunction has occurred.

Action: Contact your Micromeritics Service representative.

Cause: The orifice could not be cleared automatically.

Action: Manually clear the orifice; refer to Clearing Blockages, page 8-11.

Cause A: The orifice may be blocked.

Action A: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 8-11.

Cause B: The orifice tube and internal tubing are not filled with electrolyte, 
therefore electrical contact is not being made.

Action B: Verify that the supply bottle has sufficient electrolyte, then select Unit 
[n] > Flush to flush the orifice tube and internal tubing with electro-
lyte.
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6092- Data Collection: Particle detection rate of (number) particle per second is 
excessive. Data collection is cancelled.

Cause C: The electrolyte conductivity is too low for the size orifice in use.

Action C: Use an electrolyte with higher conductivity; for example, a solution 
with a higher concentration of salt.

Cause A: The doors to the sample compartment are open.

Action A: Securely close the doors to the sample compartment. The doors act as  
shields to prevent outside electronic noise sources from interfering 
with data collection.

Cause B: The orifice is blocked. 

Action B: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 8-11.

Cause C: The signal settings are inappropriate for this orifice tube and electro-
lyte and, therefore, causing electronic noise.

Action C: Click Optimize Settings on the Sample Analysis dialog to automati-
cally determine signal settings that will minimize electronic noise.

Cause D: The particle concentration is too high.

Action D: Reduce the particle concentration by at least a factor of 2, and repeat 
the analysis.
539-42822-01 (Rev A) - Nov 2017                                                 A-33 



Elzone II 5390 Confirm Appendix A
6093- Data Collection: Cannot measure Orifice Conductivity; Conductivity may be too 
high. Maximum Conductivity = (number), minimum Orifice Resistance = 
(number) 

Cause A: The orifice may be blocked.

Action A: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 8-11.

Cause B: The orifice tube and internal tubing are not filled with electrolyte, 
therefore electrical contact is not being made.

Action B: Verify that the supply bottle has sufficient electrolyte, then select Unit 
[n] > Flush to flush the orifice tube and internal tubing with electro-
lyte.

Cause C: The electrolyte conductivity is too high for the size orifice in use.

Action C: Use an electrolyte of lower conductivity; for example, a solution with a 
lower concentration of salt.
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6100 Series

6100- Unable to establish the TCP connection with the instrument.

6101- Configured serial number does not match instrument.

6102-  The instrument (S/N) is not calibrated.

Cause: A communications problem between the computer and the analyzer 
has occurred.

Action A: Check the cable connection between the computer and the analyzer.

Action B: Select Unit [n] > Unit configuration and verify that the TCP/IP con-
figuration for the computer and the analyzer are correct.

Action C: Exit the Elzone application, and turn off the analyzer. Then turn on the 
analyzer and restart the application. If the problem persists, contact 
your local Micromeritics representative.

Cause: The instrument serial number specified for this unit during installation 
does not match the serial number recorded in the attached instrument. 

Action: Attach the correct instrument, or run the Setup program and install the 
calibration files for the correct instrument serial number. The instru-
ment serial number is located on the back panel of the analyzer.

Cause: You attempted to begin an analysis, but the instrument is not fully cal-
ibrated.

Action A: Exit the analysis program and turn off the analyzer. Turn the analyzer 
back on and restart the analysis program. Select Unit configuration 
from the Unit [n] menu to verify that calibrations are installed (cali-
bration items will contain dates). If no information displays for the cal-
ibration items, go to Action B. 

Action B: Contact your Administrator or someone with Administrator rights to 
reinstall the calibration files. 
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6110- An automatic analysis mode is enabled. The sample defaults may not be edited 
while this mode is active.

6111- Orifice tube not calibrated with this instrument. Do you want to proceed with 
analyses anyway?

6112- Backgrounds require full resolution data storage. Do you want to select full 
resolution data storage?

6113- Volumetric flow rate is unavailable. Do you want to use differential flow rate 
instead?

Cause: One of the automatic analysis modes is active. Sample defaults cannot 
be edited while this mode is active.

Action: End all automatic analysis modes on all attached units and try again.

Cause: You selected an orifice tube that has not been calibrated to this instru-
ment.

Action A: Stop the analysis and calibrate the orifice tube.

Action B: Choose a calibration tube that has been calibrated.

Action C: Continue with the analysis, then calibrate the orifice tube after the anal-
ysis. For the sample file used with the analysis, select Data Setup on 
the Collected Data dialog and update the calibration. 

Cause: You attempted to run a background with a file that does not have Full-
resolution selected for the data format.

Action: Full-resolution data are required for a background. Click Yes to have 
the software automatically select this option. Click No to stop the back-
ground analysis.

Cause: You attempted to begin an analysis using a file in which Volumetric 
Flow Rate was selected as the Flow Control but you do not have the 
optional volumetric pump installed.

Action: Click Yes to have the software automatically select the Differential 
Flow Rate option. Select No to stop the analysis and edit the current 
file or choose another one. 
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6114- You chose to use the most recent background but no background is available. 
Choose Yes to proceed without background data.

6115- Background subtraction is selected but no background data is specified. Select 
a data file from the Data Setup dialog if you wish to subtract a background.

6116- Selected orifice tube or liquid is different from last used on this unit. Do you 
want to change the orifice tube or liquid before continuing with the analysis?.

6117- Please raise the beaker stand and press OK to continue, or Cancel.

Cause: You selected Use most recent background on the Data Setup dialog 
(from the Analysis Conditions dialog) but a background has not been 
performed on this instrument for the selected orifice tube and liquid. 

Action: Click Yes to proceed without a background. Then run a background 
after the analysis. Open the sample file and click Data Setup on the 
Collected Data dialog.  From the Data Setup dialog, click Browse and 
choose the background file.

Click No to stop the analysis so that you can run a background, then 
restart the analysis.

Cause: You requested background subtraction but you did not select a back-
ground file.

Action: Click Data Setup, then click Browse to choose a background file, or 
select the Use most recent background option.

Cause: You selected to use an orifice tube or a liquid that is not the same as 
used in the previous analysis (or calibration).

Action: Click Yes to change the orifice tube or liquid. Click No to continue 
with the operation; this is assuming that you have already changed the 
tube or liquid.

Cause: You attempted to start an analysis with the sample stand in the lowered 
position.

Action: Raise the sample stand, then click OK to continue the analysis.
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6118- The entered Minimum Particle Size (number) cannot be measured using the 
calibration selected in Data Setup. A new calibration spanning the desired size 
range is recommended.

6119- The entered Minimum Particle Size (number) requires a log range of (number): 
1 using the calibration selected in Data Setup. A new calibration spanning the 
desired size range is recommended.

6120- Unable to read the calibration file (file name).

6121- Unable to write the calibration file (file name).

Cause: You selected an orifice tube that has not been calibrated to cover the 
specified diameter range.

Action A: Enter a size range that will accommodate the selected orifice tube.

Action B: Recalibrate the orifice tube using reference samples that will cover the 
desired range.

Cause: The particle size range for the current calibration is not consistent with 
the collected data range.

Action A: Perform a calibration using the same range as specified in the message. 
Then click Data Setup on the collected data dialog and update the cal-
ibration.

Action B: Use the existing calibration, in which case interpolation will be used to 
span the collected data range.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no prob-
lems.

Cause: An unexpected error has occurred.

Action: Contact your Micromeritics service representative.
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6130- The calculation could not be performed.

6131- The peak height has not been initialized, and so cannot be used in the fit.

6132- Calibration failed: No SRM selected.

Cause: You requested a calculated peak height on the orifice tube calibration 
review screen and the number of reference materials is greater than the 
number of peaks (see Message 6136).

Action A: Select the peak height manually.

Action B: Make sure the correct sample is in the system, the correct SRM’s are 
selected, and the proper analysis conditions (for the current sample) are 
selected; then try again.

Cause: You requested that a peak be included in the fit but the peak height had 
not been assigned.

Action A: Select and assign the peak height manually.

Action B: Make sure the correct sample is in the system, the correct SRM’s are 
selected, and the proper analysis conditions (for the current sample) are 
selected; then try again.

Cause: No SRMs were selected on the Orifice Tube calibration review screen.

Action: Select one or more SRMs to be included.
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6133- Calibration failed: Fit tolerances exceeded.

6134- Calibration failed: Error in fit too large.

6136- The automatic calibration could not be performed because the number of ref-
erence materials is greater than the number of peaks. All reference materials 
have been removed from the fit.

6151- This sample file was analyzed on a different instrument. Do you want to pro-
ceed anyway?

6161- The sample already contains eight tests and cannot be used for an analysis.

6162- File (file name) cannot be analyzed. It is currently being edited.

Cause: The calibration could not be completed because the line of best fit  (ori-
fice tube calibration review screen) is too far from the measured value.

Action: Make sure the correct sample is in the system, the correct SRMs are 
selected in the Reference Material list, and the proper analysis condi-
tions are specified for this sample.

Cause: You attempted to perform an analysis using a file that has been used for 
an analysis with a different instrument.

Action: Click Yes to continue with the analysis; however, data will be less 
accurate than if the analysis was performed on the same instrument as 
the first analysis. Click No and choose a file containing an orifice that 
was calibrated on the current instrument.

Cause: You selected Start/Continue after a test completed but the current file 
already contains eight tests. 

Action: Delete some of the tests from the file or choose a different file; you can 
only perform eight tests with a file.

Cause: You selected a file that was still open in an editing window for anal-
ysis.

Action: Finish the changes to the sample file, then save and close the editing 
window.
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6163- The current test is complete. Please save or clear the data before starting a 
new test or change Ending Conditions to collect more data.

6165- Please save or clear collected data before starting this operation.

6167- The newly measured conductivity value (number) differs from previous value 
(number)

The first stage of data collection evaluates the conductivity and compares it to 
the previously recorded value for the current orifice tube and the electrolyte 
and the values differ by more than 2%.

Cause: You attempted to begin another test but data for the current test has not 
been saved or cleared.

Action: Clear the data, save the data, or change the ending conditions.

Cause: You attempted to perform an operation but you have collected data that 
have not been saved or cleared.

Action: Save or clear the data before proceeding with the operation.

Cause A: The orifice tube may be blocked.

Action A: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 8-11.

Cause B: Incorrect analysis liquid or improperly prepared liquid.

Action B: Ensure that the correct liquid is in the Supply container, and that it has 
been properly prepared.

Cause C: Air bubbles are in the tubing.

Action C: Select Unit [n] > Flush System to flush electrolyte through the sys-
tem.
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6180- Cannot read the background file (file name).

6181- The background file (file  name) was not analyzed with the same liquid as this 
file.

6182- There is no full-resolution data in the background file (file name).

6183- The orifice ID for (name) does not match the current tube’s ID (name).

6184- The orifice diameter for (file name) (number) does not match the current tube’s 
diameter (number).

Cause: The selected background file is not present or cannot be opened.

Action A: Ensure that the path name is correct.

Action B: Check directory permissions.

Action C: Make sure you have sufficient space on your disk.

Cause: You selected a background that has a different liquid from the one in 
the current file. 

Action: Choose a background that was performed used the same electrolyte as 
the current file.

Cause: You selected a background that does not contain full-resolution data.

Action: Choose a different background file. Do not delete full-resolution data 
from background files.

Cause: You selected Calibration copied from sample (file name) and you 
chose a file for an orifice tube other than the one you are using for the 
current analysis.

Action: Choose a file that contains calibration information for the current tube.
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6185- The calibrations could not be updated. The instrument used for the analysis
(s/n) is not in operation.

6186- Cannot copy calibration from this file. Orifice Tube ID (name) and diameter 
(number) must match the current settings.

6187- Cannot open the data file (file name) for reading.

6188- Cannot create a new test in (file name).

6189- Cannot add a test to (file name)

Cause: You attempted to update calibration information but the instrument 
used in the calibration is not the current instrument.

Action: Update the calibration information using the instrument on which the 
calibration was performed.

Cause: You selected a file that contains calibration parameters for an orifice 
tube other than the current one.  

Action: Choose a file containing calibration information for the current orifice 
tube.

Cause: You attempted to open a data file but were unsuccessful.

Action A: Check directory permissions.

Action B: Make sure the disk is not full.

Cause: An unexpected error occurred.

Action: Contact your Micromeritics Service representative.

Cause: You have saved the maximum number of 8 tests for this file.

Action: Delete unwanted tests, or create a new file.
539-42822-01 (Rev A) - Nov 2017                                                 A-43 



Elzone II 5390 Confirm Appendix A
6190- There is no calibration for the orifice (name) on this instrument.

6191- New minimum particle size range greater than maximum range. Old settings 
restored.

Cause: You attempted to update calibration information for an orifice tube that 
has not been calibrated on this instrument.

Action: Calibrate the orifice tube, then update the calibration using the Data 
Setup push button on the Collected Data dialog.

Cause: You entered a minimum size value that was greater than the maximum 
value.

Action: The minimum value must be less than the maximum value; reenter the 
minimum size.
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6200 Series

6200- The file (file name) does not have background data.

6201- The file (file name) does not have full-resolution data.

6202- Graph is not available. The orifice tube was not calibrated.

6203- No data available in file (file name) for reporting.

6204- The file (file name) does not have pulse length data.

Cause: You selected a background report for a file that contains no background 
data.

Action: Click Data Setup on the Collected Data dialog and select a back-
ground file.

Cause: You selected a pulse length or pulse length vs. particle size report for a 
file that does not contain full-resolution data. This information either 
was not collected or has been deleted.

Action: Before analysis, select Full resolution data on the Data Setup dialog 
(from the Analysis Conditions dialog). Do not delete full-resolution 
data if you wish to produce these type of reports.

Cause: You requested an orifice tube calibration report for an orifice tube that 
has not been calibrated.

Action: Calibrate the orifice tube, then request the report again.

Cause: You requested a report for a file that does not contain collected data.

Action: Use the file in an analysis before requesting reports.

Cause: You requested a pulse length report for a file that contains entered data. 

Action: Choose a report containing full-resolution data; pulse length reports are 
only available for this type of data.
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6205- The file (file name) does not have pulse length vs. particle size data.

6210-  Data sets must be ordered from finest to coarsest.

6211-  Not enough overlap between data sets.

6212-  Channels with no counts were found in the blend range.

6213-  The blend range could not be determined.

Cause: You requested a pulse length vs. particle size report for a file that does 
not contain the required data. You may not have collected this data or 
you may have deleted it.

Action: Before analysis, select Pulse length vs. particle size data on the Data 
Setup dialog (from the Analysis Conditions dialog). Do not delete full-
resolution data if you wish to produce these type of reports.

Cause: You attempted to blend data, but the data sets have not been placed in 
order.

Action: Reselect the files, placing the file with the finest data in field #1.

Cause: The particle size ranges of at least one adjacent pair of data sets do  not 
overlap by at least 10 points.

Action: Choose an additional data set to cover the intermediate sizes.

Cause: You attempted to blend data; however, at least one of the data files does 
not contain size classes in the size range where blending is to be done.

Action: Collect more data or choose an additional data set to cover the blending 
range.

Cause: The slopes of the distributions in the blending range are not compara-
ble for at least one pair of data sets.

Action: Collect more data or choose an additional data set to cover the blending 
range.
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6214-  The noise level or curvature in the blending range is too high.

6230- The reference material ID (name), Lot (number) is already in the list.

6231- Please select at least one reference material.

6232- No more than ten reference materials can be selected.

6233- The reference material is outside valid range for selected orifice tube. Do you 
want to add the reference material to global list only?

Cause: The data in the blending range are not comparable due to excessive 
scatter or high curvature for at least one pair of data sets.

Action: Collect more data or choose an additional data set to cover the blending 
range.

Cause: You attempted to add a reference material that already exists in the list.

Action: Change the identification of the material you are adding so that it does 
not conflict with the one in the list.

Cause: You attempted to start an orifice tube calibration, but no reference 
materials have been selected.

Action: Select the appropriate reference material(s) and try again.

Cause: You attempted to start an orifice tube calibration with more than 10 ref-
erence materials selected.

Action: Select the appropriate reference materials, but no more than 10.

Cause: You attempted to add a reference material that is outside of the range 
for the orifice tube selected for this calibration.

Action: Click Yes to add the reference material to the list. Click No to edit the 
reference material parameters.
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6235- The reference material is out of range of the orifice tube and cannot be used in 
the calibration.

6240- The input file (file name) has too many data points. Only the first (number) lines 
will be converted.

6241- The input file (file name) does not have enough data points. At least two size-
value pairs must be present.

6242- Converting data failed. Check the contents of the input file (file name).

6243- A negative particle size was found in the input file (file name).

Cause: You selected a reference material that is too large or too small for the 
selected orifice tube.

Action: Select the appropriate-sized reference material(s) or orifice tube and 
try again.

Cause: The number of size classes in reduced data is limited to 300;  you  
attempted to convert a file containing more than this number. 

Action: Reduce the number of data points in the file.

Cause: Reduced data must have at least four size classes; you attempted to 
convert a file containing fewer than this number.

Action: Increase the number of data points in the file.

Cause: You attempted to convert an ASCII file but the format is incorrect.

Action: Properly format the ASCII file before converting; refer to Convert, 
page  for the proper format.

Cause: You attempted to convert an ASCII file but one of the particle sizes 
read from the input file is less than zero.

Action: Correct the particle sizes in the input file, then convert the file.
A-48                                                    539-42822-01 (Rev A) - Nov 2017 



Appendix A Elzone II 5390 Confirm
6244- A negative incremental distribution value was found in the input file (file name).

6245- An inappropriate cumulative distribution value was found in the input file (file 
name).

6246- The particle sizes in the file (file name) are not evenly spaced on a linear or log-
arithmic scale.

6247- Particle sizes must be strictly increasing.

6248- File (file name) has an unrecognized type.

Cause: You attempted to convert an ASCII file, but one of the incremental dis-
tribution values in the input file is less than zero.

Action: Correct the distribution values in the input file, then convert the file.

Cause: You attempted to convert an ASCII file, but an increasing cumulative 
coarser, or decreasing cumulative finer distribution value was read 
from the input file.

Action: Ensure that the correct type of cumulative data was specified on the 
conversion dialog box. Correct any inappropriate data point in the 
input file, then convert the file.

Cause: The particle sizes in the input file are irregularly spaced.

Action: Choose regularly spaced particle sizes on either a linear or logarithmic 
basis.

Cause: You attempted to convert an ASCII file, but a particle size was read 
that is less than the previous size.

Action: Edit the input file so that the data points are in ascending order by par-
ticle size, then convert the file.

Cause: The input file does not nave the expected format.

Action: Correct the format of the input file.
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6260- Full-resolution data cannot be exported because the file (file name) does not 
have full-resolution data.

6272- The value of the distribution at the extrapolation point must be less than the 
peak value. The extrapolation calculation was not performed.

6273- The value of the distribution at the extrapolation point must be non-zero. The 
extrapolation calculation was not performed.

Cause: You attempted to export full-resolution data using a file that does not 
contain full-resolution data.

Action: Choose Reduced Data as the Export Type in the export dialog box.

Cause: You specified extrapolation and peak points in that the value of the dis-
tribution is higher at the extrapolation point that at the peak point.

Action: Enter (or select from the graph) an extrapolation point and/or a peak 
point so that the extrapolation value is lower than the peak value.

Cause: You specified an extrapolation point where the distribution is zero (0).

Action: Specify (or select from the graph) an extrapolation point with non-zero 
distribution.
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B.  DATA REDUCTION

Peak Statistics

Four types of statistics are available for reporting:

• Weighted
• Geometric
• Harmonic
• Arithmetic

The following distributions can be reported for Weighted, Geometric, and Harmonic:

• Volume
• Area
• Number
• Mass

The following statistics can be reported for Arithmetic:

• Length
• Surface area
• Volume

Calculations for these statistics use equations 1 through 6. Use the information provided in 
Tables B-1 through B-3 to produce the equation for the desired statistic. An example is given 
at the end of this section.

(1)

(2)

(3)

(4)

xf

f di F i
F i

-----------------------------=

f

f di  xf– 
2

 F i

F i
-----------------------------------------------=

x f
 1–

xf =

 f
 1– f =
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(5)

(6)

where 

di = average particle diameter for size class i

F,i = value of frequency distribution in size class i (number, area, volume, or mass)
xf = mean of transformed size

Table B-1. Statistic Types and Distributions

Table B-2.  Arithmetic Statistics

Statistic f(x)
(function)

f  –1(x)
(inverse function)

Distribution 

Weighted x x Volume v

Geometric log10x 10x Area a

Harmonic 1/x 1/x Number n

Mass m

Statistic f(x)
(function)

f  –1(x)
(inverse function



Length x x n

Surface Area x2 x1/2 n

Volume x3 x1/3 n

s

f di  xf–

f

----------------------
 
 
 

3

 F i

F i
------------------------------------------------=

k

f di  xf–

f

----------------------
 
 
 

4

 F i

F i
------------------------------------------------    3  –=
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Table B-3. Statistics

Example

This example provides the calculations for Harmonic Number Mean.

Substituting equation (8) into equation (3),    =  

Using equations (1) and (7),     

Thus, the Harmonic Number Mean,     

Statistic Formula

Mean x

Standard deviation 

Coefficient of variation x/

Standard deviation of transformed size f

Skewness s

Kurtosis (coefficient of excess) k

+ [n]  size f –1 (xf + nf

– [n]  size f –1 (xf – nf

Variance 2

Harmonic: from Table B-1
(7)

(8)

Number (Distribution): from Table B-1  = n

F,i  Fn,i = incremental number
                    distribution

Mean (Statistic):  from Table B-3 x

f x  1
x
---=

f
 1–

x  1
x
---=

x f
 1–

xf =
1
xf

----

xf

f di Fn i
Fn i

----------------------------   

Fn i

di

---------
Fn i

-----------------==

x
Fn i

Fn i

di

---------

----------------=
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Mass Balance

True and Measured Concentration

The true concentration is calculated from user input. The mass concentration and dilution 
factor are entered on the Sample Information dialog and the sample density on the Materials 
Properties dialog. 

The measured concentration is the total particle volume measured by the instrument, divided 
by the volume of suspension analyzed:

where

Ni = number of particles measured in size channel i

Vi = volume of a particle in size channel i

Kd by Mass Integration

For mass integration, reference material-derived calibration slope and offset are not used. The 
default calibration factor of the orifice tube is used so that the resulting Kd value is not 
dependent on orifice tube calibration by reference materials. 

where

i = volume of a particle in size channel i calculated using default calibration for 

the orifice tube

True Concentration
Mass Concentration

Sample Density Dilution Factor
------------------------------------------------------------------------------------------=

Measured Concentration
Ni Vi

Suspension Volume
----------------------------------------------------=

Kv
True Concentration

Measured Default Concentration
-----------------------------------------------------------------------------------------=

Kd

6Kv


---------- 
 

1
3
---

=

Measured Default Concentration
NiVdefi

Suspension Volume
----------------------------------------------------=

Vdefi
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Fraction of Sample Measured

The Fraction of Sample is selected on the Summary report.

Fraction Sample Measured
Measured Concentration

True Concentration
------------------------------------------------------------------=
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Specification/Reference Quantities

Out of Spec

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Coarse Specification distribution interpolated if the bins are of different size. This is always 
the average of all tests in the named sample file.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
FineSpecification distribution interpolated if the bins are of different size. This is always the 
average of all the tests in the named sample file.

If {SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

   OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFrac

   Coarseri-1

If {SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1}

   OutspecFracCoarseri = SampCumFracCoarser - FineSpecCumFrac

   Coarseri-1

or,

OutSpecFracFineri = -OutSpecFracCoarseri-1

OutSpecFracRetaini = OutSpecFracCoarseri-1

OutSpecFracPassi = OutSpecFracCoarseri-1
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Difference from Reference

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Reference Specification distribution interpolated if the bins are of different size. This is always 
the average of all the tests in the named sample file.

DiffRefCoarseri = SampCumFraci - RefCumFraci

or,

DiffRefFineri = DiffRefCoarseri-1

DiffRefRetaini = DiffRefCoarseri-1

DiffRefPassi = DiffRefCoarseri-1

Maximum Out of Spec

MaxOutSpecFrac = maximum (abs value (OutSpecFraci))

Pass/Fail by Specification

If MaxOutSpecFrac = 0, PassFail = Passed by Specification

Otherwise, PassFail = FAILED by Specification
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SPC Report Variables

Regression Chart

The line of best for the Regression Chart is calculated by the usual least squares method1. If 
there is only a single point, or all N points have the same x-value, there can be no line of best 
fit in the standard form.

The coefficient of correlation for this line also is calculated in the usual way2.

1.  BASIC Scientific Subroutines Vol. 11, Ruckdeschel, F. R., BYTE Publications, McGraw Hill, p 16.

2.  Mathematical Handbook for Scientists and Engineers, Korn, G.A. and Korn, T.M.,  McGraw Hill, Sec. 18.4 
(1968).

XAve
xi

N
---------=

YAve
yi

N
---------=

Slope
 xi  XAve–  yi  YAve 

 xi XAve 2–
--------------------------------------------------------------=

YIntercept YAve Slope XAve–=

x
 xi XAve 2–

N
--------------------------------------=

y
 yi YAve 2

–
N

--------------------------------------=

Cov (x,y) 
 xi XAve  yi YAve ––

N
--------------------------------------------------------------------=
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 Control Chart

CorrelationCoef
Cov x y 

xy
-------------------------=

Mean
yi

N
---------=

StdDev
 yi Mean 2

–
N 1–

--------------------------------------=

CoefVar
StdDev
Mean

-------------------=

PlusNSig Mean n STdDev+=

MinusNSig Mean n StdDev–=
539-42822-01 (Rev A) - Nov 2017                                                     B-9 



Appendix B Elzone II 5390 Confirm
Log Probability Data

Log probability data are a transformation of cumulative mass finer data as a means of 
determining how well cumulative and differential mass data represent statistical log  normal 
distributions. Since cumulative mass finer data are essentially data indicating the probabilities 
of finding particles of mass finer at given diameters, log normal probability data are a fit of the 
cumulative mass data to the defined, symmetrical probabilities tabulated for a log normal 
distribution. 

The log probability table used is a subset of 99 points, ranging from (-2.88, 0.2%) to (0.0, 
50.0%) to (+2.88, 99.8%), from a standard normal distribution table (see Table B-1. Log 
Probability Interpolation on the next page). The x-axis and y-axis data which are plotted on a 
log probability graph are calculated as follows:

1. X-axis boundaries are determined by the spline interpolation at 0.2% and 99.8% from 
cumulative mass finer vs. log diameter. This gives Xprob_beg and Xprob_end, 
respectively.

2. For each of the number of points collected,

If Diameter value is between Xprob_beg and Xprob_end and

if CumMassFiner value is between 0.2% and 99.8%, then

Xprob value = Diameter value

Yprob value = Spline interpolation at CumMassFiner values of the x  vs. y log probability 
table values
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Log Probability Interpolation Table

X (%)    Y X (%)    Y  X (%)   Y

 0.20 -2.88 33.00 -0.44 68.08 0.47

 0.99 -2.33 34.83 -0.39 69.15 0.50

 2.02 -2.05 35.94 -0.36 69.85 0.52

 3.01 -1.88 37.07 -0.33 70.88 0.55

 4.01 -1.75 37.83 -0.31 71.90 0.58

 4.95 -1.65 38.97 -0.28 72.91 0.61

 5.94 -1.56 40.13 -0.25 73.89 0.64

 6.94 -1.48 40.90 -0.23 74.86 0.67

 7.93 -1.41 42.07 -0.20 76.11 0.71

 9.01 -1.34 42.86 -0.18 77.04 0.74

10.03 -1.28 44.04 -0.15 77.94 0.77

10.93 -1.23 44.83 -0.13 79.10 0.81

11.90 -1.18 46.02 -0.10 79.95 0.84

12.92 -1.13 46.81 -0.08 81.06 0.88

14.01 -1.08 48.01 -0.05 82.12 0.92

14.92 -1.04 48.80 -0.03 82.89 0.95

16.11 -0.99 50.00 0.00 83.89 0.99

17.11 -0.95 51.20 0.03 85.08 1.04

17.88 -0.92 51.99 0.05 85.99 1.08

18.94 -0.88 53.19 0.08 87.08 1.13

20.05 -0.84 53.98 0.10 88.10 1.18

20.90 -0.81 55.17 0.13 89.07 1.23

22.06 -0.77 55.96 0.15 89.97 1.28

22.96 -0.74 57.14 0.18 90.99 1.34

23.89 0.71 57.93 0.20 92.07 1.41

25.14 -0.67 59.10 0.23 93.06 1.48

26.11 -0.64 59.87 0.25 94.06 1.56

27.09 -0.61 61.03 0.28 95.05 1.65

28.10 -0.58 62.17 0.31 95.99 1.75

29.12 -0.55 62.93 0.33 96.99 1.88

30.15 -0.52 64.06 0.36 97.98 2.05

30.85 -0.50 65.17 0.39 99.01 2.33

31.92 -0.47 67.00 0.44 99.80 2.88
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C.  FORMAT OF EXPORTED DATA

This appendix gives the format for sample files exported in ASCII text. All character 
strings are delimited with quotation marks; columns are separated with a comma and 
white space.

The following types of data can be exported:

• Reduced data
• Full-resolution data

Reduced Data

Information Conveyed Form

File identification quoted string
Material identification quoted string
Material density floating point
Liquid identification quoted string
Liquid viscosity floating point

Particle Size Data
Number of tests, including average if selected (following 
reported for each test)

integer

Test: [n]     (n = 1, 2, ..... , Average) quoted string
Date and time quoted strings
Current floating point*
Gain floating point*
Orifice Kd floating point*
Ending condition integer

0 = total count
1 = modal count
2 = volume
3 = time

floating point*

Mean particle size floating point
Median particle size floating point
Modal particle size floating point
Number of size class boundaries (following reported for each) integer

Particle size floating point
Value (number, surface area, volume or mass) in class floating point

*Reported for average test only if the values for all tests are the 
 same; otherwise the string “Settings Vary” is displayed.

Pulse Length Data
Number of tests (following reported for each test) integer

Test: [n] quoted string
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Full-Resolution Data

Date and time quoted strings
Number of length class boundaries (following reported for each) integer

Particle length floating point
Number of particles in class integer

Information Conveyed Form

File identification quoted string
Material identification quoted string
Material density floating point
Liquid identification quoted string
Liquid viscosity floating point

Particle Size Data
Number of tests (following reported for each test) integer

Test: [n] quoted string
Date and time quoted strings
Current floating point
Gain floating point
Conductivity floating point
Linear instrument calibration coefficients 3 floating points
Number of logarithmic calibration points (following reported
for each point)

integer

Measured voltage floating point
Normalized voltage floating point

Orifice Kd value floating point
Number of calibration coefficients (following reported
for each coefficient)

integer

Order integer
Coefficient floating point

Number of channels (following reported for each channel) integer
Particle size floating point
Number of particles in channel integer

Pulse Length Data
Number of tests (following reported for each test) integer

Test: [n] quoted string
Date and time quoted strings
Flow rate floating point
Orifice diameter floating point
Effective orifice length floating point
Number of channels (following reported for each channel) integer

Particle size floating point
Number of particles in channel integer
C-2                                                    5539-42822-01 (Rev A) - Nov 2017 



Appendix C Elzone II 5390 Confirm
Particle Shape Data

Number of tests (following reported for each test) integer
Test: [n] quoted string
Date and time quoted strings
Number of size classes integer
Number of length classes (following reported for each 
combination of length and size class)

integer

Particle length floating point
Particle size floating point
Number of particles in class integer
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D.  ELECTROLYTES

This appendix contains a discussion on electrolytes and how to prepare them for analysis.

Overview

The Elzone II 5390 analyzes samples based on the electrical sensing zone method. This 
method requires an electrolyte with suitable electrical conductivity and with physico-
chemical neutrality toward the sample particles; i.e. it must not cause them to dissolve, 
react, agglomerate, disintegrate, shrink, or swell. There are extensive listings of materials 
vs. electrolytes, but consulting one* is usually unnecessary since virtually all materials 
have more than one satisfactory electrolyte. 

The practical range for electrolyte conductivity is from 4 to 100 m-mho/cm which corre-
sponds to approximately 0.2 to 5% NaCl by weight in water. Tubes with smaller orifices 
require a higher conductivity than those with large orifices. For example, a tube with a 30-
micrometer orifice optimally requires an electrolyte conductivity of about 45 m-mho/cm, 
corresponding to 2.25% NaCl in water, while a conductivity of 9 m-mho/cm, correspond-
ing to 0.45% NaCl in water, is adequate for a tube with a 300-micrometer orifice.

When a material is found to be slightly soluble in an electrolyte, an appropriate procedure 
is to (1) saturate the electrolyte with particles of the material, (2) filter the electrolyte and 
remove undissolved particles, and (3) use the filtered electrolyte and new particles for size 
analysis. Micromeritics has a unit called the ElectroPrep which has been specifically 
designed for filtering electrolyte. Refer to ElectroPrep on page D-5 for a description.

Types of Electrolytes

Electrolytes are conveniently classified into these groups: aqueous, organic, and modified 
organic.

Aqueous

Aqueous electrolytes are safe, economical, and easy to handle and, therefore, are the 
choice whenever possible. Their pH, wetting ability, and ion type sometimes require con-
sideration. Moderately basic solutions, like those of the alkali phosphates, generally favor 
suspension stability and provide good wetting action for most non-biological materials. 
Typically a 4% solution by weight of sodium pyrophosphate provides good dispersing and 
wetting, but sometimes sodium hexa-meta-phospohate is preferable. An acid or neutral 
electrolyte is required when a material undergoes some dissolution and instability at pH 
values well above eight. A wetting agent or dispersant is required when an acid condition 
does not give a satisfactory dispersion.

*ISO 13319, “Determination of Particle Size Distributions - Electrical Sensing Zone Method” (2000).
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Wetting and dispersion are highly variable matters associated with the physical chemistry 
of particle surfaces that can range from tens of square centimeters to hundreds of square 
meters per gram. Nevertheless, only a few drops of a liquid dispersant or a few grains of a 
solid one are needed. The dispersant preferably should be added directly to the sample and 
the  sample then added to the electrolyte. Ordinary household or laboratory detergents 
very frequently are satisfactory. As a further source, however, Table D-1 lists commercial 
detergents and some specific materials for which they have been found valuable.

When the particles are already in some effective electrolyte such as sea water, plating 
solution, beer, crystallizer liquor, or when the particles are biological cells requiring iso-
tonic salinity (physiologically “normal” saline ) to avoid swelling, shrinkage, or other 
damage, the choices become limited. In the first case, it probably will be necessary to 
dilute with particle-free water. In the second case, the demand from hematology laborato-
ries has resulted in the ready availability of isotonic saline from laboratory supply houses. 
Formulations vary slightly, but all include mono- and di-basic phosphate buffered to pH 
7.4 with an osmolality  of 335-345 m-osmos. Some are filtered down to 3 micrometers and 
others to 1 micrometer.

Organic

Organic electrolytes are needed for water-soluble materials (including most salts and sug-
ars), many esters and foodstuffs, and for other materials already suspended in media that 
are immiscible with water. For these, polar organic liquids having dielectric constants of 
10 or more, with readily ionized compounds such as lithium chloride, ammonium thiocya-
nate, or ammonium perchlorate, form a useful group of electrolytes. Very useful organic 
media include alcohols and ketones having from one to four carbon atoms. Amides and 
esters are good for some samples. Often, when some other water-immiscible media is 
involved, a polar liquid alone will not form a single liquid phase or the material may be 
somewhat soluble in it. In these cases, chlorinated hydrocarbons, tetrahydrofuran, and ali-
phatic and aromatic hydrocarbons may be used for the suppression of particle solubility. 
Be sure to handle organics carefully and in a well-ventilated area. 

Adequate ventilation and handling precautions must be observed when working 
with organic media.
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Modified Organic

The dispersant Niaproof 4 (See Table D-1), undiluted, is an acceptable electrolyte for 
especially difficult materials such as Teflon®, chocolates, paints, liquid toners, and 
complex hydraulic and lubricating oils. However, after particles are dispersed in it, they 
then frequently can be mixed in other liquids, including sometimes, plain water, and 
analyzed. The dispersant apparently clings to the particles allowing sufficient time for a 
good analysis. 

Table D-1. Special Dispersants and Primary Applications

Niaproof 4 is a strong irritant. Use rubber gloves and goggles when handling this 
product and ensure that adequate ventilation is present.

Dispersant Manufacturer Application Class

Triton X-100 Rohm and Haas
Philadelphia, Pa

General purpose, often first to be tried for an 
unknown

Non-ionic

Niaproof 4 Niacet Corporation
Niagara Falls, NY

Quite effective for materials of (-) charge, e.g., 
polyfluorocarbons. Irritant.

Anionic

Lomar PW Diamond Shamrock
Dallas, TX

Carbon, coal, coke, charcoal Anionic

Sulframin Purex Company 
Chicago, IL

Carbides, polymers, oil shale, stearates Anionic

Daxad 23 W.R. Grace 
Lexington, MA

Metals and metal oxides Anionic

Variquat 
(50-MC) 

Sherex Chemical
Dublin, OH

Quite effective for materials of (+) charge, e.g., 
cationic exchange resin 

Cationic

Tween 20 ICI Americas, Inc.
Wilminton, DE 

Polystyrene and similar polymers Non-ionic

For additional information, see McCutchen’s Emulsifiers and Detergents, McCutchen Publishing 
Company, Glen Rock, NJ
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Preparation of Electrolyte Solutions

Choosing the composition of and preparing an electrolyte for frequently used materials are 
relatively straightforward, while for unknowns it most likely will involve some trial and 
error. Most often satisfactory electrolytes can be prepared from distilled water or anhy-
drous organic liquids using technical grade salts. Electrolytes must be virtually free of par-
ticles for best results, or at least free of particles above the threshold intended to be used in 
any analysis.

Filter cartridges of the high area type provide the best filtration and the easiest handling. 
Only a small liquid head and no pumping or pressurizing is required. Filtering rates of 100 
mL/min can be achieved with 0.2-micrometer (sterile) filters and greater rates for larger 
pore filters. One filter can process many hundreds of liters. Some users prefer to process 
only enough electrolyte for one day's operation to avoid contamination problems. This 
electrolyte should be held at the same temperature as the area of the analytical instrument 
and its container should remain sealed except when actually being poured from. 

Only testing for stability with an actual sample of the material in question can prove ade-
quacy. If dissolving, crystallizing, or agglomeration occurs over time, a different composi-
tion obviously is required. Small changes indicative of dissolving usually can be corrected 
by pre-saturating the electrolyte.

The instructions given below are for one type of filtering devices available. The one in 
your lab may be of a different design and, therefore, will function differently. The impor-
tant thing to remember is that you must use a 0.2-m (or lower) filter. 

1. Remove the upper container and rinse with a small amount of electrolyte.

Upper container

Filter section

Lower container
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2. Clean the lower container:

a. Rinse the lower container with a small amount of electrolyte, then replace the 
upper container.

b. Pour electrolyte into the upper container until it is approximately one-half full; 
allow the electrolyte to filter through to the lower container.

c. Remove the upper container.

d. Swish the electrolyte around in the lower container, then discard the electrolyte.

e. Replace the upper container.

f. Repeat steps b through e two more times.

3. Fill the upper container with electrolyte; allow it to filter through into the lower 
container.

4. Remove the upper container, then pour the electrolyte into the supply bottle.

5. Repeat steps 3 and 4 until the supply bottle is filled.

Be sure to read about the ElectroPrep in the next section. The ElectroPrep automates the 
filtering process, providing a continuous supply of electrolyte.

ElectroPrep

The ElectroPrep is designed to recirculate electrolyte through a filter cartridge that retains 
particles greater than 0.1- to 0.2-micrometers in diameter. The electrolyte is contained in a 
reservoir, providing a supply of clean electrolyte at all times. 

For electrolytes in which sample particles readily disperse (e.g., alumina in saline water) 
without having to add a dispersing agent, the waste liquid can simply be poured back into 
the reservoir and used again and again. In typical usage under this circumstance, one prep-
aration of electrolyte will last several months before the filter cartridge has to be replaced. 
This is also true with saturated electrolytes.

Waste liquid cannot be recycled when the sample material requires a special dispersing 
agent because placing it back into the electrolyte would change the electrolyte 
composition. The ElectroPrep is still useful in these situations by affording a ready source 
of clean electrolyte to fill instrument sample beakers and supply containers. The 
ElectroPrep can be employed with either aqueous or organic electrolytes by selecting the 
appropriate cartridge. Refer to Ordering Information, page 9-1 for information on 
ordering the ElectroPrep, or contact your local sales representative.
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E.  THEORY OF OPERATION

The Elzone II 5390 is based on the electrical sensing zone method — also known as the 
Coulter principle. The sample material is prepared and placed into a beaker containing 
electrolytic liquid of high electrical conductance in which the particles are suspended. The 
suspension is caused to move through an orifice (electrical sensing zone) separating a pos-
itive and negative electrode between which a current and a corresponding difference of 
potential are established. Almost all of the applied voltage is dropped along the interior of 
the orifice as a result of its extremely small cross-section as compared to that of the bulk 
liquid on either side of the orifice.

As a particle passes through the orifice with the carrier liquid, it displaces some of the con-
ducting fluid. This generates an electrical signal that is proportional in amplitude to the 
change in electrical conductivity through the orifice channel; the less-conductive particle 
displaces its own volume of conductive liquid and causes an increase in the electrical 
resistance of the orifice channel. The electrical signal produced, therefore, is proportional 
to the volume of the particle. The length of the pulse is related to the shape of the particle 
in that particles of a given mass and composition but with one or two significantly differ-
ing dimensions may take longer to transit the orifice passage than an otherwise identical 
particle having all three dimensions equal. Obviously, a sphere will produce the shortest 
possible pulse while rod-shaped particles can maximally extend the duration of the pulse. 
Some complications exist in interpretation of this pulse width data because particles trav-
eling close to the orifice walls are embedded in slower moving liquid than those in the 
center of the orifice. Those slower moving particles near the walls produce longer electri-
cal pulses than those in the center even if all the particles involved are identical.

The descriptive equation for the change in orifice resistance caused by a particle in the ori-
fice is:

where:

R = change in resistance caused by the particle in the orifice
 = electrolyte resistivity
V  = volume of the particle
A = orifice area normal to the axis
 = effective resistivity of the particle
a = cross-sectional area of the particle normal to the orifice axis

Note that the orifice channel length does not appear in the equation. The effect of longer 
orifices is two-fold:

1. The pulse width of the signal increases and improves the ability to detect and measure 
the particle, and
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2. At a given concentration, a longer channel length increases the probability that more 
than one particle (coincidence) will be in the orifice at the same time, thus producing 
an erroneous signal. The probability of coincidence can be reduced to its original 
value by diluting particle concentration, but this results in longer analysis times. The 
additional analysis time is proportional to the amount of dilution, and both are 
proportional to the amount that the orifice length was increased.

These contrary effects are commonly encountered in information theory applications 
where one must make trade-offs between speed, precision, accuracy, and error rate.

Particles arrive at the entrance of the orifice in a random manner at a rate that depends 
upon their concentration. Therefore, measuring the maximum number of particles per unit 
of time by increasing the sample concentration, the more likely it is that two or more 
closely spaced particles will merge to create a combined pulse. This pulse falsely indicates 
a single particle of volume exceeding that of either particle alone. This combination may 
indicate a particle volume that exceeds that of any particle that is actually present in the 
sample. The general effect of such combined signals is to spread the particle size spectrum 
upward toward larger sizes and to under-represent the amount of particle volume present 
at the lower sizes.

In addition to these fully merged coincidence events, there also exists a partial coincidence 
or near coincidence. Partial coincidence creates signals that can be mistaken for elongated 
particles or which may be too difficult to interpret. Near coincidence signals are those 
which involve a second pulse which occurs while the signal processing circuit has not yet 
completed the processing of a slightly earlier pulse. The system typically does not detect 
pulses which follow another pulse too closely. The coincidence correction feature in the 
Elzone application enables you to compensate for the effects of full, partial, and near 
coincidences.
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F.  CONCENTRATION ANALYSES

Concentration analyses are performed when you need to determine the concentration of 
particles within your sample.

Standard Analysis

Creating the Sample File

These instructions are given for the Developer’s (Advanced) format. If an Analyst is to 
create the file, appropriate templates will have to be created by the Developer.

1. Select File > New > Sample Information; the Create a Sample File dialog 
containing templates is displayed.

2. Choose a template, the click Create; the Sample Information dialog is displayed.

3. On the Sample Information dialog:

a. Enter an appropriate description in the Sample field.

b. Ensure that Automatically collected is selected as the type of data.

c. Enter the dilution factor for the sample you are analyzing. Refer to Preparing  
the Sample on the next page for determining this value.

d. Enter information in any other fields as desired (Operator, Submitter, etc.).

4. Click the Analysis Conditions tab, then:

a. Click the down arrow to the right of the Orifice Tube field and choose the orifice 
tube you plan to use.

b. Select Specify Diameter range, then enter a range in the Minimum and 
Maximum fields. 

c. Click Flow Control to display the Flow Control dialog. Select Volumetric Flow 
Rate and enter the appropriate flow rate for the orifice tube being used. (Refer to 
Table 3-1. Particle Concentration Guidelines, page 3-33 for guidelines.) Click 
OK to return to the Analysis Conditions dialog.

You must have the volumetric pump installed to perform concentration analyses.
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d. Click Data Setup; select or enter the following:

Full-resolution as the Data Format
Logarithmic in Diameter
Class range typically for concentration analyses is the same range as specified for 
diameter range

e. Select Volume as the ending condition and enter the volume of electrolyte for the 
analysis in the adjacent field; 4 mL is the maximum amount allowed. Smaller 
orifice sizes use less than 1 mL because there is a greater chance of blockages 
occurring.

f. Enter appropriate values for other fields (size range, stirrer speed, etc.).

5. Click the Material Properties tab; select the sample material and the electrolyte 
being used.

6. Click the Report Options tab; select (precede with a check mark):

Inc. Number/mL% vs. Diameter Graph
Summary; click Edit and ensure that Total Number and Volume-Specific Number 
are selected.

7. Click Save; the Save as Sample Information dialog is displayed.

8. Enter a comment in the Comments window, then click Save; the Sample 
Information file is displayed. Click Close to close the dialog.

Preparing the Sample

Your sample concentration should be at or below the amount specified in Table 3-1. 
Particle Concentration Guidelines, page 3-33 for the orifice tube you are using. 

1. Measure a volume of sample and place it into the sample beaker. Record the volume 
as SV (in mL).

2. Measure a volume of electrolyte. Record the volume of EV (in mL).

3. Calculate the dilution factor using the following formula:

If you entered a dilution factor in the file you created, you can edit this value when 
you begin the analysis or after the analysis.

DF
SV  EV+

SV
------------------------=
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Example: Use a 150-mL beaker filled with 120 mL electrolyte and a sample volume 
of 2 mL.

Performing the Analysis

1. Install the orifice tube onto the sample port (refer to Choosing and installing an 
Orifice tube, page 3-26).

2. Ensure that the appropriate electrolyte is connected to the Supply port.

3. Clean the outside of orifice tube, stirrer, and electrode with filtered electrolyte.

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Place (or hold) a beaker under the glassware and, using the squeeze bottle, 
thoroughly rinse each piece of glassware; then remove the beaker.

4. Place the analysis beaker containing your prepared sample on the sample stand; 
position the electrode next to the orifice tube so that it will be submerged in the 
beaker. 

5. Raise the sample stand.

DF
 2  120+

2
--------------------- 

122
2

---------  61 ===

Squeeze Bottle

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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6. Select Unit [n] > Fill System to fill the orifice tube.

7. Adjust and focus the camera if needed (if using the camera).

8. Select Unit [n] > Sample Analysis to display the analysis screen. Click Browse and 
choose the sample file you created. Edit the dilution factor to show the value obtained 
when preparing your sample.

9. Click Next, the User Log in dialog is displayed.

10. Enter your password, then click OK and start the analysis.

11. After the analysis is finished, save the data and print the report.
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Background-Subtraction Analysis

Occasionally, the ratio between contaminates in the electrolyte and particles in a sample 
can be low and, therefore, difficult to tell the difference between the two. When 
performing an analysis, the desired ratio between sample particles and contamination 
(sometimes called signal-to-noise ratio) in the electrolyte is approximately 99:1 in 1 mL 
of electrolyte. In other words, for every 99 sample particles, there should be no more than 
1 particle of contamination in the electrolyte.

When the signal-to-noise ratio drops below an unacceptable level, a procedure can be 
performed to remove the presence of contaminates in the electrolyte from the analysis 
data. 

Creating the Sample File

1. Select File > New > Sample Information; the Create a Sample File dialog 
containing templates is displayed.

2. Choose an appropriate template, then click Create; the Sample Information dialog is 
displayed.

3. On the Sample Information dialog:

a. Enter an appropriate description in the Sample field.

b. Select Background as the type of data.

c. Enter a dilution factor of 1.00.

d. Enter information in any other fields as desired (Operator, Submitter, etc.).

4. Click the Analysis Conditions tab, then:

a. Click the down arrow to the right of the Orifice Tube field and choose the orifice 
tube you plan to use.

b. Select Specify Diameter range, then enter a range in the Minimum and 
Maximum fields. 

c. Click Flow Control to display the Flow Control dialog. Select Volumetric Flow 
Rate and enter the appropriate flow rate for the orifice tube being used. (Refer to 
Table 3-1. Particle Concentration Guidelines, page 3-33 for guidelines.) Click 
OK to return to the Analysis Conditions dialog.
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d. Click Data Setup; select or enter the following:

Full-resolution as the Data Format
Logarithmic in Diameter
Class range typically for concentration analyses is the same range as specified for 
diameter range.

e. Enter appropriate values for other fields (size range, stirrer speed, etc.).

5. Click the Material Properties tab; select the electrolyte being used. The sample 
material selected is irrelevant since only the electrolyte is being used for the 
background. However, many Elzone users make an entry in the Sample Material list 
relevant to the background. For example, you may wish to use “Background 
particles.”  This is more relevant on the Background report.

6. Click the Report Options tab; select (precede with a check mark):

Inc. Number/mL% vs. Diameter Graph
Summary; click Edit and ensure that Total Number and Volume-Specific Number 
are selected.

7. Click Save; the Save as Sample Information dialog is displayed.

8. Enter a comment in the Comments window, then click Save; the Sample 
Information file is displayed. Click Close to close the dialog.
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Performing the Background Analysis

1. Install the orifice tube onto the sample port (refer to Choosing and installing an 
Orifice tube, page 3-26).

2. Ensure that the appropriate electrolyte is connected to the Supply port.

3. Clean the outside of orifice tube, stirrer, and electrode with filtered electrolyte.

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Place (or hold) a beaker under the glassware. Use the squeeze bottle to 
thoroughly rinse each piece of glassware, then remove the beaker.

4. Fill the analysis beaker with electrolyte (no sample) and place it on the sample stand; 
position the electrode next to the orifice tube so that it will be submerged in the 
beaker. 

5. Raise the sample stand.

6. Select Unit [n] > Fill System to fill the orifice tube.

7. Adjust and focus the camera if needed (if using the camera).

8. Select Unit [n] > Sample Analysis to display the analysis screen. Click Browse and 
choose the sample file you created.

9. Click Next, the User Log in dialog is displayed.

Squeeze Bottle

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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10. Enter your password, then click OK and start the analysis.

11. After the analysis is finished, save the background data.

Performing the Sample Analysis

Now that you have established a background, you can perform your sample analysis and 
have the background subtracted from the analysis.

1. Create a sample file for the sample analysis:

a. Select File > New > Sample Information; the Create a Sample File dialog 
containing templates is displayed.

b. Choose an appropriate template, then click Create; the Sample Information 
dialog is displayed.

c. Click Replace All and select the file you used for the background analysis.

d. Change the type of data to Automatically collected.

e. Click the Analysis Conditions tab. Click Data Setup and select Use most recent 
background. Then click OK to return to the Analysis Conditions dialog.

f. Click Save, then Close.

2. Perform steps 3 through 11 in Performing the Analysis, page F-3.
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G.  CAMERA OPTION

This appendix contains installation and operating instructions for the camera used with the 
Elzone II analyzer. 

The camera option kit includes the following:

• Camera assembly
• Light assembly
• USB cable

Description

The camera is installed on the front panel of the Elzone II analyzer, enabling you to:

• view particle activity in the orifice
• detect blockages in the orifice
• check the orifice jewel for cracking
• check the orifice for particle build-up

The camera software contains many features for manipulating images; however, this 
appendix provides information only on the ones directly related to the Elzone application. 
Refer to the help system in the camera software for assistance on other features.

Camera 
assembly
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Installation

This section will explain how to install the:

• camera assembly
• light assembly
• camera software

Camera Assembly

Install the camera assembly as follows:

1. Using a flat-head screwdriver (or your fingers), unscrew the four captive screws; then 
remove the plate from the left front panel.

2. Insert the cord of the camera assembly into the opening. Ensure that the focusing 
knobs of the assembly are facing outward. The cord should be secured with a twist tie 
making it easier to place inside the compartment. Be sure at least 12 to 14 inches (30 
to 36 cm) are free from the twist tie.

If your Elzone was ordered with a camera option installed, advance to Light 
Assembly and continue with installation of the light assembly.

Captive screws 
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3. With a Phillips-head screwdriver, secure the assembly into position using the four 
captive screws on the assembly.

4. Using a Phillips-head screwdriver, unscrew the retaining screws on the rear panel; 
then remove the panel. 

Tighten these 
screws securely.

Remove these screws, 
then remove the panel.
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5. Locate the camera assembly cord you inserted earlier. Plug the cord into its USB 
connector. The guide should be facing upward and the connector slot downward.

6. Replace the rear panel, then connect the USB cable to the connector labeled Camera 
USB on the rear panel of the analyzer. Do not plug the other end of the USB cable 
into the computer until instructed to do so (during installation of the camera 
software).

USB connector

USB guide

Slot for connector

Camera USB 
port
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Light Assembly

1. Remove the external electrode and the stirrer for easy access to the connector for the 
orifice light cable.

2. Connect the orifice light cable to the connector inside the top panel of the sample 
compartment.

3. Using a Phillips-head screwdriver, remove the mounting screw on the back panel of 
the sample compartment. 

4. Insert the screw through the retaining clip, then back into the hole on the back panel 
of the sample compartment; tighten with a Phillips-head screwdriver. 

Orifice Light Cable 
Connector

Retaining Clip
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Camera Software

1. If the camera software was not installed with the Elzone software, insert the Elzone 
installation CD and browse to the Camera folder then launch the camera Setup 
program.

2. Follow the instructions displayed on the screen to install the software. After the 
software installation is complete, your computer will restart. Do not remove the 
camera software CD from the CD drive.

3. After your computer restarts, a window instructing you to insert the camera cable 
(from the analyzer) into the computer is displayed.

4. Insert the cable as instructed, then remove the camera software CD and store in a 
secure location.

Be sure to close all programs before installing the camera software. Your 
computer will restart automatically after software installation.
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Operation

This section will explain how to:

• start and use the software
• adjust the orifice light
• focus the image

Before starting the camera software, perform the following steps:

1. Reinstall the external electrode and the stirrer.

2. Install an orifice tube on the sample port of the analyzer. Use a tube with the largest 
orifice size you have available. A larger orifice is easier to focus and view on the 
screen.

3. Place a beaker of electrolyte on the sample stand; raise the stand.

4. Select Unit > Fill System to fill the orifice tube with electrolyte.

Now you are ready to start the camera software.

Starting the Camera Software

• Click the camera icon (AMCap) installed in the Windows Start menu or double click the 
application file installed in the Windows folder (typically this is C:\WIn-
dows\AMCap.exe). 

• If multiple Elzone cameras are installed, select the preferred camera from the Devices 
menu.

• To capture video, select a location to store the captured video file using File > Set Cap-
ture File... then start the capture using Capture > Start Capture and click OK in the 
Ready to Capture window. When the capture is complete, go to Capture > Stop Cap-
ture.

• Zoom, brightness, and contrast can be set in Options > Video Capture Filter > Prop-
erties.
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Adjusting the Orifice Light

Be sure the sample stand is raised (as instructed earlier at the beginning of the Operation 
section) and the camera software is operating.

1. Close the right door of the sample compartment (the one containing the reflector).

2. While observing the image on the screen, adjust the orifice light cable so that the light 
shines onto the middle of the reflector on the sample compartment door.

An image should display in the QuickCapture window of the camera software. If an 
image does not display, you will be able to adjust it to display when you are focusing 
the image (next section).
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Focusing the Image

Follow these guidelines to obtain a clear image of the orifice on the computer screen:

• Make sure the orifice is aligned with the camera lens.

• Be sure the orifice tube is not too close to the beaker. There should be 
approximately 1/2 to 1 inch (12.7 to 25.4 mm) between the orifice tube and the 
inside of the beaker.

• Position the orifice light approximately an inch (25.4 mm) away from the reflector 
so that it shines into the middle of the reflector. 

• Use the focusing ring and horizontal and vertical knobs to adjust the image 
(described below)

Allow 1/2 to 1 inch 
between orifice 
tube and beaker

Align orifice 
with lens

Position 
light to 
shine in 
the mid-
dle of the 
reflector
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1. Turn the focal ring fully clockwise (to the right), then slowly turn it counterclockwise 
(to the left) until a clear image displays on the computer screen.

2. After you obtain a clear image, use the knobs on the left side of the camera to adjust 
the position of the image. The knob on the top adjusts the image right to left. The 
lower knob adjusts the image up and down. 

You can also use the zoom and pan controls in the camera software for adjusting the 
position.

Focal Ring

Adjusts the image 
right to left.

Adjusts the image 
up and down.

You may also need to adjust the position of the orifice light to obtain the best 
results.
G-10                                                    539-42822-01 (Rev A) - Nov 2017 



Elzone II 5390 Confirm Appendix H
H.  OPTIMUM PERFORMANCE FOR STRAY PARTICLE 
COUNT AND NOISE

Some Elzone users have applications which require minimum stray or particle counts, or 
are prone to their appearance. These unexpected pulses, counted as particles, can result 
from:

• particle contamination in the sample or electrolyte

• electrical noise that simulates particle passage pulses

• vibration or acoustic waves that produce electrical signals which simulate particle 
pulses in the same manner as a microphone 

Removal or minimization of these sources of stray particle pulses mean improved 
performance.

Using the guidelines provided in this appendix and appropriate cleaning procedures, reli-
able particle size analyses can be obtained with low-conductivity, high-viscosity 
electrolytes, small orifice tubes, and other noise-sensitive operating conditions.  

Contamination

If the source is contamination in the sample or electrolyte, additional cleaning or filtering 
of the electrolyte is required. Most “stray” particles detected during background or sam-
ple analyses, especially those of a size greater than 3 or 4 % of the orifice diameter, are 
usually the result of true particle contamination. Be sure that the orifice tube, stirrer pad-
dle or hydropulser tube, and electrode are completely clean and free of particles.

Electrical Noise

Electrical noise usually results from sources external to the Elzone. There are numerous 
noise filters and electrical isolation circuits that, when operating properly, suppress inter-
nal sources of electrical noise. External sources may be in the form of radio frequency 
fields, such as those from fluorescent lights, radio stations, or power-switching transients. 
The doors that enclose the Elzone sample compartment contain a wire mesh shield that 
stops almost all external radio frequency noise when closed, which should always be the 
case during analysis. The input power supply also contains electrical filters that remove 
normal power-line noise. Power sources to which high current or inductive devices, such 
as heaters or large AC motors, are connected should not be used to power the Elzone. 
Unusually noisy circuits such as this may degrade analysis results.
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Vibration and Acoustic Noise

Vibration and acoustic noise produce electrical signals much like those produced by a 
microphone. This usually results from the combination of a small orifice in the sample 
tube and a viscous electrolyte solution. As the size of the orifice decreases, the voltage 
drop across the orifice during operation increases. The higher the voltage, the more sus-
ceptible the system is to microphonic pulses. These pulses may be due to vibrations 
transmitted into the beaker of electrolyte through the hardware of the instrument, created 
by the vacuum pump, cooling fan, stirrer, or transformed from air-borne acoustic waves. 

In addition, as the conductivity of the electrolyte decreases, the voltage drop across the 
orifice increases, again resulting in greater susceptibility to vibration and acoustic stimuli.  
Other operational factors that increase the sensitivity to these vibration sources are 
increased viscosity or a very slow flow of the electrolyte through the orifice.

Improved Performance

The Elzone includes several features which help to control the occurrence of stray parti-
cle counts.

Software

The Elzone software contains certain analysis parameters that can be selected to help 
minimize background counts. 

Optimize Settings

Generally, the current should be set as high as possible. The amplifier gain settings  
should be chosen to cover the desired particle size range. If the current is set too high, the 
electrolyte may heat in the orifice enough to form air or vapor bubbles, which are 
detected as particles. If the gain is set too high (to compensate for too low of a current 
choice), noise inherent to the electronics is amplified and also detected as particles.This 
noise results from Brownian motion of the ions in the electrolyte.
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An option to optimize instrument settings to your electrolyte (current/gain settings) has 
been included in the software and is located on the second view of the Analysis dialog. 
Refer to Optimizing Instrument Settings, page 3-31for step-by-step instructions.

After you optimize the settings, run a background to verify that the settings are accept-
able. If the “particle” count is too high, click Instrument Setup to adjust the current/gain. 
Remember the guidelines given earlier when making the adjustment. 

Click this push button 
to have the software 
optimize current/gain 
settings automatically.

Adjust the values in these fields 
to further optimize instrument 
settings.

Deselect this option not to have 
the values in these fields adjust 
automatically.
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Pump/Fan Off During Data Collection

The vacuum pump used to drive the electrolyte flow and the fan used to cool the elec-
tronics of the Elzone produce internal vibrations which may be detected when using low-
conductivity electrolytes of high viscosity with small orifice tubes. These two compo-
nents can be programmed to be turned off automatically during data collection (if needed) 
to remove these internal vibration sources. This option can be selected on the Flow Con-
trol dialog which can be accessed in the sample file (analysis conditions) or on the second 
view of the Analysis dialog using the Instrument Setup push button. .

The pump and fan can also be turned on and off using the instrument schematic. Refer to 
Enable Manual Control, page 5-36 for additional information.

Stirrers

The Elzone accessories include two stirrer paddles. The larger one can be used at slower 
stirrer speeds to reduce vibrations of the electrolyte that may produce unwanted signals in 
low-conductivity, high-viscosity electrolyte systems used with small orifice tubes. Setting 
the stirrer so that the liquid is lifted (“up” direction), the larger stirrer paddle can still lift 
most samples at a lower speed setting than is needed when using the smaller paddle.

The Elzone software enables you to set the stirrer speed and direction. This option is 
located on the Analysis Conditions dialog as well as the first view of the Sample analysis 
dialog. Stirrer speed has a range of 0 to 10; with 1 being the lowest speed (0 turns the stir-
rer off). 

Select this option to turn the 
pump and fan off while data 
are collected.
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Elzone II 5390 Confirm Appendix H
Location

The Elzone uses vibration-absorbing feet to reduce the effects of vibrations in the lab 
bench, but whenever working with noise-sensitive applications, extra effort should be 
taken to reduce the vibrations in the vicinity of the Elzone. For example, a sieve shaker 
may sit on the same bench with the Elzone. If so, do not use the shaker while analyzing 
samples with the Elzone.

Try to choose a location for the Elzone that is away from heavy floor traffic; for example, 
do not use a location close to loading docks or elevators where large equipment is being 
moved. 

Place the Elzone on a stable, vibration-resistant bench and, if possible, on a bench by 
itself where it cannot pick up vibrations from other laboratory equipment. Also, do not 
lean on or shake the bench during an analysis.

Cleanliness

Cleanliness of system components is of utmost importance. Remember the following:

• Use electrolyte that has been thoroughly filtered with an appropriate filtering 
device.

• Always wear latex gloves when handling or cleaning orifice tubes. 

• After cleaning the orifice tube, install it immediately on the elzone analyzer to 
prevent air-borne particles from accumulating on its surface.

• Clean the orifice tube again after it has been installed.

• Place a lint-free cover on prepared samples until ready for analysis; this prevents 
air-borne particles from falling into the sample. 

See these sections in your operator’s manual for guidelines and information on maintain-
ing clean components:

• Preparation of Electrolyte Solutions, page D-4
• Cleaning Orifice Tubes, page 8-9
• Cleaning the System, page 8-6
• Preparing and Loading Your Sample, page 3-33
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INDEX

A
Add archive location command, 7-3
Add Archive Location dialog, 7-3
Add Log Entry, 4-10, 4-41
Add Orifice Tube dialog, 4-13
Adding

electrolytes to list, 4-23
orifice tubes to list, 4-13
sample materials to list, 4-23

Administrator, 2-1
Advanced push button, 4-7
Air

bubbles, 8-1
filter, 2-5
valve, 5-38

All file status, 2-11
Analysis

concentration, F-1
method, E-1
noise-sensitive applications, H-1
performing, 3-36
preparation, 3-26
QuickStart method, 5-14
Sample Analysis method, 5-3
selecting number to perform, 5-6

Analysis Conditions dialog, 4-12
Analysis conditions file, 4-12

creating, 3-4
listing statistics, 2-7, 3-39, 4-62
opening, 2-7
printing contents, 3-38, 4-59

Analysis Conditions SPC Options dialog, 6-9
Analysis program

description, 1-6
exiting, 4-72
logging in, 4-71
logging out, 4-72
menu structure, 2-13
using, 2-6

Analyst, 2-1
creating sample information file, 3-10
opening sample information file, 4-50

Analyzer
operating in manual control mode, 5-36
weight and dimensions, 1-8

Analyzing file status, 2-11
Aqueous electrolyte, D-1
ASCII text, saving reports, 6-24

Asterisk
background list, 5-31
orifice tube field, 4-13

Autoscale, 4-32
graph shortcut menu, 6-27
in Control Chart reports, 6-16
selecting options, 6-12

Average command, 4-69
Axis

coordinates, viewing, 6-31
inverting, 7-6
properties, editing, 6-29

Axis Properties dialog, 6-29

B
Background

analysis, 3-14
data, collecting, 4-5
full-resolution data, 4-20
list, editing, 5-31
report, 4-38
saving, 5-15
subtract, 4-19

Background file status, 2-11
Background Options dialog, 4-38
Bar code field

editing label, 7-4
entering, 4-9
omitting from dialog, 7-4

Basic push button, 4-11
Binned data, 4-19, 4-20
Blend command, 4-67
Blend data, 1-6
Blend Sample Files dialog, 4-67
Blockage

checking for, 4-17
clearing, 5-22

Board ID dialog, 5-48
Bubbles in orifice tube, 8-1

C
Calculations

Control Chart report, B-9
Difference from Reference report, B-7
Log probability data, B-10
Out of Spec report, B-6
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peak statistics, B-1
Regression report, B-8

Calibrate
orifice tube, 5-23

Calibration command, 5-3, 5-49
Calibration report, 4-41
Calibration Type dialog, 4-18
Camera, 2-2, G-1

focusing, G-9
installing, G-2
ordering, 9-1
orifice light, installing, G-5
software features, G-7
software, installing, G-6
USB connection, 2-5

Cancel push button, 2-9
Cascade windows, 2-7, 2-14
Category drop-down list, 7-3
Cautions, defined, 1-3
Change Orifice Tube or Liquid command, 5-19
Change Orifice Tube or Liquid dialog, 5-19
Check box, defined, 2-9
Check Orifice Tube and Liquid command, 7-7
Cleaning, H-5
Clear Blockage dialog, 5-22
Clear Blockages command, 5-22
Close All command, 4-58
Close command, 4-57
Close push button, 2-9
Close Reports command, 6-6
Coefficient of correlation calculation, B-8
Coefficient of variation, 6-18
Coincidence, 3-33, E-2
Coincidence correction, 4-19
Collected data, 4-43
Collected Data dialog, 4-43
Columns, editing on onscreen reports, 6-26
Combined report

example of, 6-33
Comments window, 4-10
Complete file status, 2-11
Computer requirements, 1-9
Concentration analysis, F-1
Concentration guidelines, 3-33
Conductivity, D-1

measure, 4-15, 5-16
Conductivity report, 5-46
Conductivity Report Settings dialog, 5-46
Confidence interval, 6-18
Contamination, H-1
Control Chart command, 6-15
Control Chart Graph Options dialog, 6-16
Control Chart Options dialog, 6-15
Control Chart report, 6-15

calculations, B-9
defining the Y-axis, 6-16
recalculating archived results, 6-17
selecting statistics, 6-18

Control chart report command, 6-2
Control Chart Sample Selection dialog, 6-17
Control Chart Summary Statistics dialog, 6-18
Controls, indicators, and connectors, 2-1

front panel, 2-2
rear panel, 2-5
side panel, 2-4

Convert command, 4-65
Cross-hair, 6-31

removing lines, 6-31
Curve Properties dialog, 6-28

D
Data

averaging from multiple files, 4-69
averaging/adding, 4-69
blending, 1-6, 4-67
collected, 4-43
converting, 4-65
entered, 4-47
exporting, 3-41, 4-64
format, 4-20
full resolution, 4-20
full-resolution, exported format, C-2
reduced, 4-20
reduced, exported format, C-1
selecting display options, 7-5
shape analysis, storing, 4-20
smoothing, 4-20

Data entry field, 2-8
Data Setup dialog, 4-17

collected data, 4-44
Date Range push button, 2-10, 4-50
Dates dialog box, 2-10
Default Fonts dialog, 6-25
Defaults

sieve sizes, 7-7
Developer, 2-1

creating a sample information file, 3-12
creating file templates, 3-1
creating parameter files, 3-3
importing files, 4-63
opening sample information file, 4-51

Diagnostics command, 5-33
Dialog boxes, using, 2-8
Dielectric constant, D-2
Difference from Reference report, 4-26, 4-31

calculations, B-7
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Differential flow rate, 4-16
Differential pressure, 4-16
Dilution factor, 4-6
Directories, 6-3

adding, 7-3
editing labels for, 7-4

Directory
orifice tube calibration, 5-30

Dispersants, D-2
table of, D-3

Dispersion
window, 4-24

Drain and fill, 5-20
Drain System command, 5-22
Drain System dialog, 5-22
Drop-down list, defined, 2-9

E
Edit Background List command, 5-31
Edit Labels command, 7-4
Edit Labels dialog, 7-4
Electrical requirements, 1-8
Electrical sensing zone method, E-1
Electrode, 1-5

connections, choosing, 4-15
connector, 2-2

Electrolyte, 1-8, D-1
adding/deleting from list, 4-23
aqueous, D-1
changing, 3-29, 5-19
checking before analysis, 7-7
conductivity, D-1
device for recirculating, 1-7, D-5
high background count, 8-2
modified organic, D-3
organic, D-2
preparation, D-4
soluble material, D-1
supply connection, 2-4
types of, D-1
water-soluble material, D-2

ElectroPrep, 1-7, D-5
Enable Manual Control command, 5-36
Ending conditions, 4-20
Entered Data dialog, 4-47
Entered file status, 2-11
Environmental requirements, 1-8
Error Messages, A-1

2200 Series, A-1
2300 Series, A-1
2400 Series, A-5
2500 Series, A-15

4200 Series, A-24
6100 Series, A-35
6200 Series, A-45

Ethernet connector, 2-5
Exit command, 4-72
Exiting the analysis program, 2-7, 4-72
Export

data, 5-7
Export command, 4-64
Export Settings dialog, 5-7
Exporting a sample file, 3-41
Exporting sample information files, 4-64
Extrapolation, 4-20

after analysis, 4-45

F
Fan, turning off during data collection, 4-17
File

exporting, 3-41
listing statistics, 2-7
opening, 2-7
selecting, 2-10
status, 2-11, 4-50, 4-59
See also Sample information file

File menu, 4-1
Average command, 4-69
Blend command, 4-67
Close All command, 4-58
Close command, 4-57
Convert command, 4-65
description, 4-1
Exit command, 4-72
Export command, 4-64
List command, 4-62
Log in command, 4-71
Log out command, 4-72
Print command, 4-59
Save All command, 4-57
Save as command, 4-55
Save As Template command, 4-57
Save command, 4-55

Fill System command, 5-21
Fill System dialog, 5-21
Fill valve, 5-38
Finish Analysis dialog, 5-12

orifice tube calibration, 5-27
Flow Control dialog, 4-16
Flow dialog, 5-40
Flow rate, 3-33, 4-16
Flush, 5-20
Flush System command, 5-21
Flush System dialog, 5-21
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Format
data, choosing for sample file, 4-20
exported data, C-1

Front panel, description, 2-2
Full-resolution data, 4-20

exporting, 4-64, 5-7
format of exported, C-2

Function keys
See Shortcut keys

Fuse
ordering replacement, 9-2

Fuse requirements, 1-8

G
Goodness of fit, 5-28
Graph

changing line thickness, 6-28
copying as metafile, 6-30
copying graphical data as text, 6-30
editing onscreen, 6-27
grid lines, 7-6
legend, editing, 6-29
overlays, 3-45
report options, 4-31
selecting grid line type, 6-29
shortcut menu, 6-27

Graph Grid Lines command, 7-6
Graph Grid Lines dialog, 7-6
Graph Overlay Samples dialog, 4-27
Graphic, displaying in report header, 4-26
Grid lilnes, 7-6
Grid lines, 6-29

H
Help menu, 2-15
Histogram, 4-31, 6-25

properties, 6-28
Hydropulser, 2-3

cleaning, 8-16
installing, 8-13
ordering, 9-1

I
Importing files, 3-40, 4-63
Indicators, 2-1
Information bar, 2-8
Instrument log

displaying, 5-44
printing a report, 5-44

selecting information to display, 5-44
Instrument schematic, 5-36

component shortcut menu, 5-37
description of components on, 5-37
displaying, 5-42

Instrument Setup dialog, 5-9
Isotherm data, exporting, 3-41

K
Kd values, orifice tubes, 4-18

L
Labels, sample file, editing, 7-4
Legend Properties dialog, 6-29
Light, camera, G-5
Liquid

changing, 3-29, 5-19
See also  Electrolytes

List command, 4-62
Listing file statistics, 3-39
Log

See Instrument log
Log in, 2-6
Log in command, 4-71
Log out command, 4-72
Log Probability Data, B-10
Log Probability Interpolation Table, B-11

M
Main Menu bar, 2-13
Maintain Backgrounds dialog, 5-31
Maintenance, 8-1

cleaning sample area, 8-6
orifice jewel, 8-4
orifice tubes, 8-9
schedule, 8-4

Manual
See Operator’s manual

Manual control
enabling, 5-36
selecting components, 5-36
shortcut menus, 5-37

Mass concentration, 4-6
Material Properties dialog, 4-22
Material properties file, 4-22

creating, 3-6
importing, 3-40
listing file statistics, 4-62
listing statistics, 2-7, 3-39
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opening, 2-7
printing contents, 3-38, 4-59

Measure conductivity, 5-16
before each test, 4-15

Menu
shortcut, 2-6
structure, 2-13

Messages
See  Error Messages

Metafile, copying graph as, 6-30
Modal count, 4-21
Move Steps dialog, 5-38

N
Near coincidence, E-2
No Analysis file status, 2-11
Noise-sensitive applications, H-1
Notes, defined, 1-3, 8-12
Number of tests, 4-5

O
Online manual

accessing, 2-7
Open Report command, 6-6
Operator’s manual

conventions, 1-3
organization, 1-1
See also Online manual

Optimize settings, 5-10, 5-16
Options menu

Add Archive Location command, 7-3
Check Orifice Tube and Liquid command, 7-7
description, 7-1
Edit Labels command, 7-4
Graph Grid Lines command, 7-6
Service Test Mode command, 7-8
Units command, 7-5
Update File List command, 7-5

Options report, 4-41
Ordering information, 9-1
Organic electrolyte, D-2

modified, D-3
Orifice

clearing blockages, 8-1
cracking, 8-5
jewel, 1-6
light, 2-2, G-5
light, adjusting, G-8
preventing blockages, 8-5
tube, D-1

Orifice tube, 1-6

adding and deleting from list, 4-13
calibrating, 5-23
calibration report, 4-41
chanigng, 5-19
checking before analysis, 7-7
choosing, 3-26
cleaning, 8-9
clearing blockages, 5-22
installing on sample port, 3-26
Kd values, 4-18
on instrument schematic, 5-39
storing, 8-4

Orifice Tube Calibration command, 5-23, 6-7
Out of Specification report, 4-27, 4-31

calculations, B-6
Overflow sensor, 5-41
Overlay

backgrounds, 4-38
data from all tests of same file, 4-32
data from all tests same file, 3-50
data from multiple samples, 4-32
from multiple samples, 3-45
generating, 3-45
selecting files for, 4-27
two different plots from same file, 3-48, 4-32

Overlay Settings dialog, 4-32

P
Parameter file, 4-54

Analysis conditions, 3-4, 4-12
creating, 3-3, 4-3
creating templates, 3-2
importing, 3-40, 4-63
listing statistics, 3-39, 4-62
Material properties, 3-6, 4-22
opening, 4-54
printing contents, 3-38, 4-59
Report options, 3-7, 4-25
saving, 4-55
saving as a different name, 4-56

Particle
concentration guidelines, 3-33
count/noise, H-1
diameter range for analysis, 4-13
flow rate, 3-33

Particle Length vs. Particle Size report, 4-39
Particle Length vs. Particle Size Report Options dialog, 

4-39
Particle size distribution graph, 6-19
Parts, ordering, 9-1
Password, 2-6

changing, 4-71
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logging in, 4-71
service tests, 7-8

Peak
valley depth, 4-28

Peaks, Summary report, 4-37
Performance, optimum, H-1
Polynomial fit, 5-30
Port

See Communications port
Power indicator, 2-2
Pressure reading, instrument schematic, 5-40
Pressure transducer, zero, 5-32
Preventive Maintenance schedule, 8-4
Print command, 4-59
Print dialog, 6-24
Printing

file contents, 3-38, 4-59
instrument log report, 5-44
reports, 6-24

Prompts, sample information, 7-4
PSD History command, 6-2, 6-19
PSD History Options dialog, 6-19
PSD History report, 6-19
PSD History Sample Selection dialog,, 6-19
Pulse height, 5-28
Pulse Length report, 4-40

full-resolution data, 4-20
Pulse Length Report Options dialog, 4-40
Pump

manually controlling, 5-36
on instrument schematic, 5-42
turning off during data collection, 4-17
vacuum, 5-39
volumetric, 1-7

Push button, defined, 2-9

Q
Quick Start command, 5-2
QuickStart Analysis command, 5-14
QuickStart dialog, 5-14

R
Radio button, defined, 2-8
Raising the sample stand, 2-3
Redraw, 6-31
Reduced data, 4-20

exporting, 4-64
format of exported, C-1

Reference Material dialog, 5-25
Reference material, adding to list, 5-25
Reference quantities, B-6

Reference Sample dialog, 4-26
Regressioin Report Options dialog, 6-11
Regression report, 6-11

calculations, B-8
recalculaing SPC values, 6-12
selecting X- and Y-Axes variables, 6-12

Regression Report command, 6-11
Regression report command, 6-2
Regression Report Sample Selection dialog, 6-12
Replace All push button, 5-4
Replace all push button, 4-10
Replace push button, 2-9
Report

Background, 4-38
calibration, 4-41
closing, 6-6
closing all, 2-7
Control Chart, 6-15
copying graphical data as a metafile, 6-30
copying graphical data as text, 6-30
editing, 4-29
editing legend, 6-29
editing title, 6-30
examples, 6-32
graphs, editing onscreen, 6-27
header, 6-21
onscreen, 6-22
opening, 6-6, 6-23
printing, 6-24
PSD History, 6-19
Regression, 6-11
Sample Log, 4-41
saving, 6-24
saving in other formats, 6-24
selecting, 4-7, 4-29
selecting fonts, 6-25
shortcut menus, 6-26
showing company logo in title, 4-26
showing title on, 4-26
Standard Class Size Table, 6-36
starting, 2-7, 6-3
Statistical Process Control (SPC), 6-8
tabular, 4-33
tool bar, 6-23
types available, 4-29
viewing axis coordinates, 6-31
zoom feature, 6-30

Report button, 6-14
Report options

graphs, 4-31
tabular, 4-33

Report Options dialog, 4-25
Report options file, 4-25

creating, 3-7
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importing, 3-40
listing file statistics, 4-62
listing statistics, 2-7, 3-39
opening, 2-7
printing contents, 3-38, 4-59

Reports
exporting automatically after analysis, 5-7, 5-15
Particle Length vs. Particle Size, 4-39
selecting, 6-5
Summary, 4-35

Reports menu
Close Reports command, 6-6
Control Chart command, 6-15
description, 6-1
Open report command, 6-6
Orifice Tube Calibration command, 6-7
PSD History command, 6-19
Regression Report command, 6-11
SPC Report Options command, 6-8
Start Report command, 6-3

Reports Settings dialog, 5-6
Revert dialog box, 4-6
Review option, 5-7
Rinse command, 5-20
Rinse dialog, 5-20
Rinse, types of, 4-6
Rosin Rammler report, 4-34

S
Sample

analyzing a series, 5-14
analyzing individual, 5-3
area, cleaning, 8-6
dispersant, D-2
material, adding/deleting from list, 4-23
preparation, 3-33
stand, raising and lowering, 2-3
valve, 5-39

Sample Analysis command, 5-1, 5-3
Sample Analysis dialog, 5-3
Sample Information dialog

Analyst, 4-4
Developer, 4-8

Sample information file, 4-4
analyst, 4-4
creating, 4-3
creating a template for, 3-1
creating automatically with QuickStart, 5-14
creating, Analyst, 3-10
creating, Developer, 3-12
Developer, 4-8
editing labels for, 7-4

exporting, 3-41, 4-64
importing, 3-40, 4-63
listing statistics, 3-39
opening, 4-49
printing contents, 3-38, 4-59
revert to previous version, 4-6
saving, 4-55
saving as a different name, 4-55
status types, 2-11
versions, 4-6, 4-49

Sample Log report, 4-41
entries, 4-10

Sample SPC Options, 6-9
Sample stand, raising and lowering, 2-3
Sample template

See Template
Save All command, 4-57
Save as command, 4-55
Save as Default button, 6-18, 6-20
Save As Sample Information dialog, 4-7
Save As Template command, 4-57
Save as Template push button, 4-11
Save command, 4-55
Save push button, 2-9
Schematic

See Instrument Schematic
Selected Reports dialog, 6-5
Selecting reports, 4-29
Sensors, 5-41
Sequence number, 7-3
Service Test command, 5-3, 5-49
Service Test mode, 5-49
Service Test Mode command, 7-8
Service tests, performing, 7-8
Servo valve, 5-40
Set Target dialog, 5-40
Shortcut keys, 2-7

for Select Dates dialog, 2-11
list of, 2-7

Shortcut menu, 2-6
accessing, 2-7
for graphs, 6-27
for tabular reports, 6-26
instrument schematic, 5-37

Show Instrument Log command, 5-44
Show Instrument Schematic command, 5-42
Show Status command, 5-43
Side panel, description, 2-4
Sieve sizes, specifying defaults, 7-7
Sieve Table dialog, 7-7
Signal Settings dialog, 4-13
Signal-to-noise ratio, F-5
Size axis, inverting, 7-6
Size classes, 4-19
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Smoothing, 4-20
Software

camera, installing, G-6
using, 2-6
version, 5-47

Sparkle display, 5-9
SPC Calculations dialog, 6-8
SPC Percentile Options dialog, 6-10
SPC report

calculations, B-8
user parameters, 7-4

SPC Report Options command, 6-8
SPC report options command, 6-1
SPC reports, 6-8
SPC Size Options dialog, 6-10
Specification Samples dialog, 4-27
Specifications, 1-8
Spreadsheet format, saving reports in, 6-24
Standard Class Size Table, 4-33

example of, 6-36
Standard Sieve Table, 4-33
Start Orifice Tube Report dialog, 6-7
Start Report command, 6-3
Start Report dialog box, 6-3
Status drop-down list, 2-11
Status list, 6-3
Status window, showing, 5-43
Stirrer

direction, 4-5
manual control of, 5-39
options, 2-3
speed, specifying, 4-5

Stirrer Speed dialog, 5-39
Stray particle count and noise, H-1
Subcategory drop-down list, 7-3
Summary Peaks dialog, 4-37
Summary Percentiles dialog, 4-36
Summary report, 4-35
Summary Report Options dialog, 4-35
Summary Sizes dialog, 4-36
Summary Statistics button, 6-15, 6-18
Supply inlet, 2-4
System

description, 1-5
draining, 5-22
filling with liquid, 5-21
flushing, 5-21, 8-6
repeatability/reproducibility, 1-8
rinsing, 5-20
specifications, 1-8

T
Tables, editing, 4-33
Tabular reports

editing options, 4-33
shortcut menu, 6-26

Temperature, environment, 1-8
Template

creating, 3-1
listing statistics, 3-39, 4-62
opening, 4-52
printing contents, 3-38, 4-59
saving from sample or parameter file, 4-57

Test, number to perform, 4-5
Text, copy graph data as, 6-30
Theory of operation, E-1
Tile windows, 2-7, 2-14
Title Properties dialog, 6-30
Tool Bar, report window, 6-23
Troubleshooting, 8-1

air bubbles sticking to orifice tube, 8-1
high background count on electrolyte, 8-2
incorrect sizes, 8-1
no liquid flowing with valves open, 8-1

Truncate table at distribution limits, 4-34
Type of data, specifying, 4-9

U
Unit Configuration command, 5-3, 5-47
Unit Configuration dialog, 5-47
Unit configuration, displaying, 5-47
Unit IP Setup dialog, 5-48
Unit menu, 5-1

Calibration command, 5-49
Change Orifice Tube or Liquid command, 5-19
Clear Blockages command, 5-22
description, 5-1
Diagnostics, 5-33
Drain System command, 5-22
Edit Background List command, 5-31
Enable Manual Control command, 5-36
Fill System command, 5-21
Flush System command, 5-21
Orifice Tube Calibration command, 5-23
QuickStart Analysis command, 5-14
Rinse command, 5-20
Sample Analysis command, 5-3
Service Test command, 5-49
Show Instrument Log command, 5-44
Show Instrument Schematic command, 5-42, 5-43
Unit Configuration command, 5-47
Zero Pressure Scale command, 5-32

Units command, 7-5
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Units Selections dialog, 7-5
Units, selecting, 7-5
Update file list command, 7-5
User levels, 2-1
User parameters, 4-9

specifying, 7-4, 7-5

V
Vacuum

pump, 5-39
tubing, 2-4

Valve
air, 5-38
appearance when closed, 5-38
appearance when open, 5-38
fill, 5-38
sample, 5-39
servo, 5-40

Valves
on instrument schematic, 5-42
operating in manual control mode, 5-36

Version
sample information file, 4-6
software, 5-47

Voltage selector, 2-5
Volumetric flow rate, 4-16
Volumetric pump, 1-7

on instrument schematic, 5-37
ordering, 9-1

W
Warnings, defined, 1-3
Waste

sensor, 2-4, 5-41
supply connection, 2-4

Windows menu, 2-14

Z
Zero Pressure Scale command, 5-32
Zero Pressure Scale dialog, 5-32
Zoom feature, 6-30
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